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Editoriál
Vítejte u čtení časopisu Abíčko.


Abíčko vychází jako měsíční příloha serveru http://www.abclinuxu.cz a obsahuje výběr toho nejzají-
mavějšího obsahu, který zde byl v minulém měsíci publikován. Touto formou chceme předat čtenářům
informace v snadno čitelné podobě vhodné i pro tisk.


Cílem serveru http://www.abclinuxu.cz je pomáhat všem uživatelům Linuxu, nezávisle na jejich
zkušenostech, platformě či použité distribuci. Motorem, který nás pohání vpřed, je idea vzájemné
pomoci a spolupráce. Proto i velkou část obsahu tvoří samotní uživatelé. Zapojit se může kdokoliv,
tedy i vy.


Na http://www.abclinuxu.cz najdete rozsáhlou databázi návodů na zprovoznění hardwaru pod Linu-
xem, velice aktivní diskusní fórum, podrobné návody a tutoriály, recenze, archiv ovladačů, informace
o linuxovém jádře (včetně populárních Jaderných novin) i rozcestník po ostatních linuxových serve-
rech. Novinkou posledních měsíců, která našla brzy odezvu, jsou blogy neboli internetové deníčky.
Každý registrovaný uživatel si jej může založit a psát si do něj poznámky nejen o Linuxu.


V neposlední řadě chceme upozornit také na výkladový slovník pojmů a vznikající elektronickou
učebnici Linuxu, na níž se můžete podílet i vy!


Náměty na články zasílejte do konference našich autorů: autori@abclinuxu.cz.


Sponzoring Abíčka a jiné formy reklamy si objednávejte na adrese: reklama@abclinuxu.cz.


Ostatní dotazy směřujte na adresu: literakl@abclinuxu.cz.


Server http://www.abclinuxu.cz provozuje firma Stickfish s.r.o., která poskytuje profesionální služby
v oblasti Linuxu firmám i jednotlivcům. Zabývá se hlavně bezpečností, instalacemi Linuxu a konfi-
gurací síťových služeb. Více na http://www.stickfish.cz.


c©2006 Stickfish s. r. o. a autoři článků


Editor a sazba: Vlastimil Ott


Pro nekomerční účely smíte tento dokument jakkoliv šířit v tištěné i digitální podobě. V ostatních
případech nás požádejte o svolení na adrese info@abclinuxu.cz.


Typografické konvence


Ve výpisech zdrojových textů mohou být použity znaky \\ . Značí přechod na nový řádek, který
ovšem není součástí samotného zdrojového textu, byl přidán editorem z důvodu lepšího vzhledu
případně nemožnosti text formátovat bez jejich použití.
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Krita – grafika pro KDE


Pavel Beníšek


Jak si stojí grafický program Krita pro KDE (součást KOffice), čím se liší od GIMPu,
pro jaké použití je vhodný.


Když jsem kdysi přecházel na desktopu na GNU/Linux, tak jsem poměrně úspěšně nacházel alter-
nativy ke stálicím na Windows desktopu. Problémy jsem měl v podstatě jen ve dvou případech.


Prvním byl použitelný klient pro ICQ komunikaci. To jsem vyřešil díky kamarádově radě a přechodu
na jabber sít. V tu chvíli jsem měl na výběr hned několik kvalitních messengerů.


Druhým problémem bylo nalezení alternativy ke grafickým programům typu Paint Shop Pro nebo
Photoshop. Zde jsem dlouho hledal a to vlastně až dodnes. Jediný použitelný nástroj byl Gimp.
Bohužel se mi v něm nepracuje příjemně. Nejsem schopen vysvětlit proč, ale prostě mi nesedí a ani
po několikaletém používání jsem si na něj nezvykl. Možná je to odlišným způsobem práce, možná
použitím gtk, možná něčím úplně jiným. V žádném případě však tím nehodlám upírat Gimpu jeho
kvality. Poskytuje velké množství kvalitních efektů a nástrojů.


Někdy začátkem roku 2005 jsem se na stránkách KDE.org dočetl o novém nástroji, který by měl
být v dalších verzích součástí Koffice. Podle několika screenshotů a popisu mi připadala, tehdy ještě
beta verze, velmi zajímavá, a tak jsem strávil den pokusy o kompilaci. Když se mi konečně podařilo
zkompilovat celý program. Čekalo mě nemilé překvapení. Program s ubíjející přesností padal a padal.
Navíc nebyl schopen načíst nic jiného než vlastní formát obrázku. Znechuceně jsem ho tedy smazal
a s pocitem, že si počkám na další verzi, jsem na něj zapomněl.


Dnes je na světě další verze, již stabilní, a když řeknu, že je dobře použitelná, tak bych snad ani
nemusel rozbouřit flame war. Znovu se nabízí srovnání s Gimpem, ale to půjde poměrně těžko, protože
ten je podstatně vyspělejší ve většině funkcí a jeho stabilní verze již nějaký ten pátek vychází. Já
většinou potřebuji jen pár jednoduchých úkonů a na ty stačí Krita úplně v pohodě a samozřejmě
zdaleka nevyčerpám její možnosti.


Instalace


Na Gentoo je instalace triviální. Věřím, že na ostatních distribucích bude obdobná: emerge krita .
Pokud vám vyhovuje používání balíku Koffice, můžete nainstalovat ten a budete mít Kritu nainsta-
lovanou také. Závislosti nejsou nijak přehnané. Protože je program pod KDE, závisí pochopitelně na
něm. Dále pak na následujících balících:


• imagemagick
• koffice-data
• koffice-libs


Přestože se Krita vyvíjí s přestávkami již od roku 2000, ještě mi stále nepřijde dostatečně stabilní.
Občas spadne, a to i přes to, že jsem ji zkoušel kompilovat několikrát s různými parametry kompilace
(Gentoo – USE flagy) a na několika počítačích.


První spuštění
Na první pohled si všimnete, že nástrojové lišty jsou vnořeny do hlavního okna, podobně jako je
to ve Photoshopu pro Windows. To mi vyhovuje víc než nezávislá okna inspirovaná pro změnu
Photoshopem pro MacOS. Když potřebuji přepnout do jiného programu, stačí zmenšit jedno okno
místo tří a více.
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Malou pihou na kráse je, že při otevření více obrázků se otevře další okno se všemi toolbary a ne
pouze závislé okno uvnitř hlavního (viz screenshot).


Zkušenosti s používáním
Ovládání je jednoduché a opět je podobné Photoshopu. Na levě straně se nachází lišta s nejpoužíva-
nějšími nástroji. Uprostřed je prostor pro editovaný obrázek a na pravé straně lišta s nastaveními,
vrstvami a dalšími. Příjemné je použití Qt/KDE toolbarů, takže můžeme nástrojové lišty velmi
jednoduše modifikovat.
Velkou nevýhodu oproti konkurenci vidím v absenci dialogu pro nastavení exportu do JPG, PNG
a GIF, tedy formátů používaných na webu, kde je potřeba kvalitu snižovat. Nepodařilo se mi v na-
stavení zjistit, jakou kvalitu má formát JPG nastavenu, ale po několika experimentech odhaduji, že
je to někde okolo 97 %.
Nepodařilo se mi najít možnost práci s křivkami, což je také poměrně závažná chyba. Doufejme, že
v příští verzi bude napravena.
Práce s vrstvami je příjemná a nepřišel jsem na nic, co by mi chybělo. Efektů zatím mnoho není,
ale ty základní samozřejmě obsaženy jsou. Určitě by pomohla podpora filtrů z Gimpu, což by mohlo
v budoucnu pomoci jak Kritě, tak nepřímo i Gimpu.
Poměrně propracovaná mi přijde podpora štětců a vzorů, příjemná je také podpora ICM barevných
profilů. Celkově mi přijde Krita mírně nevyvážená. V některých ohledech je daleko za možnostmi
konkurenčních produktů a v několika nabízí až zbytečně mnoho možností. Příkladem je zmenšování
obrázku, kde dostaneme na výběr hned 7 algoritmů pro scaling.
I přes všechny její nedostatky vám Kritu doporučuji alespoň k vyzkoušení. Jakmile autoři napraví
přehmat s exportem obrázků pro web, asi na ní přejdu a Gimp nechám na disku jen z nostalgie.
Sice není vše růžové, ale konečně nám vzniká rozumná alternativa k Gimpu a to může být jen ke
prospěchu věci. Věřím, že by za pár let a verzí právě Krita mohla pomoci přilákat další uživatele
Linuxu.


? ? ?
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Reportáž: Libre Graphics Meeting


Petr Vaněk


Konference a setkání, které bylo původně určeno pouze pro vývojáře a uživatele
GIMPu, se během přípravné fáze rozšířilo o spoustu dalších projektů. Stručně ře-
čeno – kdo ve světě OSS grafiky něco znamená, tam byl. Narcistickou kličkou se
dostávám k tomu, že jsem tam byl i já, takže vážené čtenářstvo mohu seznámit s prů-
během a závěry tohoto přelomového sjezdu, který připravil Dave Neary a sdružení
Aldil. 17.–19. 3. 2006, Lyon, Francie.


Pátek je svátek, čili den první


Zalepené oči účastníků si v takovou brzkou hodinu jen ztěžka zvykaly na světlo, ale zaplněný amfiteátr
posluchárny dával tušit, že se chystá zajímavá přednáška. Pan Øyvind Kol̊as, alias Pippin, rozpoutal
vodopád své výřečnosti na téma: budoucnost GIMPu [1], Gegl [2] a vůbec hromada dalších g*l
(GIMP: the next generation. gegl, gggl, babl and more [3]). Pippinova řeč byla vskutku strhující,
možná i proto, že své poznámky promítal pomocí šíleného software vlastní výroby, který právě
zmiňované knihovny a nástroje používal.


Závěrem předvedená kompilace a spuštění vzniklého prográmku vyvolalo frenetické nadšení – Gegl
a Babl funguje a dá se používat. Nic už nebrání tomu, aby se pomocí této knihovny přenesli GNU
vývojáři do dosud nepoznaných oblastí 16bitových barev a barevných prostorů. (Osobní impertinence:
škoda jen, že jiné aplikace používají třeba barevnou hloubku 32 bitů atd. ale o tom až později.)


Následující povídání by si dle mého názoru zasloužilo vydat alespoň v kožené vazbě. Pan Marti
Maria, jeden z autorů knihovny LittleCMS [4], sice neexceloval v showmanských eskapádách svého
předřečníka, ale obsah jeho projevu (Colour management with LittleCMS) byl natolik zásadní, že
by si jej měl povinně nastudovat každý člověk, který ke grafice alespoň přivoní. Problematiku teorie
a praxe barevných prostorů podal natolik přehledně, přičemž nesklouznul do přílišného zjednodušení.


Následující přednášky jsem neviděl, protože lidé, kteří se pohybují okolo Scribusu [5], měli naplá-
novaný pracovní dýchánek. Mimochodem velice produktivní a úspěšný. Tedy alespoň seznam: SIOX
Simple Interactive Object Extraction [6] – behind the scenes, Gerald Friedland, Tuxpaint, Gimp &
co, Cédric Gemy [7] (francouzsky) a Contributing to GIMP, Karine Delvare (edhel) (francouzsky).


a Sobota je bavorák, tedy den druhý


Velice zvláštní věc. Když takhle večer sedíte v restauraci vedle veselého člověka a vedete řeči o počasí
a sportech a ono se druhý den ukáže, že je to Jon Phillips [8], hyperaktivní [9] excentrik, který povídal
o některých svých projektech, a přitom se trefoval do posluchačů reklamními tričky. Inkscape [10],
OpenClipart [11] & Creative Commons [12]. Zejména idea CC mi, přestože se tématu konference
týkala víceméně okrajově, opravdu zahlodala v mozkových závitech. Nápad stavebnice licencí umě-
leckých děl (a hip-hopu) a vědeckých prací na míru s nástroji a prostorem na jejich publikování je
přinejmenším novátorská.


Během jeho přednášky došlo k jedinému drobnému plamennému souboji, jenž se týkal licencování.
Jedné hipísačce se nějak nelíbily možnosti licencí Creative Commons a stále se dotazovala na to,
proč se nepoužívají licence FSF [13] apod. Naštěstí rozmíška ihned utichla, respektive byla zastavena
panem přednášejícím.


Velký třesk. Pan Neil Howe z Xary ukazoval Xara Xtreme [14]. Už předem na svých reklamních ma-
teriálech Xaráci uváděli superlativní přívlastky svého software, ale říkal jsem si, že se jedná o klasické
marketingové žvásty. Jenže ona je XX opravdu rychlá. Zatraceně rychlá. Kdo na vlastní oči neviděl
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plynulou změnu barev v kresbě s tisíci polygony, v okamžiku přepočítávané transformace bitmapo-
vých obrázků velikosti několika megabytů v 300DPI a jejich kopírovaní v dokumentu podle různých
algoritmů nebo bleskové ukládání a načítání souborů, prostě nemůže uvěřit. A to některé operace,
protože ještě nejsou do linuxové verze implementovány, běžely ve Windows na VMWare a na daleko
méně výkonném notebooku než mám třeba v úřadu na běžnou práci. Inkscape, míč je teď na vaší
straně hřiště!


Po vydatném obědě nastal čas na patnáct vteřin osobní slávy. Duo Craig Bradney & Peter Linnell
uvedli ukázku nových vlastností Scribusu [15] (Scribus – Open Source Page Layout), přičemž u pří-
ležitosti toho, že se tam poprvé v životě sešli všichni vývojáři až na jednoho, ukazovali každého z nás
jako zvířátko. Inu, co už s tím. Každým pádem ukázka čerstvého checkoutu z CVS se obešla bez
pádu programu a zvídavé otázky posluchačstva svědčily o tom, že Scribus používají.


Jsem vždy tak trochu fascinován lidmi, kteří mají výtvarný talent. Stejně tak jsem jako uhranutý,
když někdo umí využít nějaký software alespoň na 94 %. A jestliže se vyskytne někdo, v jehož osobě
se obě vlastnosti spojují, je o zábavu postaráno. Pan Andy Fitzsimon [16] ukázal, co všechno se dá
udělat v Inkscape a GIMPu a naopak a jak z hnusné mazanice myší několika filtry udělat například
texturu do písma nebo stín objektu. Vlastně si někdy říkám, že talentovaní lidé jsou tak trochu
frustrující, takže berte zpět první věty tohoto odstavce.


Jako poslední vystoupil pan Rui Campos se rozpovídal o Blenderu [17] a o Project Orange [18], čili
o výrobě animovaného filmu „Elephants Dreamÿ a o co všechno se díky spolupráci Blender nadace
a studia Orange podařilo tento software rozšířit a jak vylepšit. Mimochodem – premiéru filmu můžete
shlédnout tento Pátek (24.3.2006) v Amsterodamu.


Neděle je odpočinku den, každý rád vyrazí si ven, den třetí


Poslední den byl věnován vzájemným rozhovorům a debatám mezi vývojáři, uživateli a také nezna-
lými příchozími. Ještě dnes jsem nadšený z tamější atmosféry. Když jste například položili otázku
šéfovi vývoje Xary, jak provádějí export do PostScriptu, neodbyl vás, ale rozpovídal se o problematice
a hlavně se orientoval v tom, jak export provádějí programy jiné a znal i výhody a nevýhody jednot-
livých řešení. Celá akce probíhala v prostorách lyonské univerzity, tedy přesněji řečeno v CPE [19].
Okolní prostředí mi sice připomínalo sídliště Černý Most, ale útroby CPE skrývaly nejednu technic-
kou lahůdku. Z dob svých studií nejsem zvyklý na WiFi signál po celé budově, pekelně rychlou síťovou
přípojku na každém rohu a výtečně křupavé bagetky. Právě díky všeobecně dostupné konektivitě se
některé aplikace doslova měnily pod rukama. Přímo na místě vznikaly návrhy nových ikon pro jed-
notlivé činnosti programů. Popřípadě byly prováděny opravy a úpravy podle poznámek skutečných
uživatelů. Tedy produktivita a nadšení asi čtrnáctkrát vyšší než při použití běžných elektronických
kanálů. Jeden příklad za všechny: koutkem oka jsem zahlédl, jak kdosi ukazoval v mžiku napsaný
prototyp správy ICC profilů v Inkscape, ale samozřejmě uvidíme, jak se dále vyvine.


Neúplný seznam dalších zůčastněných: Carl Worth [20] (Cairo [21]), Cyrille Berger [22] (Krita [23]),
Nicholas Spalinger a Victor Gaultney (SIL, Gentium [24] font), Andreas Nilsson [25] (Tango [26])
a další. . .


Závěrečné shrnutí, mravokárné řeči a osobní myšlenky


Závěr tohoto příspěvku je plný osobních poznámek a názorů. Čtenář s nimi nemusí souhlasit, ale to
je, slovy klasika, asi tak všechno, co s tím může dělat. A navíc – já tam byl, jsem tedy selebrita,
takže vím všechno lépe.


Problém GIMP. GIMP byl a je bezesporu vlajkovou lodí OSS grafiky, ale čím dál relevantnější otázka
zní: „Jak dlouho ještě?ÿ Dá se s ním dělat hromada hezkých věcí, ale je tak nějak zamrzlý a díky
nechuti vývojářů s tím cokoli dělat, asi pěkně zakonzervovaný zůstane. Nastiňme si hypotetický
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příklad. Na co GIMP vlastně potřebuji? Chci upravit červené oči na fotografii? Digikam a jeho
moduly. Chci změnit velikost obrázků? Gwenview, Imagemagick nebo cokoli jiného. Chci udělat
tlačítka na web? Dobrá, to umí a má na to nástroje. Ale co když chci pracovat s obrázkem s barevnou
hloubkou větší než 8b? Obligátní CMYK a další barevné prostory? ICC profily? Sbohem a šáteček.
Vždyť například Krita už může použít barvy ve 32 bitech.


Navíc jsem měl takový zvláštní pocit, že celý víkend byli lidé tak nějak rozděleni na tlupu okolo
GIMPu a na ostatní. Inu, nevím, nevím, co GIMPu budoucnost přichystá. Ale třeba, v to doufám,
mne jeho budoucnost potěší.


Mravokárná poznámka. Dovedete si představit, že za celou dobu nikdo nikomu neřekl, že je jeho
program na prd, neboť používá Gtk? A naopak? A že je třeba uvolněn pod jinou než jedinou správnou
licencí? Nedokážete? I já byl překvapen. Příjemně.


Další radostný poznatek jsem učinil v případě Inkscape. Když všem účastníkům spadla čelist po
ukázce Xara Xtreme, vývojáři Inkscape se rychle vzpamatovali, obklopili stánek Xary a začali se
vyptávat, jak dělají to či ono. A lidé z Xary odpovídali. Navíc byly odpovědi konkrétní. Snad se oba
programy ještě krutě zlepší.


Podle ohlasů soudě, stane se z LGM taková hezká tradice. Takže se jej třeba za rok dočkáme někde
poblíž našeho pidi státečku. A protože jste zavolal(a) do patnácti minut po odvysílání této reklamy,
máte ode mne dárek – fotografie [27] zdarma!


Odkazy


[1] http://gimp.org
[2] http://gegl.org
[3] http://pippin.gimp.org/lgm2006/
[4] http://www.littlecms.com/
[5] http://www.scribus.net
[6] http://www.siox.org/
[7] http://www.cgemy.com/
[8] http://www.rejon.org/
[9] http://www.rejon.org/projects/index.php
[10] http://inkscape.org
[11] http://openclipart.org
[12] http://creativecommons.org
[13] http://fsf.org
[14] http://www.xaraxtreme.org/
[15] http://www.scribus.net
[16] http://www.fitzsimon.com.au/Andy/
[17] http://blender.org/
[18] http://orange.blender.org/
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[23] http://www.koffice.org/krita/
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GIMP v příkladech
Vítězslav Šmíd


V tomto seriálu si na praktických příkladech předvedeme použití nejrůznějších nástrojů
a postupů, které nám nabízí oblíbený bitmapový editor GIMP. Nebudeme se zabývat
úplnými základy, ale tím, jak naplno využít možnosti tohoto skvělého programu.


Úvod
Jak už asi naznačuje perex, tento seriál nebude určen úplným začátečníkům. U čtenářů budu před-
pokládat tyto základní znalosti:


• Schopnost ovládat svůj operační systém a programy ;-).
• Schopnost ovládat GIMP; orientace v jeho rozhraní, schopnost konfigurace oken, záložek („od-
rážkyÿ), dialogů.


• Ukládání a načítání souborů, formáty souborů (XCF versus JPG, PNG, GIF,. . . ).
• Co jsou to vrstvy; aktivní vrstva, změny pořadí vrstev, vytváření, přejmenovávání, duplikování
a mazání vrstev.


• Barevný model RGB – jak funguje.
• Co to jsou a jak je nastavit – barva popředí a pozadí, aktivní stopa (brush), vzorek (pattern),
přechod (gradient).


• Co je to průhlednost (alpha).


Myslím, že to nejsou požadavky nijak přehnané a na webu najdete desítky článků v nejrůznějších ja-
zycích, které se takovým základům věnují. K práci budeme potřebovat pouze GIMP s jeho rozšířením
Script-fu (standardní součást instalace). Já používám verzi 2.2.8, ale myslím, že stejných výsledků
můžete dosáhnout i s verzemi trochu odlišnými. Doporučuji však používat alespoň 2.2, oproti 2.0 má
slušný počet výhod, minimálně přidání náhledů ke spoustě filtrů a efektů.


Epizoda první – hvězdná obloha


Nejprve si ukážeme, co se vlastně budeme snažit
stvořit. Nebudeme troškařit a vydáme se rovnou
mezi galaxie – namalujeme si hvězdnou oblohu
(za lepší výraz považuji anglické „starfieldÿ, tedy
něco jako „hvězdné poleÿ). Upozorňuji, že pro ně-
které obrazy, které budeme v tomto seriálu vy-
tvářet, je naše dnešní práce spíše jenom pozadí,
takový základ. . .


Postup


Na počátku byla vrstva Pozadí


Začneme, překvapivě, spuštěním GIMPu. Z menu
Soubor zvolíme Nový, nebo použijeme zkratku Ctrl+N . Výšku a šířku obrázku nastavíme na 800x600
pixelů a potvrdíme tlačítkem Budiž. Opravdovou práci započneme použitím nástroje Plechovka, který
má zkratku Shift+B . Popíšeme si jeho možnosti:


• Krytí: Určuje, jak bude nově nanesená vrstva barvy „průhlednáÿ, neboli jak bude krýt barvu
pod sebou. Pozor, toto nastavení má vliv pouze v rámci jedné vrstvy, neplést si s „opravdovouÿ
průhledností vrstev!
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• Režim: K této problematice se dostaneme o něco dále, viz kapitolku Režimy vrstev [1].
• Typ vyplňování: Určuje, čím vlastně požadovanou plochu vyplníme. Doufám, že je každému
jasné, co je to barva popředí a pozadí.


◦ Vyplňování barvou popředí
◦ Vyplňování barvou pozadí
◦ Vyplňování vzorkem: K vyplnění je použitý právě aktivní vzorek. Dialog pro výběr vzorků
zobrazíme příkazem Dialogy → Vzorky nebo klávesovou zkratkou Shift+Ctrl+P .


• Ovlivněná oblast: Určuje, kam se vlastně barva dostane


◦ Vyplnit podobné barvy: Po kliknutí na nějaký bod v obrázku vyplní všechny oblasti, které
mají stejnou barvu a navzájem se „dotýkajíÿ tohoto bodu. Citlivost je možno nastavit
v části Hledání podobných barev, viz dále.


◦ Vyplnit celý výběr: Vyplní aktuální výběr v aktivní vrstvě, nezávisle na podkladu. Pokud
žádný výběr nemáme, je vyplněna celá aktivní vrstva.


• Hledání podobných barev: Podrobnější nastavení pro Vyplnit podobné barvy.


◦ Vyplnit průhledné oblasti: Zdalipak chceme zabarvit i oblast průhlednou, „bezbarvouÿ.
◦ Sloučený vzorek: Poněkud komplikovanější případ – barva je nanášena na aktivní vrstvu,
ale oblast je podle „pravidelÿ pro vyplňování podobných barev ovlivňována první vidi-
telnou vrstvou, která leží nad vrstvou aktivní.


◦ Práh: Udává citlivost, s jakou je posuzována podobnost barev. Při nízkých hodnotách
jsou ovlivněny jen totožné nebo téměř shodné barvy.


My si nejprve vytvoříme podkladovou čerň noční oblohy – nastavíme si tedy barvu popředí na černou
(#000000) a u plechovky krytí 100%, typ vyplňování na barvu popředí a ovlivněnou oblast na celý
výběr. Po aplikaci na (zatím jedinou) vrstvu Pozadí uvidíme zárodek naší práce – nudnou černou
oblohu. Je čas zažehnout termonukleární reakci.


První hvězdy
K vytvoření hvězd použijeme filtr Noise-Hurl, který najdeme v menu Filtry → Šum → Náhodné
výpadky. Nevím proč, ale u tohoto filtru jsem měl problém s neanglickými lokalizacemi GIMPu,
jeho použití vždy skončilo pádem plug-inu randomize se signálem SIGPIPE. Mně osobně to nevadí,
protože používám lokalizaci anglickou :-). Pokud se chcete držet češtiny (předpokládám, že ano),
budete v anglickém prostředí muset „přetrpětÿ jen pár minut. Uložte si obrázek, vypněte GIMP
a v emulátoru terminálu zadejte: LANG=en US gimp
Tím spustíme „jednorázověÿ GIMP v angličtině. Nyní si otevřeme původní obrázek (File → Open
recent → název-obrázku) a použijeme Filters → Noise → Hurl s nastavením Randomization na 1 % a
Repeat na 1. Potvrdíme tlačítkem OK. Randomization nám určuje, na kolik procent pixelů z obrázku
bude filtr použit. Pokud nechceme zrovna tvořit hvězdokupu, i to minimum, 1 %, je pro nás až moc.
Repeat nastavuje, kolikrát bude filtr na obrázek aplikován, nám opět stačí „zašumětÿ jen jednou.
Tlačítko New seed, bez kterého se teď klidně obejdeme, generuje nová pseudonáhodná čísla, podle
kterých probíhá výpočet šumu.
To by z této krátké „english exkurzeÿ stačilo, můžeme obrázek uložit, vypnout GIMP a spustit ho
znovu „normálněÿ, česky, a obrázek znovu otevřít. Jak jste si určitě všimli, barevný výstup filtru
hvězdy ani trochu nepřipomíná. Velice jednoduchým Vrstva → Barvy → Odbarvit srovnáme tuto
diskotéku do latě, tedy udělíme všem hvězdám barvy šedých odstínů. Název funkce mluví sám za
sebe, ještě výstižnější je podle mě anglické Desaturate.
Než budeme pokračovat, prohloubíme trochu rozdíly mezi vzniklými body. Otevřeme dialog Vrstva
→ Barvy → Jas-kontrast, kde snížíme jas asi na -40 až -50 a naopak silně zvýšíme kontrast na 50 až
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60. Tím se zbavíme velmi slabých hvězd a naopak ty silnější ještě více zjasníme, aneb co tě nezabije,
to tě posílí. . .
Nyní přejmenujeme vrstvu Pozadí na Malé hvězdy (pravověrní programátoři a já na male hvezdy :-),
zduplikujeme ji a kopii přejmenujeme na Velké hvězdy. Nyní následuje krátká vsuvka o režimech
překrývání vrstev, které budeme za chvíli potřebovat.


Režimy vrstev
Na panelu Vrstvy si můžete všimnout rozbalovacího menu Režim, kde se nachází asi 20 možností.
Pokud zvolíme režim u nějaké vrstvy, ovlivníme tím, jak se budou prolínat barvy této vrstvy a vrstvy,
která je pod ní. Nebudu zde popisovat všechny dostupné režimy, podíváme se jen na ty, které budeme
častěji používat. Režimy se neobjevují jen u vrstev, ale i u mnoha kreslicích nástrojů, například
u plechovky nebo tužky. Pozn.: Když budu v následujícím textu psát „bíláÿ, myslím tím čistou
bílou, tedy #ffffff, stejně jako „černáÿ je #000000.


• Normální: Implicitní režim, vrstvy se nijak neovlivňují.
• Rozpouštění: Jako výsledná barva každého pixelu je náhodně zvolena buď barva horní vrstvy,
nebo spodní vrstvy. Vzniká tedy šum. Mimochodem, tímto způsobem by se dal také nahradit
filtr Noise-Hurl (úkol pro zvídavého čtenáře).


• Obraz: Zjednodušeně řečeno, čím tmavší je barva pixelu horní vrstvy, tím více je tento pixel
průhledný a je pod ním vidět barva pixelu spodní vrstvy. Barvy obou pixelů se míchají jako
v modelu RGB.


• Součet: Sčítá barvy obou vrstev, černá je minimální hodnota, bílá maximální.
• Rozdíl: Výsledkem je barva spodní vrstvy mínus barva horní vrstvy.


Další užitečná věc je nastavení celkové průhlednosti vrstvy posuvníkem Krytí. Krytí má vliv i na
výsledky režimů vrstev.


Výraznější hvězdy
Nyní se postaráme o to, aby si vrstva Velké hvězdy zasloužila své jméno. Opět použijeme Vrstva
→ Barvy → Jas-kontrast, tentokrát nastavíme jas asi na -110 a kontrast na 60. Zmizí nám tak sice
většina hvězd, to ale hned napravíme. Použijeme k tomu funkci Úrovně, kterou najdeme v menu
Vrstva → Barvy → Úrovně. V tomto dialogu můžeme měnit rozložení šedých odstínů v obrázku.
Uvidíme zde graf, který se nazývá histogram a který ukazuje zastoupení šedých odstínů v obrázku.
U naší vrstvy Velké hvězdy to moc jako graf nevypadá, protože černá má absolutní převahu a „bílýchÿ
bodů je v ní poskrovnu, zvláště po poslední drastické operaci Jas-Kontrast. Pokud bychom pracovali
např. s fotografií, vypadal by histogram poněkud zajímavěji. V části Vstupní úrovně posuneme levý
(černý) trojúhelníček na hodnotu 10 a pravý (bílý) na 40. Dojde k následujícím změnám:


1. Černý trojúhelníček: Všechny pixely obrázku, které se díky svému příliš tmavému odstínu mo-
hou v histogramu „hlásitÿ k pozicím 0 až 10 (od začátku grafu až k černému trojúhelníčku),
budou nemilosrdně přebarveny na černo. Tak se tedy zbavíme těch nejslabších, nejtmavších
bodů a z vrstvy Velké hvězdy uděláme „záležitost horních deseti tisícÿ, neboli pouze hvězd,
které září velmi silně, nebo jsou blízko k pozorovateli.


2. Bílý trojúhelníček: Přeživší body, které unikly věčnému černému zatracení a jsou světlejší, než
určuje hranice bílého trojúhelníku, budou naopak přebarveny na čistou bílou.


3. Zbytek: Body, které spadají do oblasti mezi trojúhelníky, budou přebarveny tak, aby byl za-
chován poměr šedých odstínů v obrázku. To nám zachová jistou variabilitu jasu i ve vrstvě
velkých hvězd.
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Velké hvězdy teď září až příliš jasně, což je ale záměr. Ná-
sleduje totiž malá úprava, která je sice zvětší, ale zároveň
utlumí. Nejdříve ale nastavíme režim vrstvy na Obraz.
To znamená, že její černý podklad bude úplně průhledný
(čím tmavší barva, tím průhlednější; černá #000000 pak
samozřejmě znamená absolutní průhlednost). Do vrstvy


Malé hvězdy se nám teď z Velké hvězdy promítají právě jen ty hvězdy a nikoli černý podklad. Stej-
ného efektu bychom dosáhli použitím funkce Vrstva → Průhlednost → Barva do alfy a zvolením černé
barvy. Možností je více, ať žije svoboda volby.


Velké hvězdy teď zvětšíme. Ujistěte se, že stále
pracujete jen s touto vrstvou, a otevřete dialog
Vrstva → Změnit velikost vrstvy. Zadejte šířku
1200 pixelů. Výška se adekvátně zvětší na 900 pi-
xelů pro zachování poměru stran. Jako obvykle
potvrďte tlačítkem Budiž. U fotografií bychom
takovým zvětšováním vytvořili rozmazaniny, ale
tady to nevadí, jde jen o bílé nebo šedavé body.
Posledním detailem je pak zarovnání rozměrů
vrstvy Velké hvězdy s celým obrázkem, což prove-
deme jednoduchým Vrstva → Velikost vrstvy dle
obrázku.


Dostali jsme se k takové základní jednotvárné hvězdné obloze. U každého, kdo postupoval podle
návodu až sem, vypadá obrázek zhruba stejně. V příštím díle nám konečně nastane příležitost vytvořit
si vlastní hvězdnou oblohu. Vytvoříme hvězdná seskupení (clustery), přidáme jim záři a vložíme
několik dominantních jasných hvězd na popředí. Zatím si můžete rozmyslet, jak by měla právě ta
vaše obloha vypadat.


Vytvoření vlastní stopy (brush)
Na následující operace budeme potřebovat trochu větší stopu, než nám GIMP nabízí. Nastavíme si
tedy vlastní. Otevřeme dialog Stopy (Brushes) Shift+Ctrl+B , kde klikneme na tlačítko Nová stopa
(New brush). Dialog nám nabízí tyto možnosti:


• Název stopy: Je vhodné si stopu nějak srozumitelně pojmenovat, protože orientace mezi Untit-
led, Untitled#1, Untitled#2 atd. není zrovna jednoduchá.


• Tvar (Shape): Kruh, čtverec, kosočtverec. Obrázková tlačítka srozumitelná i analfabetům :-).
• Poloměr (Radius): Snad není třeba vysvětlovat.
• Hroty (Spikes): Nemá smysl u kruhu. Z původního čtverce zde můžete udělat např. šestiúhelník.
Kombinace Kosočtverec + větší počet hrotů vytváří hvězdy.


• Tvrdost (Hardness): Udává, jak bude zaostřená hrana.
• Poměr stran (Aspect ratio): Z kruhů elipsy, ze čtverců obdélníky a z kosočtverců sprosté ob-
rázky.


• Úhel (Angle): Pootočení stopou.
• Rozestup (Spacing): Udává, jak od sebe budou vzdáleny jednotlivé stopy při kreslení tahem,
tzn. když kreslíme se stisknutým tlačítkem myši. Údaj je v procentech šířky stopy.


My si vyrobíme následující stopu:


• Název stopy: Circle (60)
• Tvar: Kruh
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• Poloměr: 30.0
• Tvrdost: 1.00
• Poměr stran: 1.00
• Rozestup: 1.00


Likvidace hvězd
Úpravy začneme malým promazáním oblohy. Použijeme k tomu nástroj Štětec
(Paintbrush), zkratka P. Popíšu pouze nové vlastnosti, s některými jsme se už
setkali.


• Stopa (Brush): Každý ví, co je to stopa, že?
• Citlivost na tlak (Pressure sensitivity): Které vlastnosti bude ovlivňovat tlak na nástroj. Nejlepší
využití bychom asi našli u tabletu.


• Doběh (Fade out): Způsobuje efekt „vypsání fixyÿ, a to po vzdálenosti zadané v políčku Délka.
• Postupný (Incremental): Má význam, pouze pokud máme Krytí (Opacity) nastaveno na méně
než 100 %. Pokud toto políčko není zaškrtnuto a při kreslení „natřemeÿ jedno místo vícekrát,
jeho krytí nepřekročí hodnotu, kterou máme u tohoto nástroje zadanou. Pokud je zaškrtnuto,
můžeme vícenásobným „natíránímÿ krytí v obrázku zvýšit (je to jako bychom na sebe pokládali
částečně průhledné fólie – čím více jich je, tím výraznější je celková barva)


• Použít barvu z přechodu (Use color from gradient): Místo barvou popředí kreslí nástroj aktivním
gradientem (přechodem). Při aktivaci této vlastnosti máme tyto další možnosti:


◦ Přechod (Gradient): Výběr použitého gradientu.
◦ Obrátit (Reverse): Prohodit koncové barvy gradientu.
◦ Délka (Length): Do jaké délky se gradient rozloží (pokud chcete malovat housenku, na-
stavte třeba 7 pixelů).


◦ Opakování (Repeat): Jakým způsobem na sebe budou navazovat opakování gradientu:


1. Trojúhelníková vlna (Triangular wave): Návaznost je plynulá, jakmile se gradient
dostane na konec, je aplikován znovu v obráceném pořadí barev.


2. Pilová vlna (Sawtooth wave): Jakmile se gradient dostane na konec, je aplikován
znovu od začátku, obvykle vznikají „zubyÿ.


3. Nic (None): Po ukončení gradientu se dál pokračuje jeho koncovou barvou.


Nastavíme si barvu popředí (foreground color) jako černou, Krytí (Opacity) nástroje 100 %, stopu
Circle (60) a deaktivujeme volby Doběh, Postupný a Použít barvu z přechodu. Začneme promazávat
některé shluky hvězd, v každé „hvězdnéÿ vrstvě zvlášť. Větší pozornost budeme ale věnovat vrstvě
Velké hvězdy, protože větších hvězd je obvykle vidět méně. Už teď byste měli mít představu, jak by
vaše dílo mělo vypadat, a podle toho mazat či zachovávat nějaká uskupení hvězd. Podle potřeby
můžete změnit krytí např. na 60 % a vyrobit nějaké slabší hvězdy. Neměli byste to ovšem přehánět,
aby z těch hvězd taky něco zbylo. . .


Seskupování hvězd
Teď, když jsme vytvořili nějaké ty „díryÿ v prostoru, vydáme se cestou opačnou a některé hvězdy
seskupíme. Budeme používat nástroj Klonování (Clone) se zkratkou C. Nástroj funguje tak, že mu
nejprve se stiskem klávesy Ctrl zadáme zdrojovou část obrázku a poté s ním kreslíme, jako by to
byl například štětec. Místo barvy nebo vzorku je však používána udaná zdrojová část obrázku, odtud
tedy název Clone – Klonování. Nějakou část obrázku prostě použijeme ještě jednou někde jinde. Je
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to základní technika pro retušování fotografií. Některé vlastnosti už opět známe, nebudu se k nim
vracet.


• Ostré hrany (Hard edge): GIMP bude se stopou zacházet, jako by byla pouze dvoubarevná.
Neostré hrany, jako mají např. stopy Circle Fuzzy, převede na černou a bílou.


• Zdroj (Source): Odkud bude nástroj brát svůj vzorek:


◦ Zdroj obrázku (Image source): Klasické použití tohoto nástroje – klonování obrázku.
◦ Zdroj vzorku (Pattern source): Místo části obrázku je jako zdroj použit aktivní vzorek
(pattern).


• Sledování (Alignment): Určuje posun zdrojové části obrázku vůči cíli. Tuto ilustraci jsem si
vypůjčil z nápovědy GIMPu. Černý kříž znázorňuje pozici zdrojové části a červený čtvereček
místo aplikace nástroje.


◦ Nezarovnáno (Non-aligned): Zdroj je určen jednou, při prvním zaměření s klávesou Ctrl
a jeho pozice není při další aplikaci nijak ovlivňována.


◦ Sledující (Aligned): Prvním použitím nástroje (poté, co je udána zdrojová část) stanovíme
odsazení mezi zdrojem a cílem. To je pak dodržováno při každé další aplikaci.


◦ Registrující (Registered): Dodržuje stejné odsazení zdroje i cíle. Využití samozřejmě na-
jde, pouze když se zdroj a cíl nenacházejí na stejné vrstvě nebo ve stejném obrázku.


Než začneme klonovat, nejprve sloučíme obě vrstvy hvězd. Vybereme vrchní vrstu (Velké hvězdy)
a provedeme Vrstva → Sloučit dolů (Layer → Merge down). Neopomeneme vzniknuvší vrstvu pře-
jmenovat na pouhé Hvězdy. Jak by se mohla jmenovat Malé hvězdy, když teď obsahuje i velké? :-)
Nyní se chopíme nástroje Klonování a nastavíme ho následovně:


• Krytí: 100 %
• Režim: Obraz (Screen)
• Zdroj: Zdroj obrázku
• Sledování: Nezarovnáno
• Doběh: NE
• Ostré hrany: NE


Jako stopu (brush) je vhodné zvolit Circle (19), pro
větší úpravy naši Circle (60). A můžeme začít vesele
klonovat! Za stisku klávesy Ctrl vybereme něja-
kou oblast s větší hustotou hvězd, a kde se nám
zlíbí, tam začneme vytvářet hvězdné chuchvalce
a skupiny. Díky zvolenému režimu nástroje Obraz
budeme hvězdy ze zdroje jakoby přidávat, místo
abychom je zdrojem přemazávali, jak by se stalo,
pokud bychom použili implicitní režim Normální.


Je nutné dávat pozor, aby nevznikaly příliš podobné části obrázku. Každý zdroj by měl být použit
pouze několikrát a pak změněn. Vyhněte se také klonování příliš blízko u zdroje. Tato fáze opět
záleží na vaší vlastní představě. Do závěrečné fáze byste neměli vstupovat, dokud nejste s výsledkem
spokojeni.
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Už se pomalu blížíme ke konci. Nyní možná obětujeme trochu realističnosti ve prospěch efektu.
Hvězdám přidáme záři, kterou ovlivníme celkovou barevnou náladu obrazu. Vložíme také několik
opravdu velkých dominantních hvězd.


Záře
Zduplikujeme vrstvu Hvězdy a kopii pojmenujeme Záře. Necháme ji navrchu a nastavíme její režim
na Obraz (Screen). Záře bude nejsilnější tam, kde hvězdy svítí nejjasněji, ať už díky jejich koncen-
traci, nebo velikosti. To je celkem logické ;-). Tohoto efektu dosáhneme prostým rozmazáním kopie
„hvězdnéÿ vrstvy. Proto jsme vytvářeli vrstvu Záře. Než ji ale rozmažeme, použijeme na ni naši dobře
známou funkci Úrovně (Levels). Posuneme pouze bílý trojúhelníček, a to na hodnotu přibližně 140.
Tím všechny hvězdy znatelně zjasníme, abychom měli vůbec co rozmazávat.
Dále otevřeme dialog Filtry → Rozostření → Gaussovo rozostření (Filters → Blur → Gaussian blur).
Funkce funguje tak, že barvu každého pixelu v obrázku nastaví jako průměrnou barvu všech okolních
pixelů ve vzdálenosti udané v políčcích Poloměry rozostření (Blur Radius). GIMP nabízí dva algo-
ritmy pro výpočet rozostření, IIR a RLE, které se od sebe za určitých okolností mohou lišit rychlostí.
Výsledky ale mají oba stejné.
Poloměry rozostření nastavíme oba shodně na hod-
notu 8.0 až 10.0 a aktivujeme filtr. Pokud nebudeme
s výsledkem spokojeni, můžeme využít kouzelné
kombinace Ctrl+Z - Ctrl+Shift+F . Jak určitě víte,
Ctrl+Z je zkratka pro krok zpět. Ctrl+Shift+F
je pak znovuzobrazení dialogu posledního použitého
filtru, kde můžeme změnit parametry a vyzkou-
šet ho znovu. Jakmile jsme spokojeni s rozmazá-
ním vrstvy Záře, můžeme ji obarvit pomocí dialogu
Vrstva → Barvy → Vyvážení barev (Layer → Colors
→ Color balance), kde pomocí jednotlivých posuv-
níků „vyrobímeÿ záři například nafialovělou nebo
modrou.


Velké hvězdy
Opravdu posledním krokem je teď přidání několika velmi silných hvězd zářících v popředí. Dosáhneme
toho pomocí filtru Supernova. Nejprve si vytvoříme novou vrstvu, které nastavíme dvojnásobné roz-
měry oproti celému obrázku a jako výplň nastavíme průhlednost. Pojmenujeme ji Hvězda #1. Tuto
vrstvu si několikrát „do zásobyÿ zduplikujeme a necháme se přitom unést dokonalostí GIMPu, díky
které se nám tyto kopie automaticky pojmenovávají Hvězda #2, Hvězda #3 atd. Poté otevřeme dia-
log Filtry → Efekty se světlem → SuperNova (Filters → Light effects → SuperNova). Tento filtr nám
dovoluje vytvořit působivé zářivé hvězdy, ale má jednu malou nevýhodu: záře, která se okolo hvězdy
vytváří, je vykreslena do velmi velké vzdálenosti. Pokud bychom tuto hvězdu umístili příliš blízko ke
hraně vrstvy a poté se rozhodli ji přesunout jinam, na její záři bude tato hrana velmi výrazně vidět.
Proto jsme vytvořili tak rozměrnou vrstvu. Hvězdu nejprve umístíme doprostřed této velké vrstvy
a pak ji teprve přesuneme na požadované místo.
Pro dokonalé vycentrování hvězdy změníme v části Střed SuperNovy (Center of SuperNova) jednotku
z pixelů na procenta a do obou políček X, Y vepíšeme 50.0. Stručně si popíšeme zbývající volby:


• Zobrazit kurzor (Show cursor): Zapíná nebo vypíná zobrazování zaměřovacího kříže v náhledu.
Užitečné, pokud vytváříme velmi malou hvězdu.


• Barva (Color): Co jiného, než barva efektu?
• Poloměr (Radius): Velikost hvězdy.
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• Paprsky (Spokes): Počet paprsků hvězdy. Při velkém počtu paprsků a malém poloměru vzniká
zajímavý zrnitý efekt.


• Náhodný odstín (Random hue): Určuje, kolik náhodných barev se nám může do hvězdy přimí-
chat.


Barvu hvězdy doporučuji nastavit tak, aby alespoň trochu ladila s barvou
Záře. Náhodný odstín samozřejmě ponecháme na nule, zbývající parametry
jsou na vás, ale Poloměr bych nenastavoval větší než 20. Po potvrzení tla-
čítkem Budiž můžeme pomocí nástroje Přesun (Move) umístit celou vrstvu
s hvězdou na její místo určení.


Poté můžeme buď použít naše „zásobníÿ vrstvy Hvězda #x a znovu na ně použít efekt SuperNova,
nebo tu stávající zkopírovat, změnit její velikost a použít jinde. Snažte se vytvářet hvězdy různých
velikostí a jemně odlišných odstínů nebo s různým počtem paprsků. Nic se ovšem nesmí přehánět!
V obrázku by nemělo být více než 7 takových velkých hvězd. Nástroj Přesun (Move) se zkratkou M
je velmi jednoduchý:


• Ovlivnit (Affect): Určuje, zda chcete přesouvat vrstvy, výběr, nebo cesty.
• Přepínač nástrojů (Tool toggle): Určuje, co budeme vlastně chtít přesouvat.


◦ Vyberte vrstvu nebo vodítko/Vyberte cestu (Pick a layer or guide): Na kterou vrstvu/cestu
klikneme, tu budeme přesouvat.


◦ Přesunout aktuální vrstvu/cestu (Move the current layer): Bez ohledu na to, kam v ob-
rázku klikneme, vždy budeme přesouvat aktivní vrstvu/cestu.


Teprve když jsme spokojeni s rozmístěním velkých hvězd, každou jejich vrstvu ořežeme na velikost
obrázku naším známým Vrstva → Velikost vrstvy dle obrázku (Layer → Layer to image size).


Kámen


Začneme tím, že si seženeme nějakou „kamennouÿ texturu. Buď si něco najdeme
pomocí Googlova hledání obrázků, anebo můžeme použít například toto (obrá-
zek). Důležité je, aby textura byla bezešvá, tzn. aby šla skládat vedle sebe jako
dlaždice a nebyly vidět její hrany. Bude se nám hodit i později, takže je vhodné
si ji uložit jako vzorek (pattern), a to do složky ∼/.gimp/„verzeÿ/patterns/.


Základem je koule
Spustíme GIMP a založíme nový obrázek o velikosti 500×500 pixelů. Zvolíme Pokročilé možnosti
(Advanced Options) – Vyplnit s (Fill with) – Průhlednost (Transparency). Vrstvu Pozadí si přejme-
nujeme na Koule. Pomocí nám známého nástroje Plechovka (Bucket fill) si vyplníme celou plochu
onou „kamennouÿ texturou. Pokud jste si ji uložili do zmíněné složky, měla by se vám objevit v dia-
logu Vzorky (Patterns). Nastavíme Typ vyplňování (Fill type) na Vyplňování vzorkem (Pattern fill)
a jako výplň zvolíme naši texturu. Vytvořili jsme tak povrch budoucího kamene. Z toho teď složíme
kouli, a to pomocí filtru Mapovat objekt (Map object), který najdeme v menu Filtry → Mapa →
Mapovat objekt (Filters → Map → Map object). Tento filtr umožňuje z aktivní vrstvy udělat trojroz-
měrný objekt, u kterého můžeme nastavit mnoho vlastností, které jsou rozděleny do čtyř nebo pěti
záložek:


• Volby (Options):
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◦ Mapovat na (Map to): Na jaké 3D těleso se povrch „natáhneÿ.


1. Rovina (Plane)
2. Koule (Sphere)
3. Hranol (Box)
4. Válec (Cylinder)


◦ Průhledné pozadí (Transparent background): Pokud nebude zaškrtnuto, kolem mapova-
ného objektu se vytvoří bílé pozadí. V opačném případě bude průhledné. Jak prosté.


◦ Opakovat zdrojový obrázek (Tile source image): Jestliže není zdrojový obrázek dostatečně
velký, buď se roztáhne a nebo, v případě zaškrtnutí tohoto pole, bude skládán vedle sebe
jako dlaždice.


◦ Vytvořit nový obrázek (Create new image): Výstup filtru se nám uloží do zcela nového
obrázku a ten původní zůstane nedotčen.


◦ Povolit vyhlazování (Enable antialiasing): Vyhlazování povrchu. Kvalita se dá nastavit
v poli Hloubka (Depth), v poli Práh (Threshold) nastavujeme citlivost.


• Světlo (Light): Odkud a jak bude 3D objekt osvětlen. Při použití světla je efekt trojrozměrnosti
ještě dokonalejší.


◦ Typ zdroje světla (Lightsource type):


1. Bodové světlo (Point light): Pozici tohoto světla můžeme nastavovat nejen v polích
Poloha (viz dále), ale i přímo v okně náhledu, kde se zobrazuje jako modrý bod.
Stačí použít tlačítka na přiblížení/oddálení.


2. Směrové světlo (Directional light)
3. Žádné světlo (No light)


◦ Barva zdroje světla (Lightsource color): Jakoupak bude mít světo barvu ?
◦ Poloha (Position) / Směrový vektor (Direction vector): Bližší určení buď polohy, nebo
směru, v závislosti na vybraném typu světla. Přirozeně se nezobrazuje, pokud máme
vybraný typ Žádné světlo – No light.


• Materiál (Material): Ovlivňuje, jaké vlastnosti bude mít povrch tělesa. Volby budou určitě
známé těm, kdo pracují např. s Blenderem nebo jiným 3D modelovacím programem, i když
zde jsou mnohem omezenější.


◦ Úrovně intenzity (Intensity levels):


1. Okolí (Ambient): Určuje, jak světlá bude oblast, kam přímo nedopadá světlo.
2. Difúze (Diffuse): Udává naopak, jak intenzivní bude barva tam, kam světlo dopadá.


◦ Reflectivity (Odrazivost):


1. Difúze (Diffuse): Jak moc bude objekt odrážet světlo (čím více, tím bude světlejší).
2. Odraz (Specular): Jak intenzivní bude světelný odlesk.
3. Odlesk (Highlight): Zaostření odlesku. Při jiných hodnotách než je implicitní 27.00
často vytváří zvláštní černé pruhy.


• Orientace (Orientation): Umístění 3D tělesa v prostoru. Myslím, že všechny položky Pozice
(Position) a Rotace (Rotation) hovoří samy za sebe.


• Válec (Cylinder): Aktivní pouze tehdy, když mapujeme na válec.


◦ Obrázky pro uzavírací plošky (Images for the Cap Faces): V menu Nahoře (Top) a Dole
(Bottom) můžeme zvolit, která vrstva bude pokrývat horní, resp. spodní základnu válce.
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Lze použít i vrstvy z jiných obrázků, které máme právě otevřené. Pokud ovšem válec není
natočen tak, že je některá jeho základna vidět, nemá smysl toto nastavovat.


◦ Velikost (Size):


1. Poloměr (Radius): Poloměr válce vzhledem k šířce vrstvy.
2. Délka (Length): Délka (výška) válce vzhledem k výšce vrstvy.


• Hranol (Box): Aktivní pouze tehdy, když mapujeme na hranol.


◦ Mapovat obrázek do plošek hranolů (Map Images to Box Faces): Podobně jako u základen
válce umožňuje nastavit povrch z vrstev, a to pro každou stranu hranolu zvlášť.


◦ Zvětšení X,Y,Z (Scale X,Y,Z): Nastavuje poměr stran, z krychle tedy můžeme udělat
kvádr. Velikosti jsou opět uváděny vzhledem k rozměrům vrstvy.


My chceme vytvořit kouli, takže v nabídce Mapovat na vybereme
samozřejmě Koule. Dále uvádím pouze odlišnosti od implicitních
nastavení:


• Průhledné pozadí Ano
• Úrovně intenzity – Difúze 0.80
• Odrazivost – Odraz 0.00


Filtr nám vytvořil kouli, kterou si pokřivíme tak, aby vypadala jako nějaký kámen, ale nejdříve ji
musíme zdrsnit, protože na kámen možná vypadá trochu hladce. Alespoň se díky nastavení Odrazivost
– Odraz na 0.00 příliš neleskne.


Zdrsnění koule
Už samotná kamenná textura navozuje dojem drsnosti, ale my tomu ještě trochu pomůžeme, a to
použitím techniky Reliéf (Emboss), která vytváří dojem, jakoby byl obrázek vytepán do plátu kovu.
Tmavé oblasti vytvářejí „údolíÿ, světlé zase „horyÿ.


• Funkce (Function):


◦ Reliéf (Emboss): Výsledek je zbaven barvy a vypadá opravdu jako reliéf v kovu.
◦ Mapa vyvýšení (Bumpmap): Výsledek je jemnější a zachovává původní barvy.


• Azimut (Azimuth): Ovlivňuje, z které strany dopadá na reliéf světlo.
• Zdvih (Elevation): Výška světla nad „obzoremÿ. Hodnota 90 je „pravé poledneÿ, světlo tedy
svítí přímo shora.


• Hloubka (Depth): Hrubost povrchu.


Nyní už můžeme aplikovat filtr. Najdeme ho v menu Filtry → Zkres-
lení → Reliéf (Filters → Distorts → Emboss). Použijeme následující
nastavení:


• Funkce: Mapa vyvýšení
• Azimut: 270.0
• Zdvih: 70.0
• Hloubka: 8
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Pokřivení koule
Z pěkné hrbolaté kamenné koule teď vytvoříme nějaký kamínek. Ke křivení vrstvy se používá filtr
Zkřivit – Filtry → Zkreslení → Zkřivit (Filters → Distort → Curve bend). Umožňuje nastavit dvě
křivky, podle kterých jsou pak pokřiveny opačné okraje vrstvy. Podle základního nastavení jsou to
horní a dolní okraje, ale to lze změnit. Opět si popíšeme nastavení:


• Upravit křivky (Modify Curves): Okno, ve kterém pomocí myši nastavujeme křivky.
• Křivka hranic (Curve for border): Určuje, zda budeme v okně Upravit křivky upravovat horní
křivku (Upper) nebo spodní (Bottom).


• Typ křivky (Curve type): Jakým způsobem budeme křivku upravovat v okně Upravit křivky:


◦ Plynulá (Smooth): Při editaci ovlivňujeme jednotlivé body křivky.
◦ Volná (Free): Křivku přímo kreslíme tahem myši. Původní křivka je nahrazována.


• Volby (Options)


◦ Rotovat (Rotate): Pootočení efektem. Při hodnotě 0.0 je křivka označená jako Horní
(Upper) skutečně aplikována na horní okraj vrstvy. Například při hodnotě 90.0 už ale
ovlivňuje levý okraj (rotace je proti směru hodinových ručiček).


◦ Vyhlazování (Smoothing, Antialiasing): Pro vyhlazení ostřejších přechodů ve výsledném
obrázku můžeme použít volby Vyhlazování a. . . ano, opět Vyhlazování :-) Zřejmě slabá
chvilka překladatelů. . .


◦ Pracovat na kopii (Work on copy): Výstup filtru se aplikuje na úplně novou vrstvu a ta
původní zůstane beze změny.


• Kopírovat (Copy): Zkopíruje aktivní křivku (určenou volbou Křivka hranic) místo druhé, ne-
aktivní křivky.


• Zrcadlit (Mirror): Podobně jako Kopírovat, ale křivka je převrácena, tedy zrcadlena.
• Prohodit (Swap): Vymění obě křivky.
• Obnovit (Reset): Vymaže aktivní křivku.
• Otevřít (Open) a Uložit (Save): Vytvořené křivky si můžeme uložit pro další použití.


Teď už nám zbývá jen podle vlastního uvá-
žení vyrobit nějaký ten balvan. Nejprve
bych začal konverzí koule na brambor. Asi
bude nejjednodušší uvést screenshot místo
dlouhého vysvětlování:
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Nyní už zbývá jen experimentovat. Znovu a znovu používat filtr Zkřivení a vytvářet jiné a jiné kusy
skály. Se svým kamením si můžete hrát tak dlouho, dokud nebudete spokojeni. . . Vyžaduje to hodně
pokusů a „kouzelných kombinacíÿ Ctrl+Z - Ctrl+Shift+F (Krok zpět + Vyvolání dialogu naposledy
použitého filtru). Občas se hodí používat volbu Typ křivky – Volná. Je též nutné občas měnit hodnotu
Rotovat.


Tento díl byl výrazně „filtrovýÿ a trochu více popisný, ale příště se zase vrátíme k tradičním nástrojům
GIMPu. Pohrajeme si také s plug-iny Script-Fu, a to všechno při tvorbě meteoru a možná i komety.
Pro oboje budeme kámen, který jsme se dnes naučili vytvářet, potřebovat.


Příprava & obloha
Před spuštěním GIMPu si do složky ∼/.gimp/„verzeÿ/patterns/ uložte novou kamennou texturu:


Pak už můžete GIMP spustit a vytvořit nový obrázek. Velikost zvolte 800 x 400
pixelů. Budeme potřebovat spoustu místa na ohnivou stopu meteoru. Dopředu
přiznávám, že s oblohou se moc párat nebudeme a uděláme ji prostě jedno-
barevnou, asi jako při soumraku. Vhodná barva je například #171833. Vrstvu
s oblohou pojmenujeme překvapivě Obloha. Hvězdná obloha [2] se sem moc
nehodí, protože to pak může vypadat, že meteor letí volným vesmírem, a to
je samozřejmě nesmysl. V tom případě by to totiž byl meteoroid a nemohl by


hořet. Možná se v některém z příštím dílů podíváme na tvorbu jednoduchých mraků. . .
Na konec přípravy si uděláme jádro meteoru – kámen připravený podle návodu v minulém díle (GIMP
v příkladech – 3 (kámen) [3], ale s novou texturou, kterou jste si právě uložili. Při použití filtru
Zdrsnění je skvělým nápadem nastavit větší hodnotu parametru Hloubka (Depth), meteor tak bude
drsnější. Doporučuji vytvářet ho větší (400 x 400) a po dokončení zmenšit na velikost okolo 50 x 50
pixelů funkcí Vrstva → Změnit velikost vrstvy (Layer → Scale layer). Pak už stačí kámen přesunout
do levého nebo do pravého spodního rohu obrázku, řekněme 40 pixelů od okrajů. Použijeme, jak
jinak, nástroj Přesun (Move). V tomto projektu budeme operovat s mnoha vrstvami a doporučuji
vám je hned od začátku smysluplně pojmenovávat. Budiž tato vrstva zvána Jádro.


Z kamene kámen rozžhavený
Jako každé těleso, které vstupuje do atmosféry vysokou rychlostí, bude se náš meteor třením rozžha-
vovat. Efektu dosáhneme dvěma metodami: tónováním kamene do „žhavě vypadající barvyÿ a ob-
klopením ohnivou září. Zabarvení provedeme jednoduchou funkcí Vrstva → Barvy → Vyvážení barev
(Layer → Colors → Color balance). Za zmíněnou „žhavě vypadající barvuÿ můžeme považovat nějaký
odstín červeno-oranžové, takže si pohrajeme s posuvníky směrem k červené a žluté. Lepší je použít
tento dialog hned několikrát. Dobrý nápad je také pomocí funkce Vrstva → Barvy → Jas-kontrast
(Layer → Colors → Brightness-Contrast) zvýšit kontrast i jas.
Pro ohnivou záři se nám dokonale hodí jedno z rozšíření Script-Fu – Sálající záře (Glowing hot).
Patří do skupiny rozšíření Alfa do loga (Alpha to logo). Tyto plug-iny většinou vytvářejí své efekty
ve vybrané vrstvě kolem tvarů ohraničených průhledností (alpha). Podle toho také získaly svůj název
– často se používají na dekoraci textů či logotypů. Náš plug-in tedy najdeme jako Skript-fu → Alfa
do loga → Sálající záře (Script-fu → Alpha to logo → Glowing hot). Na rozdíl od klasických filtrů
mívají plug-iny velmi jednoduché nastavení, což je ale spíše výhoda.


• Velikost efektu (Effect size): Do jaké vzdálenosti se „oběťÿ efektu rozzáří. Teoreticky bude mít
efekt třetinový rozměr oproti zadanému číslu (viz poznámka „pixely*3ÿ), ve skutečnosti je
patrný do vzdálenosti ještě menší.


Abíčko ? Duben 2006 ? www.abclinuxu.cz – Linux na stříbrném podnose ? Zprávičky – wap.abclinuxu.cz ? 20



http://www.abclinuxu.cz/clanky/navody/gimp-v-prikladech-1-hvezdna-obloha

http://www.abclinuxu.cz/clanky/navody/gimp-v-prikladech-3-kamen

http://www.abclinuxu.cz/clanky/navody/gimp-v-prikladech-3-kamen

http://www.abclinuxu.cz

http://wap.abclinuxu.cz





praceabc.cz – pracovní nabídky z oblasti Linuxu a IT


• Barva pozadí (Background color): Plug-in z průhledných částí vrstvy udělá pozadí o zadané
barvě.


Pro náš účel zvolíme Velikost efektu 50 pixelů a pozadí třeba černé, nehraje totiž žádnou roli. Tady
musím upozornit, že plug-in s obrázkem pěkně zacvičí a vytvoří nějaký balast navíc. Nepříjemné je,
že celý obrázek ořízne na rozměry použité vrstvy, kterou ještě k tomu zničí. Proto před použitím
ještě zduplikujeme vrstvu Jádro a tak nám vznikne Jádro kopie. Vrstvu ani nemusíme přejmenovávat,
stejně se jí hned zbavíme, jenom provedeme Vrstva → Velikost vrstvy dle obrázku (Layer → Layer to
image size). Pak už můžeme plug-in použít. Jak jsem říkal, v obrázku se nám objeví malý nepořádek.
Smažeme vrstvy Jádro kopie a Background, vrstvu Glow layer si přejmenujeme na Jádro – Záře
a umístíme ji pod vrstvu Jádro.


Meteorická stopa
Postup při vytváření stopy velmi připomíná skutečnou malbu skutečným pastelem :-). V podstatě
si pomocí Štětce (Paintbrush) na plátno naneseme barvu, kterou pak nástrojem Šmouha (Smudge)
rozmažeme do požadovaných kreací. Štětec jsme už používali, u Šmouhy se zkratkou S už většinu
vlastností známe z jiných nástrojů. Nástroj funguje přesně jako skutečné rozmazávání barvy prstem.
Při používání Šmouhy záleží také na směru – mějme například černý kruh na bílém pozadí. Kruh
můžeme asimilovat, když začneme rozmazávat bílé pozadí směrem do kruhu. Nebo můžeme rozšiřovat
barvu kruhu okolo, když budeme mazat z kruhu ven do bílé.


• Krytí (Opacity): V podstatě ovlivňuje, kam až daleko bude znatelná stopa barvy, do které při
rozmazávání vjedeme „rukouÿ.


• Přeběh (Rate): Ovlivňuje, jak daleko bude nástroj kreslit původní barvou, než „podlehneÿ
a začne šířit barvu novou. Vlastnosti Krytí a Přeběh se funkčností tak trochu kryjí.


My si stopu namalujeme ve dvou nezávislých vrstvách – v jedné žlutou, ve druhé oranžovo-červenou.
Vytvoříme tedy dvě nové průhledné vrstvy se jmény Jádro – Stopa – Červená a Jádro – Stopa –
Žlutá. Nejlepší je asi přepínat se mezi vrstvami a pracovat na obou stopách najednou. Abychom
měli co rozmazávat, tak štětcem s naší stopu (brush) Circle (60) uděláme v obou vrstvách „malé
tečkyÿ přímo u meteoru. Pak si vytvoříme další stopu – podobně jako jsme si nastavili Circle (60),
ale tentokrát o polovičním poloměru (Radius), takže budeme mít Circle (30). Touto novou stopou
si nakreslíme přibližně 350 pixelů dlouhou čáru ve směru požadovaných plamenů, a to přirozeně
do každé ze dvou „stopovýchÿ vrstev správnou barvou. Doporučuji „červenouÿ vrstvu umístit nad
žlutou a nastavit jí krytí asi 50–60 %.


A teď už si můžeme vesele špinit prsty! Pro rozmazávání budou potřebné různé velikosti stop (brush),
od Circle (15) až po Circle (60). Je možné vyzkoušet i neostré Circle Fuzzy. A pak už jen rozmazávat
a rozmazávat obě vrstvy tak dlouho, dokud výsledek neodpovídá vašim představám. Jako obvykle,
tato fáze závisí na vaší vlastní kreativitě a chuti experimentovat. . .
Je možné, že se vám působením rozmazávání udělají v plamenech „vráskyÿ. To lze jednoduše vyřešit
filtrem Gaussovo rozostření (Gaussian blur), popsaném ve druhém dílu (GIMP v příkladech – 2
(hvězdná obloha 2) [4]). Poloměr rozostření nastavený na 3.0 se zdá být dobrou volbou.
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Úlomky meteoru (volitelný doplňek)
Pokud náš meteor není zrovna stogramové smítko, mohl by se při svém pádu k povrchu Země roz-
padat. Zkusme do obrázku přidat několik menších úlomků.


Nejjednodušší bude zkopírovat vrstvu Jádro, pozměnit tvar naším známým filtrem Zkřivit (Curve
bend) a nakonec ji zmenšit a přesunout na vhodné místo. Ještě lepší bude, když tento nový úlomek
také trochu přebarvíme nebo změníme jas a kontrast. Jeden malý úlomek bychom mohli umístit
blízko jádru, takže pro něj bude stačit odštěpit větev stopy z jádra a nemusíme vytvářet extra
„stopovéÿ vrstvy. Pak ale umístíme jeden fragment ve větší vzdálenosti a rozmažeme mu vlastní
stopu podobným způsobem jako u jádra, jen trochu menší. Teď už je opravdu nutné udržovat si
pořádek v názvech vrstev, například takto:


Dokončení
Jako poslední doplněk si do hořící části meteoru
umístíme světelný efekt SuperNova, který jsme už
používali ve druhém dílu seriálu. Opět se bude ho-
dit trik s dvojnásobně velkou vrstvou, umístěním
hvězdy přesně doprostřed a následným přesunu-
tím na místo. Barvu zvolte žlutobílou, poloměr
20 až 25 a paprsky 450 až 500.


Blesk
Jediné, co se na produkci blesku v GIMPu dá nazývat prací, je nakreslit věrohodně vypadající
klikatící a větvící se čáru :-). Alespoň se ale přesvědčíme, že GIMP není výhradně bitmapový editor,
ale že nějaký ten vektorový modul se v něm také najde, i když těžko srovnatelný se specializovanými
vektorovými editory, jako jsou např. Inkscape nebo Sodipodi. Založíme nový obrázek o rozměrech
400x600 pixelů a začneme obligátní vrstvou Pozadí. Zatím jsme se stále nedostali ke generování
mraků v GIMPu, takže máme výmluvu, proč se spokojit s jednobarevnou oblohou. Hlavně to nesmí
být šmolková modř letního slunečného dne, nýbrž zlověstně temný závěs černého mračna, jenž s sebou
přináší předzvěst temnoty, bouře, výpadků proudu a horečnatého hledání médií s poslední zálohou :-
D. Například #0b1621.
Nastává čas odhalit sílu nástroje Gfig, který je k nalezení v menu Filtry → Vykreslení → Gfig (Filters
→ Render → Gfig).


Filtr Gfig
Gfig je nástroj pro vektorovou kresbu. To znamená, že na rozdíl od bitmapového kreslení, při kterém
se ukládají informace o jednotlivých pixelech, zaznamenávají se zde body, úsečky, křivky apod. jako
objekty. Po skončení vektorové editace jsou všechny tyto objekty převedeny do normální bitmapové
vrstvy (filtr vytvoří novou vrstvu se jménem Gfig).


Abíčko ? Duben 2006 ? www.abclinuxu.cz – Linux na stříbrném podnose ? Zprávičky – wap.abclinuxu.cz ? 22



http://www.abclinuxu.cz

http://wap.abclinuxu.cz





praceabc.cz – pracovní nabídky z oblasti Linuxu a IT


V menu Soubor (File) najdeme obvyklé příkazy Otevřít, Uložit a Zavřít (Open, Save, Close). Svůj
vektorový výtvor si tedy můžeme uložit tak, jak je (objektový model), a použít jej znovu. Menu
Úpravy (Edit) nám nabízí všeříkající Zpět (Undo) a Vymazat (Clear). Dále se zde dá nastavit Mřížka
(Grid) – lze ovlivnit Rozestup (Spacing), Typ (Type) a Barva (Color). V dialogu Nastavení (Prefe-
rences) máme několik voleb, které snad není třeba dlouze vysvětlovat. V ikonové liště najdeme tyto
nástroje a funkce:


• Vytvořit čáru (Create line): Tažením myši nakreslíme prostou rovnou čáru, která má dva kon-
trolní (řídící) body.


• Vytvořit kružnici (Create circle): Nakreslíme kružnici, která má jeden kontrolní bod pro svůj
střed a jeden pro poloměr.


• Vytvořit elipsu (Create ellipse): Elipsa, která má stejné kontrolní body jako kružnice.
• Vytvořit výseč (Create arc): Tažením myši umístíme tři body, které určují kruhový oblouk.
• Vytvořit pravidelný mnohoúhelník (Create reg polygon): Pravidelný n-úhelník, kde číslo n se
zadává vpravo v poli Počet stran (Sides). N-úhelník má jeden kontrolní bod pro střed a jeden
pro poloměr. Maximální počet stran (n) je 200, minimální přirozeně 3.


• Vytvořit hvězdu (Create star): Hvězda s jedním kontrolním bodem pro střed, druhým pro
vnější poloměr (délka ramen) a třetím pro vnitřní poloměr (vzdálenost ramen od středu).
Počet vrcholů se nastavuje v poli Strany (Sides).


• Vytvořit spirálu (Create spiral): Vykreslí spirálu, která má opět dva kontrolní body (střed
a poloměr). Orientaci změníme (překvapivě) v poli Orientace (Orientation), počet „závitůÿ
(ramen, stran) pak nastavíme v poli Strany (Sides). Nástroj má nepravdivou ikonu, protože
umožňuje kreslit jenom kruhovité spirály, nikoli hranaté.


• Vytváří Beziérovu křivku (Create bezier curve): Umístěním prvních dvou bodů definujeme zá-
kladní přímku, třetí bod určuje zakřivení. Když chcete křivku ukončit, při umisťování po-
sledního bodu musíte přidržet klávesu Shift . Tady upozorňuji na svérázný český překlad:
„Přeřaďovač + tlačítko myši. . .ÿ má být správně „Shift + tlačítko myši. . .ÿ.


• Přesunout objekt (Move an object): Tažením myši přesouváme objekt, který musíme uchopit
za některý z kontrolních bodů.


• Přesunout jeden bod (Move a single point): Tažením přesouváme jeden kontrolní bod. Ostatní
přitom zůstávají na místě, takže je nevhodné použít tuto funkci například k přesunu celé
kružnice za její střed, protože bod určující poloměr se nepohybuje a rozměry kružnice se tak
mění.


• Kopírovat objekt (Copy an object): Vytvoří kopii objektu, na který klikneme. Při kliknutí se
kopie vytvoří přesně na stejném místě, jako je originál. Lepší je tedy myší táhnout, tím kopii
zároveň přesouváme. K selekci musíme použít některý z kontrolních bodů, nikoli obrys objektu.


• Odstranit objekt (Delete an object): Na který objekt klikneme, ten je rázem synem (dcerou)
smrti. K selekci musíme použít některý z kontrolních bodů, nikoli obrys objektu.


• Zvolte objekt (Select an object): Prostý výběr objektu, který bude považován za aktivní. Opět
musíme k selekci použít některý z kontrolních bodů, nikoli obrys objektu.


• Zvýšit zvolený objekt (Raise selected object): Aktivní objekt je umístěn o jednu úroveň výše.
• Snížit zvolený objekt (Lower selected object): Aktivní objekt je umístěn o jednu úroveň níže.
• Zvýšit zvolený objekt nahoru (Raise selected object to top): Aktivní objekt je umístěn úplně
nahoru.


• Snížit zvolený objekt dospod (Lower selected object to bottom): Aktivní objekt je umístěn úplně
dolů.


• Zobrazit předchozí objekt (Show previous object): Zahájí režim cyklování, kdy je zobrazen vždy
jen jediný objekt. Zobrazí předcházející objekt.
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• Zobrazit další objekt (Show next object): Zahájí režim cyklování, kdy je zobrazen vždy jen
jediný objekt. Zobrazí následující objekt.


• Zobrazit všechny objekty (Show all objects): Zruší režim cyklování a zobrazí všechny objekty.


Dále nám pracovní okno Gfig nabízí tyto volby:


• Možnosti nástroje (Tool options): Nastavení nástroje předtím, než jej použijeme. Zde se nasta-
vuje např. počet stran n-úhelníku nebo orientace spirály. Vlastnosti nakresleného objektu nelze
změnit dodatečně.


• Vykreslit (Stroke): Obtažení čar objektu. Nastavujeme barvu a stopu (Brush).
• Vyplnit (Fill): Udává, zda a jak budou vyplněny uzavřené plochy vybraného objektu. Možnosti
výplně jsou:


◦ Žádné vyplňování (No fill)
◦ Vyplnění barvou (Color fill)
◦ Vyplnění vzorkem (Pattern fill)
◦ Vyplnění přechodem (Gradient fill)


Ke každé možnosti patří příslušný výběr výplně, tedy barva, vzorek (pattern) a přechod (gra-
dient).


• Zobrazovat mřížku (Show grid): Přepíná zobrazování mřížky, jejíž vlastnosti lze nastavit ve
zmiňovaném dialogu Úpravy → Mřížka (Edit →Grid).


• Chytat k mřížce (Snap to grid): Určuje, zda se mřížka bude zobrazovat jen „na ozdobuÿ, nebo
se k ní veškeré vytvářené objekty budou zarovnávat.


• Zobrazit obrázek (Show image): Přepíná zobrazování zbytku „normálníhoÿ obrázku jako pod-
kladu.


To by bylo z popisu přibližně vše. Teď se pustíme do samotného blesku. Pozadí už máme, takže
můžeme rovnou otevřít Gfig a nástrojem Vytvořit čáru (Create line) se pokusit o tvar blesku. Vy-
pneme možnost Vyplnit (Fill) a zapneme Vykreslit (Stroke), a to s modrobílou barvou (například
#e4eff9) a stopou Circle (05). Při umisťování druhého bodu jedné čáry a umisťování prvního bodu
čáry následující nehýbejte myší, aby na sebe čáry navazovaly. Gfig bohužel neumožňuje kreslit čáru
o více kontrolních bodech. Jednodušší práci budeme mít, když si zapneme zobrazování mřížky a při-
chytávání mřížky a v dialogu Mřížka (Grid) zadáme rozestup (Spacing) např. 10 pixelů. A protože
výsledky naší práce vidíme realtime vykreslovány do „normálníhoÿ obrázku, můžeme také vypnout
volbu Zobrazit obrázek (Show image).
U našeho blesku vytvoříme větve o třech různých silách („tloušťkáchÿ), které budeme mít rozdělené
do tří vrstev. Budeme tedy Gfig spouštět třikrát, každou tloušťku budeme kreslit na zvláštní vrstvu.
Ovšem pozor, Gfig si pamatuje, kterou vrstvu kreslil, a je schopen pokračovat v její vektorové úpravě.
Tomu se musíme vyhnout. Postup bude zhruba následující:


1. Uvedenou stopou (Circle (05)) nakreslíme hlavní rameno blesku.
2. Opustíme Gfig stiskem tlačítka Zavřít (Close) a vzniklou vrstvu přejmenujeme na Blesk –
Hlavní.


3. Vybereme vrstvu Pozadí. U ní Gfig nemůže pokračovat ve vektorové editaci, a tak bude muset
vytvořit novou vrstvu Gfig.


4. Spustíme Gfig, přepneme stopu pro vykreslování na Circle (03) a uděláme nějaké postranní
větve.


5. Opět Gfig zavřeme a novou vrstvu pojmenujeme Blesk – Větve – 1.
6. Vybereme vrstvu Pozadí.
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7. Proces dokončíme opětovným použitím Gfigu, nakreslením „větvičekÿ se stopou Circle (01)
a pojmenováním poslední vrstvy Blesk – Větve – 2. U tohot kroku je lepší nastavit vykreslovací
barvu na čistě bílou, nikoli modrobílou.


Nakonec ještě jeden špinavý trik – zkopírujte vrstvu Blesk – Větve – 2 a kopii ihned slučte s originálem
příkazem Vrstva → Sloučit dolů (Layer → Merge down). A hned jsou větvičky jasnější! Samozřejmě
jsme mohli použít funkci Úrovně nebo Jas-Kontrast, ale toto je přece rychlejší ;-).


Blesk – Hlavní, Blesk – Větve – 1, Blesk – Větve – 2, Celý obrázek, Konečný výsledek
Díky tomuto postupu máme teď jednotlivé větve blesku rozděleny v různých vrstvách podle jejich
síly. Kolem těchto jednoduchých čar ještě doplníme namodralou záři závislou právě na jejich síle
(proto to rozdělení do vrstev) a jsme hotovi. Na namodralou záři použijeme další z plug-inů Script-
fu, a sice Alfa do loga → Mimozemská záře (Alpha to logo → Alien glow). Jak jsem se zmiňoval
při jiné příležitosti, plug-iny Script-fu mají velice jednoduché nastavení, což vidím jako výhodu. Pro
všechny tři vrstvy nastavíme jednu modrobílou barvu, ale pro každou vrstvu jinou velikost:


• Blesk – Hlavní: 90 pixelů
• Blesk – Větve – 1: 60 pixelů
• Blesk – Větve – 2: 40 pixelů
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Plug-in je opět trochu panovačný a v obrázku nadělá nepořádek. Vrstvu, na kterou je použit, zne-
hodnotí, takže si od každé vrstvy vytvořte kopii a efekt použijte na ni. Pak smažte balast – vrstvy
Background a <jméno vrstvy> kopie. Vrstvu Alien glow přejmenujte na Blesk – Záře – Hlavní/Větve
1/Větve 2 (podle původní vrstvy).
Nyní jsme více méně u konce. Já vím, že to není ani umělecké dílo, ani realistický obrázek, ale
s trochou fantazie si můžeme říci, že to vypadá jako blesk :-). Hlavní prostor pro vylepšení bych viděl
ve čtvrté vrstvě (nejmenší větvičky). Uznávám, že nejsou nic moc.


Kometa
Malování komety je velmi podobné meteoru, ale je jednodušší. Opět začneme otevřením nového
obrázku, může stačit 800x300 (čím širší, tím více místa na ohon komety => tím lépe). Tentokrát už,
narozdíl od meteoru, nevadí použití hvězdné oblohy jako pozadí. Stejně tak se ale můžeme spokojit
s prostou černou. Vrstva Pozadí je tedy vaší volbou.
Celou kometu si vlastně rozmažeme stejným způsobem jako jsme vytvářeli meteorickou stopu. Štět-
cem si naneseme „materiálÿ na jádro komety a ohon a pak s nástrojem Šmouha (Smudge) kometu
vytvarujeme. Je to jednoduché, chce to jen trpělivost. Kde už jsem to jenom slyšel?
Vložíme si novou průhlednou vrstvu a pojmenujeme ji Ohon. Na nanesení materiálu budeme přirozeně
potřebovat bílou barvu. Na nastavení dvou používaných barev (popředí a pozadí) existují dva malé
triky: klávesou D (od slova Default) si nastavíme výchozí barvy – černé popředí a bílé pozadí. Další
klávesa, X (eXchange), zase vymění barvu popředí a pozadí. Pokud tedy chceme štětcem (se zkratkou
P) malovat bílé skvrny, stačí popořadě stisknout D X P.
Podklad ohonu komety uděláme stopou Circle Fuzzy (76) s Krytím (Opacity) nastaveným na 40 %.
Pro samotné jádro komety si založíme novou průhlednou vrstvu se jménem Jádro. Podklad nám
zajistí malá kresba stopou Circle (19) s Krytím 100 %.


Následující postup je stejný jako u meteoru – špinit si prsty. . . Je také potřebné manipulovat s hod-
notou Krytí (Opacity) vrstvy Ohon. Náš bílý ohon komety je tzv. ohon prachový. Obvykle se odvrací
směrem od Slunce a může být zakřivený. Kdo chce jít ještě dál, může vytvořit také sekundární ohon,
zvaný plazmový. Ten je vždy rovný a má modře fluoreskující barvu. Postup je analogický.
Posledním krokem je naprostá ignorace realističnosti :-). U skutečné komety má vlastní pevné jádro
velikost řádově kilometrů až desítek kilometrů a v porovnání s ohonem ho tedy nemůžeme vůbec
vidět. Celá ta bílá skvrna, kterou jsme si naivně nazvali Jádro, je ve skutečnosti jenom tzv. koma,
oblak plynů a prachu, který se z jádra vypařuje. Protože obrázek může, ale nemusí vypadat lépe
i s nějakým náznakem kometárního jádra, berte prosím následující návrh jako volitelný doplňek.
Zkusme si do zmíněné komy přidat cosi jako stín samotného jádra, který bude kometě dodávat jakýsi
„hmotnějšíÿ dojem. Někde ve druhém obrázku si připravíme malý kámen (dle návodu ve třetím dílu -
GIMP v příkladech – 3 (kámen) [5]), lze použít i malé upravené jádro meteoru z dílu čtvrtého - GIMP
v příkladech – 4 (meteor) [6]). Ten vložíme jako novou, nejvýše umístěnou vrstvu a uděláme z něj
slabý přízrak nastavením toho správného Režimu vrstvy (Layer mode) a Krytí (Opacity). Vhodným
režimem je v tomto případě Odlišnost (Difference). Tento mód (režim, chcete-li) funguje podobně
jako Rozdíl (Subtract), o němž jsem se krátce zmínil v prvním dílu (GIMP v příkladech – 1 (hvězdná
obloha) [7]). U obou módů je výsledkem odečtení vrchní vrstvy od spodní. Oba režimy se ale liší:
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• V případě Rozdílu je barva pro každý pixel stanovena jako: barva = max(spodni pixel –
horni pixel, 0) To znamená, že pokud by měla barva vycházet v záporných číslech, je místo ní
dosazena nula, tedy černá.


• V případě režimu Odlišnost je barva každého pixelu stanovena takto: barva = |spodni pixel –
horni pixel| Zde je výsledkem absolutní hodnota rozdílu. Pokud tedy rozdíl klesne do negativních
hodnot, není přepsán na nulu, ale je mu přiřazeno kladné znaménko (snad nemusím vysvětlovat,
co je to absolutní hodnota :-). Přirozeně to také znamená, že nezáleží na pořadí vrstev.


Já jsem nastavil Krytí na 30 %, výsledek pak může vypadat třeba takto:


Mraky
Ukážeme si dvě metody generování mraků – pomocí filtrů Plazma (Plasma) a Pevný šum (Solid
noise). Výsledky mají maličko odlišné. V obou případech začneme založením obrázku o rozměrech
800x600 a vyplněním vrstvy Pozadí nějakou „oblohovouÿ barvou, například #6969bf. Pro mraky pak
vložíme ještě novou, průhlednou vrstvu, zvanou Mraky. Na ni budeme aplikovat filtry.


Plazma
Filtr Plazma najdeme v menu Filtry → Vykreslení → Mraky → Plazma (Filters → Render → Clouds
→ Plasma). Okno možnostmi zrovna neoplývá:


• Hnízdo náhodných čísel (Random seed): Nastavení nějakého náhodného čísla, které bude po-
užito jako základ pro výpočet. Pokud filtr použijete vícekrát a vždy nastavíte stejné číslo,
výsledky budou vypadat stejně. S nastavením náhodného čísla se setkáváme u mnoha filtrů
a efektů.


• Turbulence (Turbulence): Nastavení hustoty budoucí plasmy.


Pro naše mraky je přiměřená hodnota Turbulence asi 2.0, na náhodném čísle až tak nezáleží. Až filtr
vykoná svou práci, zbavíme se těch strakatých barev příkazem Vrstva → Barvy → Odbarvit (Layer
→ Colors → Desaturate).


K vytvoření mraků nám teď zbývá jen zprůhlednit černou barvu v obrázku, čehož dosáhneme příka-
zem Vrstva → Průhlednost → Barva do alfy (Layer → Transparency → Color to alpha) a následným
zvolením černé barvy. Ještě předtím je však možné mraky doladit známou funkcí Úrovně (Levels),
kde můžeme ovlivnit poměr černé (budoucí oblohy) a bílé (mraků). Vhodným zakončením je pak
použití filtru Gaussovo rozostření (Gaussian blur) s Poloměrem rozostření (Blur radius) nastaveným
(shodně u X a Y) na 3.0 nebo 4.0 pixely (s filtrem jsme se setkali ve druhém díle (GIMP v příkla-
dech – 2 (hvězdná obloha 2)) seriálu). Je vidět, že mraky vytvořené „plazmovouÿ metodou možná
připomínají spíše mlhu. No, s trochou snahy by se tímto filtrem dala vykreslit i plíseň.
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Šum
Filtr Pevný šum najdeme v menu Filtry → Vykreslení → Mraky → Pevný šum (Filters → Render →
Clouds → Solid noise). Okno nabídne maličko větší repertoár nastavení než jeho konkurent Plasma.
Nebudeme se již zabývat hnízdy náhodných čísel:


• Velikost X (X size): Udává horizontální roztažení efektu v obrázku. Při nastavení velkého čísla
lze dosáhnout vzhledu připomínajícího plameny (Samozřejmě by se s tím muselo ještě dále
pracovat).


• Velikost Y (Y size): Podobně jako Velikost X, jde ale o vertikální roztažení.
• Detail (Detail): Hloubka prokreslení šumu. Rozdíl mezi rozplizlým mlhavým „něčímÿ a detail-
něji zaostřeným „něčímÿ.


• Dlaždicovatelný (Tilabe): Pokud je zaškrtnuto, šumový efekt je generován jako bezešvý, tzn.
obrázky lze skládat vedle sebe, aniž by byla rozeznatelná jejich hrana.


• Turbulentní (Turbulent): Zapíná jiný způsob generování, jehož výsledky jsou odlišné od nor-
málního módu. Vypadají zajímavě.


Mraky připomínající obraz nám filtr může vysypat například s následujícím nastavením: Turbu-
lentní: Ano, Detail: 9, Velikost X: 3.0, Velikost Y: 4.0. Výsledek má ovšem daleko ke vzhledu mraků.
Nejenže budeme muset zprůhlednit černou barvu, ale také zlomit nadvládu barvy bílé, jenž v obrázku
dominuje. Zbraní budiž nám důvěrně známá funkce Úrovně (Levels). Je vhodné pohrát si se všemi
trojúhelníčky, například takto: bílý na 65, šedý na 1.1 a černý na 230. ZávěremMraky opět zahladíme
filtrem Gaussovo rozostření s Poloměrem rozostření 5.0 pixelů.
S každým výsledkem si ovšem lze hrát dál a dál, třeba upravováním jasu a kontrastu, barevným
tónováním, rozostřováním, atd.


Mlha na fotografii
V souvislosti s minule probranými mraky si uká-
žeme malý trik, jak do fotografie přidat mlhu.
Předtím si ale musíme povědět něco o maskách
vrstev (layer masks).
Příklad budu vysvětlovat na konkrétním obrázku –
fotografie Jenny Lake (Jezero Jenny); c©Lee Ben-
nett, atpm.com; http:// www.atpm.com/6.07/na-
tional-parks/jenny-lake.shtml [8]


Maska vrstvy – Layer mask
Každá vrstva v GIMPu může mít svůj doplňující
rastr v odstínech šedé (grayscale), který určuje
její průhlednost. Nemá to však žádnou souvislost
s alpha kanálem ani s Krytím (Opacity), je to jen
další (a často lepší) způsob, jak ovládnout prů-
hlednost vrstvy. Masku můžeme upravovat nezávisle na vrstvě samotné. Barva pixelu masky o sou-
řadnicích [X; Y] určuje průhlednost pixelu vrstvy o souřadnicích [X; Y]. Ohromná výhoda masky je,
že díky ní můžeme upravovat průhlednost vrstvy nezávisle na vrstvě samotné a že to můžeme dělat
s použitím všech propracovaných nástrojů, filtrů a efektů, které používáme na regulérní vrstvy.
Černá barva v masce znamená absolutní průhlednost, bílá je barva „opaqueÿ, tedy úplně neprůhledná
(vrstva zůstává vidět stejně). Šedé odstíny mezi nimi pak zajišťují částečnou průhlednost – čím
tmavší, tím průhlednější. Vrstva po svém vložení či vytvoření ihned masku neobsahuje. Ta se musí
aktivovat v kontextovém menu vrstvy příkazem Přidat masku vrstvy (Add layer mask). Ten zobrazí
malý dialog s dotazem, jak se má maska inicializovat. Na výběr máme následující možnosti:
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• Bílá (úplné krytí) (White (Full opacity)): Snad netřeba vysvětlovat. Maska je kompletně bílá,
vrstva normálně viditelná. Maska tedy jakoby nebyla.


• Černá (úplná průhlednost) (Black (Full transparency)): Přesně opačný efekt od předcházejícího
– vrstva je úplně průhledná.


• Alfa kanál vrstvy (Layer’s alpha channel): Maska zkopíruje stav alfa kanálu vrstvy.
• Přenést alfa kanál vrstvy (Transfer layer’s alpha channel): Stejné jako předchozí volba, ale
původní alfa kanál je zresetován. Asi jako použít mv místo cp .


• Výběr (Selection): Maska je nastavena podle současného výběru - obsah výběru odpovídá bílé
barvě masky (normální viditelnost). To, co vybráno nebylo, odpovídá černé barvě, tedy abso-
lutní průhlednosti.


• Kopie vrstvy v odstínech šedi (Grayscale copy of layer): Jako maska je použit současný obsah
vrstvy jednoduše převeden na odstíny šedé.


• Invertovat masku (Invert mask): Poté, co je stanovena maska jednou ze zvolených metod, je na
ní ještě provedena inverze barev a maska je tak úplně převrácena.


Po odsouhlasení dialogu se nám hned vedle náhledu na vrstvu zobrazí ještě jeden malý obdélník
stejných rozměrů, který reflektuje stav masky. Pokud vybereme vrstvu a klikneme na její náhled,
veškeré další použití nástrojů, efektů, filtrů apod. je aplikováno, jako obvykle, přímo na ni. Pokud
ale explicitně klikneme na náhled masky, tyto kroky jsou aplikovány na masku.
Za normálních okolností je maska v GIMPu jakási neviditelná stínová eminence a její přímé zobrazení
si musíme zapnout v kontextovém menu vrstvy příkazem Zobrazit masku vrstvy (Show layer mask).
Můžeme také spoléhat na zobrazení masky v pouhém náhledu. Komu není na monitoru těsno (to byl
samozřejmě vtip, protože na tvorbu grafiky je každé rozlišení malé :-), ten si může náhledy zvětšit
kliknutím na malou šipku na panelu s vrstvami a zvolením velikosti dle libosti v nabídce Velikost
náhledu (Preview size).
V kontextovém menu vrstvy najdeme ještě několik dalších užitečných příkazů:


• Upravit masku vrstvy (Edit layer mask): Stejný efekt jako kliknutí na náhled masky – veškeré
operace s nástroji a efekty jsou prováděny nikoli na samotné vrstvě, ale na její masce.


• Zakázat masku vrstvy (Disable layer mask): Maska je prostě dočasně vypnuta – není na ni brán
ohled, ale je stále k dispozici.


• Odstranit masku vrstvy (Delete layer mask): Maska je odstraněna a její obsah je ztracen.
• Použít masku vrstvy (Apply layer mask): Maska je převedena na alpha kanál a odstraněna. Po
tomto kroku sice vrstva zůstává stále stejně průhledná jako s maskou, ale průhlednost již nelze
upravovat nezávisle na zbytku obrázku. I to však může být někdy žádoucí.


Pro vložení mlhy na fotografii použijeme mraky vygenerované metodou Pevný šum – Solid noise.
Otevřeme si zvolenou fotografii, přidáme novou vrstvu a v ní vyrobíme mraky [9]. Výsledek vypadá
takto (další obrázek).
A teď přichází využití masky vrstvy (nezní lépe layer mask?). Zřejmě nevypadá moc přirozeně, když
je mlha rozložená po celé fotografii rovnoměrně. Budeme chtít, aby se mlha rozkládala nad vodní
hladinou, směrem vzhůru se pomalu vytrácela a v horách nad vodou mizela. Pro splnění tohoto
požadavku je ideální kombinace masky vrstvy a gradientu, alias přechodu.


Přechod, mísení, gradient, blend, . . .
Všemi těmito názvy lze v české a anglické verzi GIMPu označovat nástroj na vykreslování přechodu
jedné barvy do druhé. Jeho klávesová zkratka je L . Nástroj provede svoji práci poté, co mu ta-
žením v obrázku určíme úsečku. V počátečním bodě úsečky je použita počáteční barva gradientu,
v koncovém bodě barva koncová a prostor mezi nimi je vyplněn oním touženým gradientem, tedy
postupným přechodem jedné barvy do druhé. Gradient se vykresluje pouze do oblasti vyhrazené
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výběrem (Selection), pokud žádný výběr není aktivní, jde o celou vrstvu. Za normálních okolností
jsou oblasti vyplněny podle následujícího schématu (kresleného v GFigu [10]!):


Je tedy vidět, že poloroviny, které jsou mimo samotný gradient a jsou kolmé na základní úsečku, jsou
vyplněny krajními barvami. Toto chování se dá změnit nastavením Opakování (viz dále). Některé
vlastnosti jsou nám již známy (Krytí, Režim), na ostatní se podíváme:


• Přechod (Gradient): Zde se nastavuje, jaký barevný typ gradientu bude použit. Na výběr máme
široké spektrum barevných kombinací, některé z nich jsou přizpůsobivé a místo pevně daných
barev používají barvy popředí či pozadí.


• Obrátit (Reverse): Vymění počáteční a koncovou barvu gradientu.
• Posun (Offset): Čím vyšší je vložené číslo, tím razantněji gradient přechází z jedné barvy do
druhé.


• Tvar (Shape): Výběr ovlivňující tvar gradientu. Základní a běžný je Lineární, jeho malou
modifikací je Bilineární – tyto dva rozprostřou gradient na přímku. Mezi další zajímavé mož-
nosti patří Radiální, který tvoří gradientový kruh, nebo Čtvercový, jenž vykresluje gradient do
čtverce. Typy Pronikající se přímo přizpůsobují tvaru prostoru, do kterého se vykreslují.


• Opakování (Repeat): Se stejnou volbou jsme se již setkali při popisu nástroje Štětec, konkrétně
u jeho možnosti Použít barvu z přechodu. I zde jde o ovlivnění způsobu navazování gradientu.
Volby fungují stejně.


• Rozptyl (Dithering): Při vykreslení je používáno méně barev, které jsou ale rozptýleny tak, že
by lidské oko nemělo postřehnout rozdíl (podobně jako televize nebo obrázky v novinách).


• Adaptivní převzorkování (Adaptive supersampling): Převzorkování slouží k jemnějšímu vyhla-
zování barevného přechodu.


U lineárních a bilineárních gradientů označuje úsečka počáteční a koncový bod gradientu, u ostatních
(radiální, čtvercový, spirála) pak poloměr. Jakmile si na ni zvyknete, práce s nástrojem Gradient je
jednoduchá a intuitivní.


Dokončení mlhy
Pro náš „fadeoutÿ mlhy použijeme jednoduchý gradient Popředí do pozadí aplikovaný na masku
vrstvy s mlhou. Barvy popředí a pozadí nastavíme prostým stiskem klávesy D na černou a bílou
(gradient budeme vykreslovat do masky, která operuje pouze s šedými (grayscale) odstíny). Maska
a konečný výsledek její aplikace by měly vypadat takto:
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Planeta
Dnes ještě nakousneme další téma, kterým je kon-
strukce planety. Zřejmě by bylo svazující napodo-
bovat samotnou Zemi, a tak si vymyslíme nějaké
extrasolární těleso. Jako pozadí použijeme naši
starou známou hvězdnou oblohu [11] a planetu
vytvoříme jakoby ve stínu jiného tělesa, takže
z ní může zbýt třeba jenom srpeček. K takovému
efektu se dokonale hodí dnes představená kombi-
nace layer mask + gradient. Povrch planety zvrás-
níme pomocí bump-mappingu a přidáme jí atmo-
sféru prostřednictvím Mimozemské záře. Ovšem
dnes jen položíme základy.
Prvním krokem je rozhodnutí o velikosti obrazu.
Protože bude planeta pěkně kulatá a okolo ní
nebudou žádné důležité prvky, zvolme čtvercové
rozměry, například „kulatá číslaÿ 1024x1024 pi-
xelů. Pozadím nechť se nám stane hvězdná ob-
loha, která ale nemusí být dovedena do úplného
konce (záře, supernovy). Prosté společenství ma-
lých a velkých hvězd rozličně rozmístěných nám
bude dostatečným:-). Dalším důležitým krokem je
rozhodnutí o barvě planety. Nebudeme vytvářet
mnohobarevná tělesa jako je Země, ale spíše jed-
nobarevně laděné koule, jako je třeba Neptun.
Vhodné barvy jsou například modrá, červená,
žlutá, oranžová, možná i světle šedá.


Do příštího dílu si tedy připravte čtvercový obrázek s jednou vrstvou Pozadí
obsahující hvězdnou oblohu a jednou vrstvou Povrch, kterou budeme později
mapovat na kouli. Zvolte si dominantní barvu planety a tuto vrstvu vyplňte
bilineárním gradientem dvou jejích odstínů, třeba podle následujícího obrázku
(styl Neptun). Těším se na shledání u osmé části seriálu. Stvoříme svět.


Na konci minulého dílu [12] jsme si připravili základ pro povrch budoucí planety - jednoduchý
gradient. I ten by se dal sám o sobě jednoduše použít, pokud bychom chtěli stvořit plynného obra,
tedy planetu bez pevného povrchu a viditelného zvrásnění. Věnujme se však něčemu zajímavějšímu
a utvořme si těleso s členitým povrchem. Na kontrolované „zhrbolatěníÿ vrstvy se výborně hodí
bump-mapping, zvaný též elevační mapa či mapa vyvýšení.
V textu budu používat anglický název bump-mapping, protože jde o zavedený a běžně používaný ter-
mín. [bump = hrbol, boule]


Bump-mapping
Pro použití tohoto filtru potřebujeme dvě vrstvy (nemusí být ve stejném obrázku). Jedna je ta,
kterou chceme zvrásnit – nazveme si ji cílovou. Pak máme druhou vrstvu, kterou nazveme elevační
mapa. Právě podle ní se bude řídit ono vrásnění (bumping) vrstvy cílové. Filtr funguje zhruba tak,
že si vezme elevační mapu, převede ji na režim grayscale (šedé odstíny) a podle její světlosti provede
bumping cílové vrstvy. Tmavé oblasti na místě [X; Y] v elevační mapě způsobí na místě [X; Y] cílové
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vrstvy prohlubně, světlé oblasti naopak pohoří. Pomocí Blenderu [13] a GIMPu jsem se pokusil
ilustrovat toto převední elevační mapy na bump-mapu:


Filtr se nachází v menu Filtry → Mapa → Mapa vyvýšení (Filters → Map → Bump map) a nabízí
nám poměrně rozsáhlé možnosti:


• Mapa vyvýšení (Bump map): Zde se vybírá použitá elevační mapa. V nabídce jsou všechny
vrstvy ze všech současně otevřených obrázků.


• Druh mapy (Map type): Druh mapy ovlivňuje výpočet kontrastu. Typ Lineární provádí klasické
bump-mapování bez úprav, typy Kulový a Sinusoidní používají ještě různé vyvažování odstínů.
Nejlepší je s volbami experimentovat.


• Kompenzovat tmavnutí (Compensate for darkening): Přirozeným (d)efektem bump-mappingu
je celkové ztmavnutí obrazu. Zaškrtnutím můžete tento jev eliminovat.


• Invertovat mapu vyvýšení (Invert bumpmap): Na elevační mapě je před použitím provedena
inverze barev. Z hor se tak stanou údolí a naopak.


• Opakovat mapu vyvýšení (Tile bumpmap): Pokud je tato volba aktivována a elevační mapa je
menší než cílová vrstva, je poskládána vícekrát vedle sebe.


• Azimut (Azimuth): Úhel určující pozici světla, 0 - 360 stupňů. Podle polohy světla se v nově
vznikajícím „terénuÿ vykreslují stíny.


• Zdvih (Elevation): Úhel určující výšku světla nad „obzoremÿ, 0 – 90 stupňů. Podle polohy
světla se v nově vznikajícím „terénuÿ vykreslují stíny.


• Hloubka (Depth): Určuje rozsah elevační škály neboli rozdíl mezi nejvyšším a nejnižším bodem.
• Posun X (X Offset): Relativní posunutí elevační mapy vůči cílové vrstvě v horizontální (X) ose.
• Posun Y (Y Offset): Relativní posunutí elevační mapy vůči cílové vrstvě ve vertikální (Y) ose.
• Výška hladiny (Waterlevel): Tento parametr má význam, pokud cílová vrstva obsahuje alpha
kanál. Vyšší alpha zesiluje bumpmapovací efekt, nižší ho „přidušujeÿ. Výška hladiny zde hraje
roli konstanty, která tuto interakci ovlivňuje.


• Okolí (Ambient): Nastavuje sílu tzv. ambientního světla, tedy světla, které ozařuje scénu vše-
směrově.


Teď, když už víme, jak zvrásnit budoucí povrch naší planety, musíme ještě najít vhodnou elevační
mapu. Je také možné postupně po sobě použít dvě různé. Dobře mohou vypadat třeba fotografie
Marsu, Měsíce nebo Europy, problém ale může být s jejich opakovatelností (tileabity). Dostačující
může být i textura kamene nebo, paradoxně, i samotné Země. Prostě něco, co bude připomínat
kontinenty, pohoří, moře, ostrovy atd. Google jako vždy poskytne spoustu podkladů [14].
Nelze bohužel jednoznačně říci, jak filtr nastavit, protože pro každou elevační mapu se hodí něco
jiného. V podstatě je potřeba pohrát si s volbami Druh mapy (Lineární / Kulový), Zdvih a Hloubka.
Mně z filtru vypadlo něco takového:
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Budiž koule!
Základní povrch máme připraven, pojďme jej tedy „natáhnoutÿ do toho správného tvaru, a to pomocí
známého filtru [15]Mapovat objekt (Map Object) [Filtry → Mapa → Mapovat objekt (Filters → Map
→ Map object)]. Nastavení bude zhruba následující:


• Volby – Mapovat na (Options – Map to): Kouli (Sphere)
• Volby – Průhledné pozadí (Options – Transparent background): Ano
• Materiál – Odrazivost – Odraz (Material – Reflectivity – Specular): 0.0


Umístěním světla (na záložce Světlo [Light]) v tomto filtru už si de facto určujete, kde bude planeta
mizet ve stínu – na straně opačné od zdroje světla. Po aplikaci filtru se může stát, že povrchové
detaily na planetě budou trochu rozmazané a neostré. Proto nám přijde vhod další jednoduchý
filtr, a to Filtry → Vylepšení → Doostřit (Filters → Enhance → Sharpen). Funkce má pouze jediný
parametr, kterým je všeříkající Ostrost (Sharpness). Za pomoci náhledu si zvolte vhodnou hodnotu,
mně pomohlo číslo 50:
Nyní přichází na řadu namodralá (nebo jiná) záře atmosféry, kterou pro nás zařídí filtr Skript-fu →
Alfa do loga → Mimozemská záře (Script-fu → Alpha to logo → Alien Glow). Má velmi podobné na-
stavení jako Sálající záře, takže snad ani nemá smysl se jím zabývat. Barvu nastavte světle modrou až
bílou, třeba #d6f5f9. Rozumná velikost efektu je 200 pixelů při rozměrech celého obrázku 210 x 210:-
). Pozor, jak už jsem několikrát v tomto seriálu zmiňoval, plug-iny Script-fu s vrstvami pěkně zacvičí
a přímo zničí tu vrstvu, na kterou jsou použity. Proto si zkopírujte vrstvu Povrch (kterou byste si už
měli přejmenovat na Planetu) a filtr Mimozemská záře použijte na tuto kopii. Jakmile skončí jeho
řádění, smažte vrstvy Planeta kopie a Background, vrstvu Alien glow si přejmenujte na Atmosféra
a zařaďte ji pod vrstvu Planeta. Výtvor nyní, včetně jednoduchého hvězdného pozadí, vypadá takto
(další obrázek).


Země stínů
Poslední etapou je zakrytí části planety stínem, což uskutečníme pomocí masky vrstvy (layer mask).
Podobně jako u kauzy mlha [16] pokryjeme masku gradientem. Protože do mizení planety musíme
zahrnout i záři její atmosféry, obě vrstvy sloučíme. Vyberte Planetu a v kontextovém menu zvolte
Sloučit dolů (Merge down). Vzniklou jedinou vrstvu Atmosféra přejmenujte zpět na Planeta a přidejte
jí masku příkazem Přidat masku vrstvy (Add layer mask) z kontextového menu. Jako inicializaci
ponechejte výchozí Bílá (White). Poté se již jen stačí chopit nástroje Gradient [17]. Stiskem D si
zvolíme výchozí barvy (černá a bílá) a jako typ gradientu vybereme Popředí do pozadí (FG to BG).
V okně vrstev se ujistíme, že máme vybraný náhled masky, nikoli samotné vrstvy, a můžeme začít
experimentovat. Je mnoho možností, jak planetu zastínit. Může být jak lehce pohlazena stínem, tak
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téměř úplně pohlcena temnotou. Na menší stín stačí použít tvar Lineární, ale pro větší zastínění je
vhodnější Radiální.


Zůstává nám tu poslední problém – planeta je sice částečně ve stínu, ale protože stín je v tomto
případě pouhá průhlednost, jsou přes ni vidět hvězdy za ní, a to je hrubá chyba. Řešení je něko-
lik. Například jsme mohli rezignovat na použití masky vrstvy, raději si vzít gradient Popředí do
průhlednosti (FG to transparent) a překreslit s ním samotnou planetu tak, aby čistá průhlednost
začínala tam, kde má být planeta normálně viditelná, černá by končila tam, kde je planeta totálně
zastíněná. Toto řešení by však znamenalo vzdát se flexibility masky (jednoduše upravitelná průhled-
nost). My to vyřešíme jinak – pod vrstvu Planeta vsuneme černý „koláčekÿ stejných rozměrů, který
bude překrývat nežádoucí hvězdy pod planetou. K tomu nám postačí jen trochu hrátek s výběrem
(selection).


1. Vytvořte novou průhlednou vrstvu, zařaďte ji mezi vrstvy Planeta a Pozadí a pojmenujte ji
Stín.


2. Vyberte vrstvu Planeta. Poté zvolte Vrstva → Průhlednost → Alfa do výběru (Layer → Transpa-
rency → Alpha to selection). Tato funkce zahrne do výběru úplně neprůhledné části vrstvy,
průhledných se ani nedotkne. V našem případě to znamená, že máme vybrané ty části vrstvy,
které jsou částí planety.


3. Vyberte znovu vrstvu Stín. Výběr (selection) v obrázku nám stále zůstává.
4. Aktivujte nástroj Plechovka (Bucket fill) ( Shift+B ), zatrhněte volbu Vyplnit celý výběr (Fill
whole selection) a černou barvou vyplňte výběr, který nyní platí pro vrstvu Stín. Tím pádem
máme vyplněnou stejnou oblast, jakou zaujímá samotná planeta.


Velkou výhodou stále zůstává, že se zastíněním planety si můžeme pořád hrát, jak je libo, maska
vrstvy je krásně upravitelná bez zásahů do zbytku obrázku. Za tuto flexibilitu jsme zaplatili malou
cenu – černou podkladovou vrstvu Stín.
Dnes doplníme obrázek planety o vycházející hvěždu a začneme práci na běžném semaforu. V minulém
díle jsme vyrobili imaginární planetu. Dnes si ji maličko vylepšíme – přidáme hvězdu vycházející nad
jejím povrchem. Dal by se k tomu použít i náš dobře známý filtr SuperNova, my ale upřednostníme
filtr GFlare, který slouží především k vytváření efektů vznikajících při odlescích světla na různých
čočkách (například u fotoaparátů nebo kamer). Filtr se nachází v menu Filtry → Efekty se světlem
→ Záře z přechodu (Filters → Light effects → GFlare). Vykresluje primární efekt (kruhový lesk)
a sekundární efekt („šňůruÿ odlesků). Pro filtr budu raději používat anglický název GFlare, protože
je kratší a, podle mého názoru, lepší. Okno filtru nabízí dvě záložky:


• Selektor (Selector):
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◦ Hlavní částí záložky je seznam přednastavených typů odlesku. Po vybrání je můžeme
okamžitě vidět v náhledu. Každý z nich lze samozřejmě upravit, k tomu slouží záložka
Nastavení (Settings).


◦ Tyto typy – předvolby – můžeme kopírovat, upravovat a vytvářet nové. Po stisknutí
tlačítka Úpravy (Edit) se nám nabídnou velmi detailní možnosti. Tím se však nyní zabývat
nebudeme.


• Nastavení (Settings):


◦ Střed (Center): Udává (překvapivě) pozici efektu na vrstvě.
◦ Poloměr (Radius): Velikost primárního (kruhového) efektu.
◦ Rotace (Rotation): Rotace primárního efektu.
◦ Rotace odstínu (Hue rotation): Zde se, trochu nezvykle oproti zbytku GIMPu, ovlivňuje
barva efektu.


◦ Úhel vektoru (Vector angle): Rotace sekundárního efektu („šňůraÿ, nebo „čáraÿ odlesků).
◦ Délka vektoru (Vector length): Délka sekundárního efektu v procentech, kde základem je
Rádius.


◦ Adaptivní převzorkování (Adaptive supersampling): Zapnutí vyhlazování hran.


Pro naši hvězdu si založíme novou průhlednou vrstvu jménem Hvězda a umístíme ji pod vrstvu
Planeta. Spustíme filtr GFlare (Záře z přechodu) a v záložce Selektor zvolíme předvolbu GFlare 102.
V záložce Nastavení pak hvězdu doladíme. Protože ji vkládáme na čistou, prázdnou vrstvu, těžko
budeme odhadovat, kam ji umístit, abychom se trefili přesně na okraj planety (nebo kamkoliv jinam).
Proto, podobně jako u vkládání hvězd do hvězdné oblohy, umístíme střed GFlare doprostřed vrstvy.
Tu si pak posuneme, kam budeme chtít.


• Poloměr efektu by se mohl pohybovat kolem 250 – 350.
• Žluté odstíny hvězdy získáme nastavením Rotace odstínu na hodnoty 130 – 160, oranžové až
červené jsou v rozmezí 90 – 120.


• Délku vektoru nastavíme na minimum, protože nás sekundární efekt momentálně nezajímá.


Po vygenerování efektu se vrstvy chopíme nástrojem Přesun (Move) a umístíme ji na požadované
místo tak, aby hvězda vycházela nad povrchem. Jakmile si budeme jisti, že je vrstva na správném
místě, zarovnáme její rozměry příkazem Vrstva → Velikost vrstvy dle obrázku (Layer → Layer to
image size). A to je vše:
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Semafor
Nyní si v GIMPu začneme kreslit klasický dopravní semafor, příště jej dokončíme a vyrobíme i vari-
antu pro chodce. Začneme otevřením nového čtvercového (například 500x500) obrázku s průhledným
pozadím. Protože ze semaforu budeme později vytvářet semafor pro chodce, nebudeme jej nyní kreslit
v oranžové barvě, na výběr je pouze červená a zelená. Já pro tento příklad zvolím červenou.
Vlastní obrázek se bude skládat ze dvou hlavních vrstev: jedna bude představovat samotný (čtver-
cový) skleněný povrch semaforu, druhá ji bude překrývat a ukazovat z ní jen kulatý střed. Začneme
spodní – povrchovou vrstvou, kterou si pojmenujeme Sklo.
Tuto vrstvu nejprve pokryjeme radiálním gradientem. Jako typ gradientu použijeme Popředí do
pozadí (FG to BG) a jako barvy popředí a pozadí si zvolíme světlejší a tmavší odstín zvolené barvy
semaforu (červená nebo zelená). Po aplikaci bude vrstva Sklo vypadat takto (první obrázek):


Dalším krokem je dodání „sklovitějšíhoÿ – mozaikového vzhledu. Skla semaforů nevypadají hladce!
Použijeme filtr Skleněné dlaždicování, který nalezneme v Filtry → Efekty se sklem → Skleněné dlaž-
dicování (Filters → Glass effects → Glass tile). Dialog nabízí pouze nastavení výšky a šířky dlaždice,
ale nic jiného vlastně nepotřebujeme. Zvolte tedy nějakou nižší hodnotu ( 15 pixelů) pro oba rozměry
a aplikujte filtr. Uvidíte, že skoro nic neuvidíte :-). Pozn.: Vím, že ve skutečnosti má semaforové sklo
trochu složitější vzor, ale toto zjednodušení nám zde postačí.
Výsledky filtru jsou velmi nepatrné, proto jim ještě pomůžeme filtrem Doostřit, který jsme použili
i na planetu [Filtry → Vylepšení → Doostřit (Filters → Enhance → Sharpen)]. Dovolíme si použít
velmi vysokou hodnotu, klidně i 90. I tak to není zrovna do očí bijící, ale to nevadí, v příštím kroku
se reliéf ještě zvýrazní (předchozí obrázek).
Přichází na řadu vyboulení skla. Dodáme mu jemně sférický vzhled pomocí dalšího filtru, a to Použít
čočku – Filtry → Efekty se sklem → Použít čočku (Filters → Glass effects → Apply lens). Tento filtr
vyboulí část vrstvy, jako bychom se na ni dívali přes nějakou čočku – lupu. Můžeme ovlivnit jednak
refrakční index této imaginární čočky, jednak vzhled okolí, jenž touto čočkou zasaženo nebude.


• Ponechat původní okolí (Keep original surroundings): Použití této volby nejvíce připomíná
lupu. Okolí čočky prostě zůstává beze změny.


• Nastavit okolí na barvu pozadí (Set surroundings to background color): Okolí nezasažené čočkou
bude přebarveno na barvu pozadí.


• Zprůhlednit okolí (Make surroundings transparent): Okolí nezasažené čočkou bude průhledné.
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• Refrakční index čoček (Lens refraction index): Nastavení samotné čočky. Čím vyšší hodnota,
tím razantnější vyboulení. Hodnota 1.0 znamená nulovou změnu.


My si sklo vyboulíme s indexem 1.50 a průhledným okolím. Na barvě okolí nám sice nezáleží, protože
bude stejně překryto horní vrstvou, ale jeho nastavením na průhledné si zjednodušíme pozdější
výběry. Kulaté sklo se nám nyní rozkládá přes celý obrázek, což není úplně vítané. Oba rozměry vrstvy
Sklo zmenšíme na 70 % původní velikosti (v mém případě tedy z 500px*500px na 350px*350px). Snad
nemusím připomínat, že dialog pro změny rozměrů vrstvy najdeme menu Vrstva → Změnit velikost
vrstvy (Layer → Scale layer). Nakonec si rozměry vrstvy Sklo pěkně úhledně zarovnáme s obrázkem
příkazem Vrstva → Velikost vrstvy dle obrázku (Layer → Layer to image size).


A teď se vrhneme na horní vrstvu, kterou pojmenujeme Plech, a která bude představovat plechový
kryt semaforu. Vložte tedy novou průhlednou vrstvu a pomocí Plechovky (Bucket fill) ji zaplavte
nějakou tmavou barvou (ale ne úplně černou!), například #333333. Nejprve do Plechu vyřízneme
otvor, aby bylo vidět Sklo pod ním. A to uděláme pomocí masky vrstvy (layer mask). Přidělte tedy
vrstvě Plech masku příkazem Přidat masku vrstvy (Add layer mask), inicializaci nastavte na bílou
(white). Abychom získali absolutní průhlednost vrstvy, musíme kruhovou část masky vyplnit černou
barvou. Rozměr této kruhové části ale získáme z vrstvy Sklo – proto jsme u filtru Použít čočku zvolili
možnost zprůhlednit okolí. A budeme postupovat takto:


1. Vyberte vrstvu Sklo.
2. Použijte funkci Vrstva → Průhlednost → Alfa do výběru (Layer → Transparency → Alpha to
selection). Použili jsme ji i minule [18], slouží k nastavení výběru (selection) na neprůhledné
části vrstvy.


3. Vyberte vrstvu Plech a kliknutím na náhled masky zapněte editaci masky, nikoli vrstvy sa-
motné.


4. Stisknutím Shift+B aktivujte nástroj Plechovka (Bucket fill), klávesou D nastavte výchozí
(černá+bílá) barvy.


5. Nyní jsme téměř připraveni „vyříznoutÿ díru do vrstvy, ale je tu ještě jeden detail: do výběru
jsme získali přesný rozměr barevného skla, ten ale nemůže být použit jako rozměr výřezu do
plechu, protože na okrajích by nám mohly vznikat jedno- až dvoupixelové otřepy. Proto celý
výběr (selection) maličko zmenšíme funkcí Vybrat → Zmenšit (Select → Shrink). Jako hodnotu
smrsknutí stačí zadat 3 pixely.


6. A teď už můžeme zmenšený výběr vyplnit čistě černou barvou.
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Dnešním posledním krokem bude zjemnění výřezu do vrstvy Plech. Zahoďte tedy pilky na železo
a chopte se jemného pilníku. Ujistěte se, že máte stále zvolenou editaci masky vrstvy Plech a otevřete
filtr Gaussovo rozostření – nachází se ve třetím šuplíku pod ponkem, zabalený v tom modrém hadru
[Filtry → Rozostření → Gaussovo rozostření (Filters → Blur → Gaussian blur)] :-D. Není třeba
rozostření přehánět, stačí nastavit poloměr (radius) na 2.0 – 4.0. Tak je přechod černé do bílé v masce
vrstvy hladší, ovšem jen velmi jemně. To je to, co jsme chtěli a pro dnešek nám to bude stačit. . .


Dokončení semaforu
Pomocí bump-mappingu a výběru „vylisujemeÿ do plechu asi
takový reliéf. Nejdříve si musíme stvořit elevační mapu. Za-
ložíme tedy novou průhlednou vrstvu, kterou pojmenujeme
prostě Mapa. Tu prstencovou část, která bude vyvýšena, mu-
síme vyplnit bílou barvou, zbytek vrstvy pak černou. Připo-
mínám, že nejrychleji nastavíme černou jako barvu popředí
klávesou D, nástroj Plechovka (Bucket fill) pak aktivujeme
kombinací Shift+B . Zaplavíme tedy celou vrstvu Mapa čer-
nou a pak u ní vypneme viditelnost. Nyní nastává čas pro
hrátky s mocnou funkcí Výběr (Selection). Představíme si
čtyři drobné, avšak užitečné funkce:


Zmenšit (Shrink)
Celá oblast výběru se zmenší, smrskne dovnitř o zadanou vzdálenost. Lze si to představit jako
obkreslování tvaru výběru zevnitř – tvar se zmenšuje.
Zvětšit (Grow)
Funkce provádí operaci opačnou k předchozí, výběr se rozrůstá ven. Tentokrát jako bychom tvar
výběru obkreslovali zvenku.
Obvod (Border)
Zde je výběr rozšířen ven i dovnitř, čímž vzniká okraj. Nová oblast výběru tedy není obsah původního
tvaru, ale jen pruh, který obkresluje původní obrys.
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Pokud si vezmeme tuto ilustraci (opět nakreslenou pomocí
GFigu), funkce Obvod byla použita s parametrem (vzdá-
leností) X. Toto X je šířka vzniklého pruhu, neboli vzdá-
lenost jeho (modrých) okrajů. Vnitřní okraj tohoto pruhu
byl tedy získán stejně, jako kdybychom na původní okraj
použili Zmenšit (Shrink) s parametrem X / 2. Analogicky,
vnější okraj byl získán, jako kdybychom na původní okraj
použili Zvětšit (Grow) s parametrem X / 2.


Zaostřit (Sharpen)
Odstraní jakékoliv jemné přechody výběrů. Ty vznikají výběrem oblastí s různými stupněmi prů-
hlednosti. Například příkaz Alfa do výběru, který později využijeme, vybírá ty části vrstvy, které
nejsou průhledné. Jenže GIMP u pixelů rozlišuje mnoho úrovní průhlednosti, což je logické, jinak
bychom nemohli tvořit plynulé přechody barvy do průhlednosti. To, že některé pixely jsou průhledné
více než jiné, také znamená, že některé pixely jsou tímto příkazem „vybrané více než jinéÿ. A právě
f-ce Zaostřit tento jev odstraňuje – zajistí, že pixely ve výběru jsou „vybrány všechny stejněÿ:-).
Ale teď už zpět k semaforu. Pro získání potřebného prstence nejprve do výběru dostaneme samotnou
díru v plechu. Tento výběr pak rozšíříme, za použití Obvodu jej proměníme v prstenec a Zaostříme
jej.
Díra v plechu existuje pouze v podobě masky (layer mask), jenže jsme si ji na konci minulého dílu
trochu rozmazali, takže ji k výběru používat nebudeme. Místo toho vybereme vrstvu Sklo a použijeme
Vrstva → Průhlednost → Alfa do výběru (Layer → Transparency → Alpha to selection). Tak máme ve
výběru (zhruba) rozměry díry. Dále přichází na řadu zvětšení tohoto výběru. Nejdříve si stanovme
šířku budoucího prstence – X, řekněme 30 pixelů. Parametr pro Zvětšit (Grow) bude poloviční šířka
budoucího reliéfu (X / 2), v tomto případě tedy 15 pixelů. Jakmile máme výběr rozšířený, konečně
jej proměníme v prstenec spuštěním Obvodu (Border) s parametrem X (30 pixelů).
Jelikož okraje červeného skla nebyly přesně zaostřené a do průhlednosti přecházely plynule, i výběr
není úplně ostrý. Napravíme to použitím výše zmíněného Zaostřit (Sharpen). Nyní už stačí vybrat
a zviditelnit vrstvu Mapa a Plechovkou vyplnit výběr bílou barvou. Ještě než tuto elevační mapu
použijeme, maličko zjemníme přechod bílé a černé barvy naším známým filtrem Gaussovo rozostření
s oběma parametry 2.0 px. Nakonec můžeme Mapu zneviditelnit.


Přichází poslední kouzlo – bumpmapping. Zvolte vrstvu Plech a otevřete dialog Filtry → Mapa →
Mapa vyvýšení (Filters → Maps → Bump Map). Není nutné hluboce zasahovat do nastavení, stačí
jen zvolit správnou Mapu vyvýšení (Bump map) – vrstvu Mapa a filtr spustit.
Tím kresbu jednoduchého semaforu ukončíme. Pro jednoduchost jsem zatím vynechal stínítko nad
sklem. Ve zbytku článku se vrhneme na další mocnou feature GIMPu. Cesty budeme potřebovat
k nakreslení semaforu pro chodce.


Cesty (Paths)
Cesty jsou vektorové Beziérovy křivky, které lze v GIMPu volně kreslit a upravovat. Křivka se skládá
z kotevních (anchor) bodů, kterými přímo prochází. Každému z těchto bodů pak přísluší dva body
kontrolní (handles), které určují směr křivky při „vstupuÿ a „výstupuÿ z/do kotevního bodu. Při
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prvotním umístění každého kotevního bodu s ním jeho kontrolní body sdílejí stejnou pozici, takže
„křivkaÿ je přímá – polygonální.
Jedna cesta se může skládat z několika komponent, tedy vzájemně nepropojených skupin spojených
bodů. Ačkoli komponenty nejsou přímo spojeny, stále patří do jedné cesty. Cesty mají dvě hlavní
využití:


• Snadno lze převést cestu do výběru a naopak. Tyto dva nástroje je velmi výhodné používat
dohromady. V kombinaci s výběrovými režimy (povíme si o nich příště) jde o skvělý způsob,
jak s výběrem manipulovat.


• Cesty lze obtahovat klasickými nástroji (Štětec, Guma, Tužka, Šmouha,. . .). Tato funkce je
mnohem silnější než obtahování obrysů v GFigu, protože v podstatě simuluje ruční kreslení
nástrojem. Umožňuje tak využít všechny jeho možnosti a nastavení.


Pro vkládání a úpravu cest slouží nástroj Cesty (Paths) s klávesovou zkratkou B. Pracuje ve třech
režimech, přičemž v prvních dvou lze rozlišit a nastavit aktivní bod (popřípadě body), ke kterému se
vztahují další operace. Aktivní bod je zobrazován jako prázdná kružnice, ostatní body jsou předsta-
vovány černě vyplněnými kruhy.


• Mnohoúhelník (Polygonal): Tato možnost vypne vlastnosti Beziérovy křivky – vkládání kont-
rolních bodů. Cesta tedy nepředstavuje křivku, ale je polygonální.


• Návrh (Design): Zde kreslíme samotnou křivku. Body lze přidávat a přesunovat.


◦ Výběr aktivního bodu: Kliknutím na jeden bod jej učiníme aktivním. Při držení Shiftu
přidáváme body do výběru. Pokud máme aktivovanou volbu Mnohoúhelník, kliknutím na
spojnici dvou bodů aktivujeme oba dva.


◦ Přidání kotevního bodu: Pokud je aktivní některý z koncových bodů křivky, jednodu-
chým kliknutím umístíme další bod, který s ním bude spojený. Jestliže je aktivní některý
z vnitřních bodů nebo při kliknutí držíme Shift , nový bod zakládá novou komponentu,
není tedy s aktivním bodem spojen.


◦ Přesunutí kotevního bodu: Aktivní bod (body) se přesouvají tažením.
◦ Přesunutí kontrolního bodu: Kontrolní body lze přesouvat dvěma způsoby – jednak
přímým tažením těchto bodů, jednak uchopením spojnice dvou kotevních bodů a taže-
ním. Pokud přímo tažením přesouváme jeden kontrolní bod, držením Shiftu si zajistíme
symetrický přesun i toho druhého.


◦ Uzavření křivky: Křivku můžeme uzavřít, pokud máme aktivní jeden z koncových bodů
a za stisku Ctrl klikneme na ten zbývající. Tato funkce však slouží i ke spojování
nesouvislých komponent cesty.


• Úpravy (Edit): V tomto módu můžeme pracovat pouze s existující a aktivní křivkou.


◦ Přesunutí kontrolního bodu: Tažením či kliknutím na kotevní bod jej v tomto režimu
nemůžeme přesunovat. Místo toho pohybujeme s jeho kontrolními body.


◦ Přidání kotevního bodu mezi dva existující: Kliknutím na spojnici dvou kotevních bodů
mezi ně vložíme další kotevní bod.


◦ Uzavření křivky: Křivku můžeme uzavřít, podobně jako u návrhového módu, pokud máme
aktivní jeden z koncových bodů. Narozdíl od návrhového módu však při kliknutí na ten
zbývající nedržíme Ctrl . I tato funkce slouží také ke spojování nesouvislých komponent
cesty.


◦ Odstranění bodu: Za stisku Shift+Ctrl lze kliknutím úplně odstranit kotevní nebo kon-
trolní bod.


◦ Odstranění spojnice dvou bodů: Úplně odstranit spojnici dvou bodů můžeme kliknutím
přímo na ni za stisku Shift+Ctrl . Tím otevřeme křivku či oddělíme komponenty.


• Přesun (Move):
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◦ Přesunutí jedné komponenty: Tažením jedné komponenty ji lze přesunovat nezávisle na
ostatních.


◦ Přesunutí všech komponent: Pro přesouvání všech komponent najednou jsou dvě mož-
nosti: buď při tažení jedné z komponent přidržíme Shift , nebo při tažení neuchopíme
komponentu, ale vybereme si prázdné místo cesty.


Funkci Cesty je v GIMPu vyhrazena celá odrážka (tab). Najdeme v ní všechny cesty v obrázku
naskládané na sobě podobně jako vrstvy, s možností měnit jejich pořadí, přepínat viditelnost a po-
jmenovávat je. Důležitý je výběr, která cesta je právě aktivní. Dole pod seznamem cest se kromě
obvyklých tlačítek pro vytváření, přesouvání a mazání nacházejí ještě další tři, zpřístupňující ono
vzpomínané využití cest:


• Cesta do výběru (Path to selection): Provádí konverzi aktivní cesty do výběru. Pokud tlačítko
stiskneme jen tak, aktuální výběr je prostě nahrazen novým. Pokud při stisknutí držíme Shift ,
nový výběr je k tomu aktuálnímu přidán. Pokud držíme Ctrl , nový výběr je od původního
odečten, a konečně, pokud držíme obě klávesy, výsledný výběr je průnikem původního a nového.


• Výběr do cesty (Selection to path): Provádí operaci opačnou k předešlé – aktuální výběr je
převeden do cesty. Vzniká tak nová cesta s názvem selection to path. Pokud při kliknutí na
tlačítko držíme Shift , otevře se nám okno nabízející záplavu pokročilých nastavení, které
však pravděpodobně vůbec nevyužijeme.


• Vykreslit cestu (Stroke path): Otevírá dialog pro obtažení cesty, který má dvě hlavní části.
Cesta je obtažena buď podle přímo nastaveného stylu, nebo je vykreslena zvoleným nástrojem.


◦ Vykreslit úsečku (Stroke line): Zde je možné dopodrobna nastavit styl, jak bude cesta
obtažena. Lze ovlivnit tloušťku čáry, zakončení, oblouky, ale také styl (plná čára, tečko-
vaná, čárkovaná, čerchovaná apod.). Také se zde přepíná, zda se čára bude vykreslovat
aktuální barvou popředí, nebo aktuálním gradientem.


◦ Vykreslit pomocí kreslicího nástroje (Stroke with a paint tool): Pokud volíme obtažení
ne podle vloženého stylu, ale přímo některým z nástrojů, toto je ta správná část dialogu.
Na výběr je 9 druhů nástrojů, množství více než dostatečné.


Vím, že takový hutný souhrn tolika funkcí může vypadat dost složitě, ale pokud si spustíte GIMP
a chvíli si s nástrojem Cesty pohrajete, jeho ovládání vám přejde rychle do krve. Není tak kompliko-
vaný, jak může na první pohled vypadat. BTW, to ovšem platí o celém GIMPu ;-) Kvůli trochu delší
teorii se do tohoto dílu už nevměstnala část o semaforu pro chodce, takže ji najdete v díle příštím.


Odkazy
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Darwinia


LinuxEXPRES


Michal Spáda predstavuje najnovšiu hru od Introversion Software. Hlboko v zlatej ére
8bitových počítačov, keď Amiga 500 bola ešte neznámym pojmom, uviedol tajomný Dr.
Sepulveda na trh počítač novej generácie, Protologic 68000. Menšie technické chyby
v koncepte však prerástli až do úplného kolapsu celého projektu a namiesto ovládnutia
sveta zostal Sepulveda sám so skladmi plnými počítačov.


Potom sa ale stalo niečo zvláštne – jedna z chýb vyvolala v okolitých počítačoch niečo, čo Sepulveda
nazval „kvantovou rezonanciouÿ. Stroje sa spojili do siete, ktorá svojím fungovaním zo všetkého
najviac pripomínala ľudský mozog. Doktor vrhol všetky svoje sily do výsledného projektu a vytvoril
digitálny zábavný park, obývaný malými zelenými Darwiniánmi, ktorí sa počas tisícok generácií
v duchu pravidiel evolúcie vyvinuli na prvú umelú inteligentnú formu života. Vy máte tú česť patriť
medzi návštevníkov spomínaného parku.


Ak sa vám zdá, že je príbeh hry Darwinia poriadne strelený, nemýlite sa. Ak sa ale naozaj vydáte
do digitálneho sveta obývaného postavičkami z klasických videohier, zistíte, že je nielen zaujímavý,
ale aj neuveriteľne zábavný. Chris Delay a Andy Bainbridge z Introversion Software totiž urobili to
najlepšie, čo mohli. Prišli s nápadom, zistili aké sú ich možnosti, výhody, ale aj obmedzenia, a potom
práve svoje vlastné obmedzenia využili takým spôsobom, aby výslednú hru ešte zlepšili. Ako je to
možné?


Darwinia sa podobne ako Uplink (predchádzajúca hra od Introversion) len veľmi ťažko zaraďuje
do nejakého žánru, ale keby ste veľmi prosili, väčšina hráčov by sa zrejme nejako zhodla na 3D
akčnej realtimovej stratégii. Introversion síce dokázali vytvoriť výkonný engine a kvalitné objekty,
ale pri danom počte vývojárov (rozumej 2) by vytváranie fotorealistických textúr, zložitých animácií
a automatického prepočítavania pohybu postáv po mape jednoducho zabralo príliš veľa času, ktorý
autori radšej venovali odlaďovaniu programu a dôrazu na hrateľnosť.


Článek vyšel v únorovém čísle [1] časopisu LinuxEXPRES [2].


Téma, ktorú si zvolili, ich zbavila časti problémov. Nielen, že je digitálny svet Darwinie originálny,
ale vďaka prítomnosti postáv známych z tých najstarších hier je pre väčšinu hráčov aj okamžite
identifikovateľný (mladší ich poznajú z mobilných telefónov). Jednoducho povedané, nostalgická at-
mosféra zašlých čias počítačovej zábavy vo vysokom rozlíšení s kvalitnými detailami a pri vysokej
rýchlosti (ak nemáte príliš starý systém, uvedené technické požiadavky berte ako minimálne) vám
v hre poskytne naozaj estetický zážitok, a to bez nutnosti programovať napr. mimiku tváre (ktorú
digitálne postavičky nemajú).


Druhé obmedzenie sa zdá byť ešte závažnejšie. Len veľmi ťažko môžete hráčom predložiť realtimovú
stratégiu v prípade, že sa jeho jednotky nedokážu sami bez problémov presúvať po mape aj na veľké
vzdialenosti. V Darwinii je ale práve toto jedna z najväčších devíz hry, keďže nutnosť priameho
ovládania vojenských jednotiek je práve to, čo robí väčšinu misií zábavnými (a niekedy aj pomerne
zložitými).


Pýtate sa, čo hľadajú vojenské jednotky v zábavnom parku? Krátko po vašom príchode sa dozviete,
že ste vlastne jediný návštevník – park bol kvôli invázii vírovej nákazy uzavretý. Ak chcete pomôcť
chudákom Darwiniánom prežiť a poraziť vírusy, budete sa musieť chopiť ovládania a vyvolať svoju
prvú jednotku.
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Zátišie s vírusmi: v pozadí stúpajú duše padlých do digitálneho neba.


Na tomto mieste by som sa na chvíľu zastavil – pri pôvodnom uvedení hry v marci 2005 sa všetky
jednotky v hre, ktoré mimochodom spúšťate ako programy a majú aj príslušné verzie (na rozdiel od
praxe zaužívanej v linuxovom svete začínajú väčšinou od verzie 1.0), vyvolávali kreslením geometric-
kých obrazcov myšou. Originálne riešenie, ale mnohým hráčom zrejme pripadalo zložité. Introversion
urobili v komerčnom svete pomerne nevídaný krok a s najnovšou záplatou do hry uviedli aj iný,
jednoduchší systém vyvolávania jednotiek prostredníctvom ikon.


Základné jednotky sú v podstate dve: vojenská, ktorá za použitia viacerých zbraní bojuje s vírusmi,
a inžinier, ktorý zbiera dušičky mŕtvych vírusov či Darwiniánov, preprogramováva vírusmi obsadené
budovy a zbiera stratené prvky výskumu Dr. Sepulvedu. Zozbierané dušičky sa potom v budove
zvanej inkubátor (ak ju pravda máte) pretvoria na nových obyvateľov digitálneho sveta. V priebehu
hry získate ešte ďalšie jednotky, dôstojníka, prostredníctvom ktorého môžete Darwiniánov ovládať,
a pancier, ktorý vám poslúži ako obrnený transportér alebo výkonné delo.


Dôvody, ktoré robia z Darwinie výbornú hru, sú podľa mňa tri. Prvým z nich je akčná stránka
hry a dizajn misií. Spočiatku sa vám zrejme bude zdať, že vaši digitálni vojaci, ktorí sa pohybujú,
strieľajú a hádžu granáty podobne ako hrdinovia klasickej hry Cannon Fodder, si s vírusmi bez
problémov poradia; v počiatočných misiách to tak viac-menej skutočne je. Neskôr sa ale boj s rôznymi
zákernými formami vírusov stáva jednou z najťažších častí hry, budete musieť obratne ovládať práve
pohyb vojakov, streľbu (aby ste nezastrelili vlastnú jednotku či Darwiniánov) a snažiť sa často riešiť
problémy na viacerých miestach súčasne, čo je však skôr zábavné ako frustrujúce (aj keď o triffidoch,
ktorí na diaľku metajú vajíčka, z ktorých sa vám v tyle liahnu nové vírusy, sa mi dodnes snívajú zlé
sny).
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Cannon Fodder je hra z 90. rokov od legendárnej spoločnosti Sensible Software a jedna
z hlavných inšpirácií Darwinie. V tejto akčnej klasike na (pôvodnej) Amige a Atari
ST viedol hráč malú skupinu veľmi malých vojakov, ktorá za použitia rapídnej streľby
prechádzala najrozličnejšie misie (v pokračovaniach hry okrem iného aj v budúcnosti
a stredoveku). Zosnulých vojakov bolo podobne ako v Darwinii možné rýchlo nahradiť
novými.


Druhým dôvodom je rôznorodosť riešených problémov a získavanie nových technológií. Môžete si byť
istí, že ak zvládnete riešenie jedného problému či druhu vírusu, v ďalšej misii sa vám síce zíde, ale
zároveň sa objavia nové problémy a nové typy nepriateľov. Niekedy budete musieť udržať na žive
istý počet Darwiniánov, inokedy pomocou nich uviesť do prevádzky rôzne stroje, niektoré vírusy sú
odolné voči laserom vašich vojakov a budete ich musieť zničiť výbušninami, atď.


Ale tu už ustupujú pod paľbou kanóna.


Zároveň pokračuje výskum Dr. Sepulvedu, ktorý na vaše požiadanie zlepšuje jednotlivé jednotky
či zbrane (zvyšuje im verziu až na 4.0), takže postupne získavate aj vy nové bojové prostriedky
a stratégie (výborné je napríklad bombardovanie, pri ktorom na vami určené miesto zaútočia votrelci
z klasickej hry Space Invaders).


Ako by to nestačilo, na výskum môžete v hre (obsadzovaním budov) nazbierať len istý počet bodov,
pomocou ktorých nemôžete zlepšiť úplne všetko. Po skončení teda môžete začať znova, s novou stra-
tégiou. Misie sa dajú vyhrať ľahšie pomocou dôvtipu, to ale neznamená, že ste so silovým prístupom
stratení, iba vám to bude trvať dlhšie. Hra sa nedá ukladať, ale v podstate ani definitívne prehrať;
z akejkoľvek pozície sa môžete pokúsiť o obrat. V prípade, že sa už nedá robiť nič (napr. keď vám
pomrie viac Darwiniánov, ako je prípustné a vy už nemáte ďalších odkiaľ vziať), jednoducho reštartu-
jete misiu. S podobne vyváženým vývojom a schopnosťou zaujať hráča v každej misii niečím novým
som sa stretol naposledy zrejme pri klasike Dune 2.
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Tretím a posledným dôvodom je celková umelecká koncepcia a príbeh hry, ktorý je zábavný a in-
teligentný zároveň. Jednotlivé misie na seba logicky nadväzujú, štýl je jednotný, zvuky autenticky
staromódne (hra ich obsahuje niekoľko tisíc, mnohé z nich sú pôvodné sample zo starých video-
hier), podobne ako hudba, ktorú tvorili majstri digitálneho retro žánru (dostupný je aj soundtrack).
Samostatnou kapitolou sú vtipné úvodné obrazovky, ktoré sa náhodne zobrazujú pri spustení hry
a obsahujú (okrem iného) verné kópie pozdravov crackerov v 8bitových hrách z osemdesiatych rokov.
Keď potom uvidíte horieť digitálne stromy, oblohu s mrakmi vytvorenými z kociek tetrisu, vyľakané
pípanie vyplašených Darwiniánov (podľa manuálu ich dabovala mačka Maddie) alebo ich radostné
vyskakovanie po splnenej misii, pochopíte, že sa autorom ich zámer – vytvoriť digitálny svet – poda-
ril. Ak som vás o tom nepresvedčil ja, mohlo by vás presvedčiť nové demo, ktoré na rozdiel od toho
starého dobre ilustruje všetky prednosti hry a navyše tvorí epilóg k pôvodnej dejovej línii, v ktorom
sa Darwiniáni na rakete vydávajú objavovať nové hviezdne systémy. Nezabudnite sa preto pozrieť
na stránky Introversion, kde nájdete nielen demo, ale aj najnovšiu záplatu; tá zároveň slúži ako
inštalátor pre Linux (hľadajte v sekcii support). Veľa šťastia pri zachraňovaní Darwinie!


Technické požiadavky:


Jadro 2.4 alebo novšie, glibc-2.1 alebo novšie, X Window System, procesor P3 600 MHz alebo lepší,
128 MB RAM, 60 MB HDD, 32 MB grafická karta s 3D akceleráciou, OSS kompatibilná zvuková
karta (stačí emulácia cez ALSA)


Darwiniáni vyšších verzií majú vlastné zbrane: tu zaháňajú na útek stonožku.


Odkazy


[1] http://www.linuxexpres.cz/strucny-obsah-unoroveho-cisla-2-2006
[2] http://www.linuxexpres.cz


? ? ?
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Gentoo Linux – Prelink a Psyco


Matej ’Yin’ Gagyi


Ďalšie urýchľovanie systému. Tentokrát upravíme knižnice, spustitelné binárky a pro-
gramy písané v Pythone (konkrétne Portage).


Prelink


Používatelia desktopového prostredia KDE môžu za prelink ďakovať Jakubovi Jelinekovi z RedHatu.
Prelink upravuje knižnice a binárky tak, aby sa programy spúšťali rýchlejšie (hlavne aplikácie písané
v jazyku C++, napríklad KDE).


Inštalácia


V Gentoo nie je inštalácia prelinku nič zložité (zväčša):


$ su -


Password:


# emerge prelink


Prelink sa však nemusí nainštalovať, ak na prelinkovanie nemáte pripravený systém. Celý systém by
mal byť skompilovaný s USE flagom pic . Pridajte ho do súboru /etc/make.conf: USE="pic" a
prekompilujte celý systém:


$ su -


Password:


# emerge --update --deep --newuse world


alebo:


$ su -


Password:


# emerge -uDN world


Nastavenia a spustenie prelinku


Po úspešnom nainštalovaní prelinku odporúčam upraviť nastavenia v súbore /etc/env.d/60prelink.
Pridajte adresáre /opt, /mnt, /tmp a /var/tmp do premennej PRELINK PATH MASK :


PRELINK_PATH_MASK="/opt:/mnt:/tmp:/var/tmp:..."


Prelink sa bude týmto adresárom vyhýbať a prelinkovanie bude trvať kratšie. Môžete pridať aj ďalšie
adresáre, v ktorých sa nenachádzajú binárky ani knižnice. To isté platí aj pre mená súborov, ktoré
ma prelink vynechať (napríklad: *.txt, *.html, *.odt apod.) Teraz vygenerujte konfiguračné súbory
systému (vrátane /etc/prelink.conf):


$ su -


Password:
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# env-update


>>> Regenerating /etc/ld.so.cache...


Spustenie a používanie prelinku


Teraz stačí spustiť prelinkovanie a dať si šálku svojho obľúbeného kofeínového nápoja, pretože to
bude chvíľu trvať:


$ su -


Password:


# prelink -amR


Parametre:


-a, --all


Prelinkuje všetko, čo nájde.


-m, --conserve-memory


Zmenší pamäť potrebnú pre spustené súbory.


-R, --random


Zvýši bezpečnosť prelinkovaných programov.


-q, --quick


Použite po inštalovaní nových verzií knižníc. Zrýchli opätovné prelinkovanie.


-u, --undo


Vráti všetky zmeny, ktoré boli na knižniciach a binárkach urobené.


POZOR! Pred prelinkovaním si dajte pozor, aby ste mali dostatok voľného miesta na disku. Stačí
len pár megabajtov, ale radšej si ich uvoľnite viac (aspoň 100MB).


Prelink a KDE
Štartovanie KDE sa môže zrýchliť až o 50 %, ak mu oznámite, že už je prelinkované. Stačí na-
staviť premennú prostredia KDE IS PRELINKED . Používatelia Gentoo tak môžu urobiť v súbore
/etc/env.d/99kdeenv: KDE IS PRELINKED=1
Aby sa zmena prejavila, treba obnoviť konfiguráciu systému a načítať nanovo vygenerovaný súbor
/etc/profile:


$ su -


Password:


# env-update


# exit


$ source /etc/profile


Psyco
Stále opakujem, že Portage je veľmi pomalý. Nastal čas prestať o tom rozprávať a niečo s tým urobiť.
Samozrejme, ak máte výkonný hardvér, rýchlosť Portage vám prekážať nemusí. Vlastníkov starších
počítačov teraz prichádza vykúpiť Psyco.
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Ako Psyco funguje
Portage je celý napísaný v programovacom jazyku Python. Python je interpretovaný jazyk, takže je
omnoho pomalší ako kompilované jazyky (C, C++, Pascal a podobne).
Psyco kompiluje program do binárnej formy počas behu programu. Skompilovaný program pracuje
nezávisle na interpreteri Pythonu, a preto pracuje rýchlejšie. Je to princíp JIT (just-in-time) kompi-
látora, ale Psyco je trochu odlišný.
Psyco totiž každý blok (časť programu) skompiluje do viacerých binárnych verzií. Každá verzia je
optimalizované pre inú situáciu behu programu. Nevýhoda Psyca je, že potrebuje veľké množstvo
pamäte. Presné údaje sa mi nepodarilo zistiť. Podľa autora Psyco urýchľuje Python priemerne štvor-
násobne a matematické výpočty až desaťnásobne. Moje benchmarky ukazujú nasledovné údaje:


Test na procesore AMD AthlonXP 2800+


Program emerge bez Psyco (tretie spustenie):


# time original_emerge -uDNpv world > /dev/null


real 0m3.211s


user 0m2.917s


sys 0m0.242s


Program emerge s Psyco (tretie spustenie):


# time emerge -uDNpv world > /dev/null


real 0m2.822s


user 0m2.534s


sys 0m0.248s


Test na procesore AMD K6-2 400 MHz


Program emerge bez Psyco (tretie spustenie):


# time original_emerge -uDNpv world > /dev/null


real 0m58.200s


user 0m53.159s


sys 0m2.928s


Program emerge s Psyco (tretie spustenie):


# time emerge -uDNpv world > /dev/null


real 0m44.759s


user 0m39.958s


sys 0m2.752s


Inštalácia
Inštalácia je jednoduchá a rýchla: # emerge psyco . Psyco musí byť aktivované z programu, ktorý
chceme urýchliť, preto musíme upraviť súbor /usr/bin/emerge. Najprv si urobte kópiu:


# cd /usr/bin


# cp emerge original_emerge
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Do súboru /usr/bin/emerge pridajte riadky označené zelenou farbou:


#!/usr/bin/python -O


# Copyright 1999-2004 Gentoo Foundation


# Distributed under the terms of the GNU General Public License v2


# $Header: /var/cvsroot/gentoo-src/portage/bin/emerge,v 1.345.2.31 \\


2005/05/18 15:19:52 jstubbs Exp $


import os,sys


os.environ["PORTAGE_CALLER"]="emerge"


sys.path = ["/usr/lib/portage/pym"]+sys.path


import portage


#Added for Psyco


try:


import psyco


psyco.full()


except ImportError:


pass


#Done


import emergehelp,xpak,string,re,commands,time,shutil,traceback,\\


atexit,signal,socket,types


A hotovo, program emerge by mal byť citeľne rýchlejší. Ak Gentoo nepoužívate, ale chcete Psyco
využiť, stiahnite si ho z domovskej stránky Psyco [1].


Odkazy


[1] http://psyco.sourceforge.net/index.html


? ? ?
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Quantian – prostředí nejen pro vědecké výpočty


Vencour


Vznik Quantianu motivovala touha nabídnout zvýšení výkonu sdíleně prováděných
počítačových operací, umožnění pouze dočasného použití počítačových laboratoří na-
bootováním z DVD nebo ze sítě či umožnění práce v jednotném prostředí s minimální
administrací.


Quantian je variantou Knoppixu [1] / Debianu [2] pro numerické a kvantitativní výpočty z oblasti
biologie, chemie, matematiky, fyziky i dalších příbuzných oblastí, samokonfigurující se a přímo bo-
otovatelná cd-rom/dvd distribuce, umožňující počítači, toho bootu schopný, stát se plnokrevnou
linuxovou pracovní stanicí. Quantian taktéž obsahuje clusterKnoppix [3] a je přidána podpora pro
openMossix [4], rozšíření jádra pro clusterování, včetně vzdáleného bootování tenkých klientů v rámci
terminal serveru openMossix přes PXE. Distribuovaný systém lze v Quantianu použít jako „snea-
ker netÿ – spouštěním jobů na jednotlivých počítačích a sbíráním výsledků, jako „Beowulfÿ cluster
– prostřednictvím MPI, PVM a dalších metod, které požadují vlastní paralelní kód (lze použít R
wrappery), prostřednictvím openMossixu, který zprostředkovává celou nakonfigurovanou síť počítačů
jako jako jeden počítač a nevyžaduje explicitní paralelní kód. Dřívější verze Quantianu zůstávají stále
dostupné ke stažení. Nyní je dostupná verze 0.7.9.2 [5], ve které je jádro 2.6.12 a KDE 3.5.1.


Stručné souhrné úvodní informace jsou dostupné mj. z DSC2005 [6], Usenixu 2004 [7] a v Politickém
metodologovi [8].


Co najdeme v Quantianu?


Quantian je rozšířením Knoppixu [9] a clusterKnoppixu [10], ze kterých si bere gigabyty softwaru
i plně automatickou detekci a konfiguraci hardwaru. Na rozdíl od Knoppixu jsou na Quantianu
umístěny mnohé programy podle zájmu teoretiků i praktiků ve zpracování dat. Přidané mnohostní,
numerické a vědecké programy zahrnují:


• Soubor programů pro moderní statistické zpracování a zobrazení dat R [11], se všemi balíčky [12]
z CRANu [13] (kromě neunixových balíčků, jako jsou MimR nebo ROracle, které potřebuje
extra knihovny) a BioConductor [14] nabízející početní kapacitu pro zpracování dat genomu.
Dostupné verze jsou aktualizované k 25.2.2006, stejně tak jako další balíčky z R repozitáře,
s podporou módů Emacs Speak Statistics – ESS [15] pro XEmacs [16], Ggobi vizualizační
program [17], Rpy [18] – R Python interface, RSPearl [19], obousměrnou integraci s Perlem,
úspěšné JGR [20] – Java GUI pro R, Rserve [21] – nehlavičkový R server, Rpad interaktivní
webové rozhraní [22] a počáteční podpora pro RKWard gui pro R.


• Bioinformatické nástroje – jmenovitě project BioConductor [23], BioPerl [24], BioPython [25],
ARB [26] a aplikace jako jsou BLAST2 [27], ClustalW [28], ImageJ [29] a HMMER [30].


• Octave [31] s mnohými rozšiřujícími balíčky – octave-forge [32], octave-sp [33], octave-epstk [34],
Matwrap [35] a Inline::Octave [36] a další maticově zaměřené jazyky.


• Početně algebraický systém Maxima [37] i s X11 frontendovou a emacs podporou, Pari/GP [38],
GAP [39], GiNaC [40], YaCaS [41], Axiom [42], Mathomatic [43] a Calc [44].


• Gnu Scientific Library – GSL [45], obsahující i příklady.
• QuantLib [46], knihovnu pro kvantitativní a finanční operace, včetně jejího pythonského roz-
hraní.


• Geografický informační systém Grass [47].
• Vizualizační systémy OpenDX [48] a Mayavi [49].
• TeXmacs [50] pro WYSIWYG editory, jako jsou LyX [51] a Kile [52] pro (La)TeX.
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• Rozličné moduly Pythonu [53] včetně Scipy [54] – vědeckého a numerického Pythonu.
• Cernlib [55] – množství programů a knihoven z fyzikálních laboratoří CERNu [56].
• Emulátory Bochs [57], Wine [58] a QEMU [59].
• Kancelářské balíky a nástroje OpenOffice.org 2.0 beta, KOffice [60], Abiword [61], Gnume-
ric [62], Inkscape [63], Sodipodi [64], Qcad [65], Gimp [66] a Xfig [67].


• Mnohé další programy, jako jsou: A+ [68] pro kritické aplikace, statický analyzer ftnchek [69]
pro programy ve Fortranu 77, ARIBAS [70] s funkcemi pro řešení algebraických teorií čísel,
euler [71], GTK+ Equation Grapher [72] pro kreslení grafů, FreeFem [73] pro řešení parciál-
ních diferenciálních rovnic, AutoClass [74] hledající komplexitu systému, modelační Surface
Evolver [75], Dr. Geo [76] pro interaktivní geometrii, Gambit [77] pro analýzu her, interaktivní
3D prohlížecí Geomview [78], modelační Ghemical [79] pro názorné zobrazování molekul, GNU
Linear Programming Kit (GLPK) [80] pro řešení problémů velkých čísel, Gnuplot [81] pro ob-
sluhu souřadnicového zapisovače, tabulka chemických prvků GPeriodic [82], technicky kreslící
gri [83], Generic Mapping Tools (gmt) [84] pro práci s kartografickými údaji, GNU Regression,
Econometrics and Time series Library (gretl) [85] pro ekonomickou analýzu, bitmapový Image-
Magick [86], kreslící editor pro pdf a eps IPE [87], LAM/MPI Parallel Computing (mpi) [88]
pro zasíťování a používání paralelních počítačů, LP-solve [89] pro řešení lineárních problémů,
MCL [90] pro práci s řídkými maticemi, MPICH [91] s vylepšenou podporou clusterů, The
Massively Parallel Quantum Chemistry Program (mpqc) [92] počítající vlastnosti molekul,
multimix [93] pro hledání tříd ve vzorcích, RasMol [94] pro zobrazení makromolekulární struk-
tury, plotutils [95] pro tvorbu 2D grafiky, knihovna PGAPack [96] pro paralelní genetické
algoritmy, PSPP [97] pro statistickou analýzu, The Perl Data Language (PDL) [98] pro práci
s n-rozměrnými poli, rCalc [99], SQLite [100] se zero-konfiguračním databázovým enginem,
shell tclsh [101], programovací jazyk Yorick [102] pro simulace či kalkulace, fraktálový zoo-
mer a morpher XaoS [103] a XPPAUT [104] pro řešení deferenciálních a pravděpodobnostních
rovnic.


Podrobněji o některých programech


• The Basic Local Alignment Search Tool (BLAST [105]) hledá oblasti místní podobnosti mezi
částmi genetického kódu. Program porovnává části nukleotidů nebo proteinů s databází a počítá
statistickou podobnost shody. BLAST se používá k identifikaci vztahu funkční a vývojové
sekvencí genomu stejně jako k identifikaci genomových kmenů.


• KLogic [106] je simulační program pro kybernetiky.
• Chemici a elektrotechnici by mohli ocenit Kalzium [107], dosti podrobnou periodickou tabulku
chemických prvků.


• Euler [108] nabízí zpracování reálných i komplexních skalárů i vektorů, programový jazyk s lo-
kálními proměnnými ai funkcemi, dvou a tří rozměrné grafy, animace, numerické integrování
i diferencování, statistické funkce, diferenciální rovnice, interpolace i aproximace, rychlou Fou-
riérovu transformaci i postscriptový výstup a další funkce.


• Praat [109] je program pro analýzu a syntézu řeči. Dokáže extrahovat z daného zvuku spektro-
gramy, kochleogramy, formanty [110] i pauzy [111], zvládne artikulační syntézu jakož i používání
fonetické abecedy. Pro komunikaci s dalšími programy obsahuje vlastní skriptovací jazyk.


Vychytávky z Knoppixu zůstávají i v Quantianu


• Samokonfigurující nastavení grafiky, zvuku, disků, sítě a pomocných zařízení, které nemá ob-
doby. :-)


• Poslední verze KDE [112], v současnosti 3.5.1.
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• Vybavení GNU vývojovým prostředím – gcc 3.3, gcc 3.4, gcc 4.0, g77, g++ [113] včetně gcj. Pří-
tomný je též KDevelop [114], DrScheme [115], Quanta [116], Guile [117] a pro správu projektů
Cervisia [118].


• Perl [119] a Python [120] se spoustou doplňků, k tomu další jazyky, jako je ruby [121], tcl [122]
a Lua [123].


• Nejen editory Emacs [124] a Vim [125], ale i Kate [126], JED [127], NEdit [128] a Zile [129].
• Kancelářské nástroje Gnumeric [130], Koffice [131] se znovu přidaným OpenOffice.org [132].
• Balíček síťových utilit pro přístup přes drát i bezdrát, GPRS i UMTS, síťově vymezeno přes
ethernet, isdn i dial-up.


• Kompletní teTex [133] Tex / LaTeX [134] nastavení pro vědecké publikování společně s wysiwyg
frontendy jako jsou Kile [135] a LyX [136] / LyX-Qt [137], preview mód pro emacs editory,další
nejen bibtexové nástroje, jako třeba prosper [138], pdfscreen [139] a beamer.


• Z Kanotixu je doplněna podpora pro použití televizních karet s bttv čipsetem prostřednictvím
xawtv a AleVT.


Nastavenou konfiguraci Quantianu lze uložit, v mém případě na flashku, pak ji lze při bootu načíst
zadáním knoppix myconfig=/dev/sda1 .


Drobné osobní poznámky
Při bootu jsou nabízeny volby mj. fb1280x1024, fb1024x768, fb800x600, je možné nastavit národní
prostředí, vybrat si při startu wm z icewm, fluxbox, kde a twm, při 1GB++ RAM do ní vše nako-
pírovat, zapnout/vypnout DMA, zvolit podporu brailova písma, vybrat runlevel, otestovat médium
v cd/dvd mechanice, otestovat paměť. Množstvím softwaru mne uchvátil. I taková hloupost, jako je
učení se psaní na stroji, je v Quantianu obsažena (KTouch [140]). Mapu oblohy nabídne Kstars [141]
– viz obrázek, dokáže i simulovat pohyb planet v naší Sluneční soustavě. V možnostech simulace
je Celestia [142] možná ještě dál. Internetová rádia zvládne Kaffeine. Jediné, co mi chybí, je htop
(lze jej ovšem apt-getnout). Při hledání podkladů k Calcu [143] jsem narazil i na stránku o Mer-
sennových prvočíslech [144]. Také jsem objevil staré pravidlo, že není pěkné jen to, co se třpytí, má
lákavé gui a tak, například zmiňovaný autoclass [145] hledá souvislosti v datech samotných, používá
Bayesovskou klasifikaci [146] systémů.
Používání takovéto distribuce mi přijde vhodné i pro začátečníky, budou jako já překvapeni, co vše
pěkné už v open softwaru je. Přímo z menu lze spustit ssh, sambu a nx servery. Hračičkové by
mohli ocenit přítomnost slušného počtu her, jmenovitě najdou Kgalaxa, Frozen-bubble, KAsteroids,
Enigma, Monopoly, KAtomic, Tetravex.
Čerpáno z: Quantianu [147] a Penguina [148], který mne na stopu Quantianu přivedl a tímto bych
mu chtěl i poděkovat.
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Slax 5.0.7


Martin Tesař


Slax je linuxová live distribuce, která se díky velikosti pouhých 188MB vejde na mini-
CD (o průměru 8cm), případně na flash disk. Článek popisuje zkušenosti s verzí
5.0.7 Czech Edition a protože se zaměřuje hlavně na nováčky, upozorňuje především
na problémy, které mohou uživatele potkat.


Slax se stal za necelé čtyři roky své existence coby malá linuxová distribuce ve světě Linuxu pojmem.
Pro nováčky ve světě Linuxu budiž řečeno aspoň tolik, že live distribuce Linuxu je operační systém
běžící kompletně z CD-ROM nebo flash disku, které můžete nosit v kapsičce u vesty nebo v peněžence
a v případě potřeby jej nastartovat na kterémkoliv cizím počítači.


Slax je jedna z nejvyzrálejších distribucí tohoto druhu. Vlastence může navíc těšit, že tvůrcem je
Čech, Tomáš Matějíček, díky čemuž existuje dokonce zvláštní české vydání (Czech Edition), které
nabízí vyladěný linuxový operační systém (téměř) kompletně počeštěný, jejíž zatím poslední verzi
5.0.7 z konce ledna 2006 se věnuje následující recenze.


K čemu je live distribuce dobrá


Stručně řečeno, k pohodlné práci v navyklém prostředí na cestách, k opravě nefunkčních systémů
(linuxových) či alespoň záchraně dat z těch většinově rozšířených, k prezentaci Linuxu, i jen tak pro
potěšení z běhu něčeho tak složitého, jako je operační systém z něčeho tak jednoduchého, jako je
placka CD-ROM. Někdy zkrátka nemáte možnost nebo chuť tahat s sebou notebook nebo iPod, a na-
vzdory pokročilé miniaturizaci technologií se ještě i dnes můžete ocitnout v situaci, kdy v hotelovém
pokoji, na koleji nebo v ubytovně máte přístup k cizímu počítači. . .


Tedy, počítači, v takových prostorách zpravidla trošku předpotopní mašince, většinou neudržované,
na které se plácá beznadějně zavirovaný a zoufalými pokusy předchozích hostů rozdrbaný systém
(včetně jejich dokumentů, mailů a historií webových stránek, které navštívili) Windows, často ještě
98. Máte sice teoreticky přístup k internetu, ale systém padá jako přezrálé švestky a dostupný personál
se v tom nevyzná a ani nejeví ochotu se angažovat v takové nebezpečné věci, jako jsou počítače. Navíc
pokud jste v cizině, tak můžete dát skoro krk za to, že administrátor na češtinu při nastavování
systému nepamatoval.


V takové konstelaci pak potřebujete napsat nějaký dopis, poslat e-mail přes web, spravovat svoje
webové stránky, zaflamovat si ve svém oblíbeném fóru na abíčku nebo si jen v klidu zasurfovat, aniž
pak budete muset svoje stopy složitě mazat. Trn z paty vám může vytrhnout právě live distribuce
Linuxu, třeba právě Slax.


V praxi: startujeme


K běhu potřebujete pouze funkční CD-ROM nebo DVD-ROM mechaniku či USB port, z nichž se dá
bootovat (což bývá většinou na takovém cizím „zčuněnémÿ počítači povoleno, nebo se nezřídka při
bootování můžete dostat stiskem kombinace kláves do BIOSu a povolit to tam ručně).


Co naopak nepotřebujete, je pevný disk (ovšem pokud se na počítači nachází linuxový swapovací od-
díl, Slax jej automaticky využije), tím méně nějaký operační systém na disku – což oceníte v horkých
chvilkách, kdy se vám nedaří z pevného disku nabootovat do nainstalovaného systému.


Teorie vypadá vždycky o chlup lépe než barvitá praxe, a tak se potkáte samozřejmě s několika ome-
zeními „báječnéhoÿ operačního systému z kapsičky u vesty. Jako první si řekněme, že si Slax užijete
zejména na strojích s více než 256 MB operační paměti (RAM), navzdory doporučené minimální
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konfiguraci (pro start do příkazové řádky 36 MB, pro start grafického rozhraní s lehkým okenním
manažerem Fluxbox 64 MB a aspoň 144 MB pro běh desktopového prostředí KDE).


Pokud má totiž počítač dostatek RAM, tedy více než 256 MB, můžete použít skvělou vychytávku:
možnost při bootování natáhnout kompletní ISO obraz Slaxu do RAM a uvolnit tak CD mechaniku.
Reakce systému jsou pak samozřejmě svižnější, neboť rychlosti přístupu k RAM se žádná mechanika
nemůže rovnat. Před startem systému stačí napsat na příkazovou řádku:


slax copy2ram


Obsah komprimovaného CD se překopíruje do operační paměti a mechanika automaticky CD vysune.
Další zrada se může týkat problematického hardware, s nímž automatická konfigurace Slaxu odmítne
spolupracovat. Pro tento případ je tu řada tzv. cheatcodes [1], tedy parametrů jádra, kterými můžete
start systému ovlivnit (např. nohotplug , noagp apod.).


Třeba také říci, že pauza před startem systému je minimální (asi 5 sekund), v těch musíte stihnout
stisknout alespoň nějakou klávesu a pak pomocí klávesy F1 vyvolat stručnou nápovědu. Uživatelé
navyklí na start systému (ať už Linuxu nebo Windows) rovnou do grafického prostředí by pak mohli
být zaskočeni způsobem startu Slaxu: nejdříve se dostanete do černé konsole, byť osvěžené zeleným
čtyřlístkem.


Tam teprve se musíte přihlásit ( login ) jako root s heslem toor a pak spustit povelem startx
(případně guifast ) grafické prostředí. Doporučeno může být též před startem grafického prostředí
příkazem xconf nechat provést automatickou detekci a konfiguraci grafické karty, monitoru, klá-
vesnice a myši. Když jsem ji neprovedl já, byla obrazovka pouze poněkud posunuta doprava, po
automatické konfiguraci bylo vše v pořádku. Jak údaje k přihlášení, tak tyto příkazy jsou česky
vypsány na úvodní obrazovce a nemusíte si je tedy pamatovat.


V rámci startu si proberme i řešení vypínání: Úvodní obrazovka radí použít známý trojhmat
Ctrl+Alt+Del , který zahájí reboot systému. Zejména pokud jste pracovali na pevných discích,
je po ukončení KDE, kde vás „Odhlásit seÿ a „Ukončit současnou relaciÿ vrátí do příkazové řádky,
vhodné tento způsob použít: procedura zajistí spolehlivé odpojení pevných disků a vysunutí CD ze
všech mechanik.


Ukládání konfigurace a dokumentů


V live distribuci Linuxu je velmi důležité, abyste mohli ukládat rozpracované dokumenty nebo pří-
padně konfiguraci systému. V live distribuci se vytvořené (a do RAM ukládané) dokumenty nebo
konfigurace bez zálohování na zvláštní místo ztrácí, jakmile systém vypnete (nebo je-li vám vypnut,
např. při výpadku proudu).


Je-li v počítači disketová, CD-RW nebo DVD-RW mechanika, je možné díky programovému vybavení
ukládat na tato média. To předpokládá, že ještě používáte zastaralé diskety a že máte příslušnou CD
nebo DVD mechaniku volnou (tj. že jste nastartovali v režimu copy2ram ). Lépe jsou na tom zřejmě
majitelé flash disku.


Máte-li naopak přístup k internetu, umožňuje Slax využít daleko pohodlnější způsob ukládání dat:
přímo na web. Nabízí nástroj KNetAttach, s jehož pomocí můžete ukládat přímo buď do již připravené
webové složky, nebo si můžete otevřít přímo FTP přístup k vlastnímu účtu, s nímž pak pracujete
jako s obvyklým adresářem (složkou na dokumenty).


Nemáte-li jinou možnost než ukládání na disketu, stačí startovat s parametrem slax floppy , který
zajistí automatické připojení diskety do adresáře /mnt/floppy a všechno, co do něj uložíte, bude
uloženo také na disketu. Lze samozřejmě připojit disketu běžným „linuxovýmÿ způsobem, totiž
příkazem mount ; chcete-li disketu v průběhu práce vyměnit, nezbyde vám než provést ručně:
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umount /mnt/floppy


mount /dev/floppy/O /mnt/floppy


Zvláštní případ je ukládání navolené konfigurace, tj. když už si nastavíte systém (např. přístup
k internetu) k obrazu svému, nechcete stejnou proceduru opakovat stále znova. I na to je ve Slaxu
teoreticky pamatováno. Použít můžete podle dokumentace několik způsobů: buď rovnou při startu
zadat:


webconfig=hesloheslo


(heslo musí mít nejméně 10 znaků a mělo by být jedinečné, protože zároveň slouží k identifikaci na
webovém serveru Slaxu, kam se konfigurace ukládá).


webconfig=ask


způsobí, že budete při startu a při vypnutí na přístupové heslo dotázáni. Uložit konfiguraci můžete
z již běžícího Slaxu povelem z příkazového řádku:


websave [hesloheslo]


případně uloženou konfiguraci natáhnout:


webrestore [hesloheslo]


Zálohovány mají být podle dokumentace adresáře /etc, /root, /home a /var (kromě /var/log
a /var/run) a k dispozici je údajně celých 8 MB pro sezení. Z konfiguračních dat je vytvořen soubor
– a ten pak automaticky uploadován na server. Doporučuje se však celou proceduru před ostrým
nasazením několikrát vyzkoušet a pochopitelně raději nezálohovat tímto způsobem choulostivá data
jako různá přístupová hesla nebo důvěrné dokumenty. Za sebe musím říci, že se mi tímto způsobem
nedařilo v době testování konfigurace ukládat ani načítat a že by si tento způsob patrně zasloužil
extra analýzu, případně dopracování.


Programová výbava: práce i zábava


V recenzované verzi Slaxu je nainstalováno KDE 3.5.0 a odpovídající vybrané „kancelářskéÿ vyba-
vení: Slax se snaží maximálně využít nabídky KDE a zbytečně aplikace nezdvojovat. Spustit lze
jako nouzové řešení „lehkýÿ okenní manažer Fluxbox, jenž ale není příliš vyladěný, tedy určený pro
nezkušené uživatele, a proto se jím nebudu v článku zabývat.


Jako textový procesor slouží KWord (1.4.1), pro tvorbu tabulek KSpread, jako tvůrce prezentací
KPresenter. Použil jsem KWord ve Slaxu pro psaní několika kratších textů (včetně tohoto) a své
úlohy jednoduchého textového procesoru se zhostil se ctí. Uživatelé uvítají, že lze ukládat dokumenty
do formátu OASIS OpenDocument Text (.odt), s nímž pracuje OpenOffice.org, a tedy že text bude
přístupný i pro uživatele, kteří KWord nemají. Ukládání je samozřejmě možné v širokém spektru
formátů, od formátu čím dál oblíbenějšího procesoru Abiword přes SGML dokument až po Rich
Text Format (.rtf), který by měl otevřít bez větších problémů i MS Word. Samozřejmě je moudré
práci a převody komplexnějších a důležitých dokumentů a prezentací raději ověřit předem, neboť
převody mezi formáty nejsou nikdy dokonalé.


K dispozici je několik základních KDE programů, jako jsou nezbytný webový prohlížeč a souborový
manažer v jednom Konqueror, textové editory KWrite a Kate, vědecká kalkulačka KCalc, snímač
obrazovky KSnapshot, mailový klient Kmail, kromě toho vypalovací program K3B, prohlížeč PDF
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souborů KPDF, prohlížeč obrázků Kuickshow, jednoduchý kreslící program KolourPaint, archivační
nástroj Ark, čtečka RSS kanálu Akregator, vzdálené připojení pracovní plochy Krcd, instant mes-
senger (ICQ, IRC, Jabber atd.) Kopete.


A propos připojení k internetu: máte-li štěstí, obstará ji za vás automatická konfigurace DHCP již
při startu a nemusíte sahat na nic, chcete-li zprovoznit připojení přes modem či zadat ručně potřebné
údaje, je k dispozici nástroj KPPP resp. možnost zadat do příkazové řádky povely:


ifconfig eth0 123.123.123.123 netmask 255.255.255.0


route add default gateway 123.123.123.1


echo "nameserver 123.123.123.10" >> /etc/resolv.conf


Zastoupeny jsou i multimediální aplikace: Kliknutí na stream internetového rádia ve formátu WMA
(.asx) nabídne otevření přehrávače KPlayer (dříve KMPlayer) – a hraje to. Zklamáním skončily
ovšem pokusy o přímé přehrání formátů OGG a MP3 jako streamů z internetu: dialog KDE nabídne
aplikaci Noatun, ta však místo hraní pravidelně spadne. MP3 uložené na pevném disku Noatun oproti
tomu přehraje bez problémů. Kromě toho je k dispozici ještě přehrávač hudby JuK (jakýsi jukebox,
kam můžete umístit své playlisty) a také KsCD pro přehrávání klasických audio CD.


Přehrát DVD už není pro nezkušené až tak triviální, protože v menu KPlayeru patřičná položka chybí.
Je třeba otevřít buď zařízení, kde se DVD nachází (přes menu Soubor ¿ Otevřít a vyhledat v adresáři
/dev), nebo zapsat přímo do dialogu Otevřít URL: /dev/dvd. Jistě by prospělo inspirovat se např.
na první pohled přehledným startovacím prostředí z Kaffeine. KPlayer je na slabších systémech také
poněkud náročnější na výkon CPU než třeba Xine: ve výchozím nastavení se na takovém PII se 400
MHz na film z DVD lze dívat, pouze když omluvíte občasné trhnutí zvuku i obrazu.


Pro spíše zkušenější „linuxákyÿ a pro práci v textovém režimu je určen textový editor Elvis (2.2.0),
který vychází z Vi a díky víceméně kompatibilním vlastnostem i ovládání poslouží navzdory menší
velikosti jako náhrada fanouškům editoru Vim (dvoudílný článek o editoru Elvis ve srovnání s Vim
napsal před rokem pro Root.cz Pavel Tišnovský: VIM2ELVIS [2]).


Zařazen je i konzolový e-mailový klient Mutt [3] (viz článek Jan Fuchse Mutt – jak začít [4]), samo-
zřejmě souborový manažer Midnight Commander a textový webový prohlížeč Lynx. Sada nástrojů
samozřejmě není kompletní, ale Slax se evidentně zaměřuje více na uživatele než na administrá-
tory a ti zkušení mají na výběr řadu jiných live distribucí použitelných coby rescue (záchranné)
CD s potřebnými nástroji. Přesto je Slax použitelný i pro základní práci v konzoli coby záchranný
nástroj.


Slax připojuje všechny nalezené a podporované oddíly pevných disků, včetně těch se souborovými
systémy FAT32 a NTFS, tedy i ty windowsovské. Pozor, ty linuxové automaticky i pro možnost
zápisu, což sice ulehčuje opravy, ale také představuje při neopatrné manipulaci potenciální riziko
pro nainstalované systémy. Oddíly FAT32 a NTFS jsou připojovány automaticky naštěstí jen pro
čtení, nemělo by se vám tedy stát, že nevědomky poškodíte nějaká Windows. Ostatně, chcete-li si
být úplně jisti, že nebudete pevný disk potřebovat, je možné startovat s parametrem nohd , a tak
zabránit připojování jakýchkoliv pevných disků.


Mouchy a nedodělky
Tím se dostáváme k několika na první pohled zřejmým „mouchámÿ této jinak skvělé distribuce,
jejichž přítomnost mrzí tím spíše, že by se daly s trochou péče snadno vychytat. Většina z nich se
týká výchozího nastavení a pro zkušené uživatele Linuxu resp. KDE jejich náprava nepředstavuje
žádný problém.


Nicméně jistě všichni, kdo pracovali častěji s nějakou live distribucí Linuxu, mi dají za pravdu
v tom, že v případě nouze, kdy se live distribuce Linuxu zejména použije, nemáme chuť upravovat
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si samozřejmosti. Vyladěný předvýběr je v takovém případě mnohem lepší než ponechat výchozí
nastavení, které vyhoví jen málokomu. I když použijete při startu české verze (Czech Edition) boot
parametr lang=cs (který je vlastně zbytečný), není po startu KDE připravena česká klávesnice
a místo očekávané vlaječky Kbd se objeví bílý flek s nápisem „errÿ jako chyba.


Českou klávesnici je proto nutné přidat ručně pomocí KDE-menu Nastavení (po kliknutí na ikonku
vlaječky) nebo Ovládacího centra. Toto nastavení bohužel záloha pomocí webconfig nezachová. Za-
tímco pamatuji doby, kdy byla ve Slaxu dostupná pouze česká klávesnice QWERTY, je to nyní přesně
naopak, nyní je „českáÿ pouze QWERTZ, což může zklamat ty, kteří si na QWERTY navykli.


Písmo Luxi nepůsobí příliš esteticky, a i když lze pochopit, že práce ve Slaxu bude často nouzová,
nebylo by možná od věci přidat k české verzi nějaké lepší písmo odvozené od přítomného Vera Bit-
Stream (které je kvůli absenci diakritických značek pro češtinu stejně nepoužitelné), např. vynikající
DejaVu, jakož i nastavit ho jako výchozí písmo v KDE.


V terminálu Konsole je nastaveno coby výchozí miniaturní a tedy nečitelné písmo, a to i na 19”
monitoru v rozlišení 1024x768. Jak vypadá při větším rozlišení nebo naopak na menším starém mo-
nitoru, to si raději ani nepředstavuji. Navíc nejsou jako výchozí české fonty, což se projeví nejpozději
při startu Midnight Commanderu, který naopak česky je, čtverečky namísto písmen s diakritikou.
Nastavení fontů Konsole je tedy opět třeba provést ručně, stejně jako v Kate, chcete-li psát a číst
česky.


Osobně bych uvítal kromě lepších českých přibalení i některých nelatinských fontů, aspoň hláskových,
jako je řečtina, ruština, arabština a hebrejština a umožnit psaní textu směrem RTL (right-to-left),
pravděpodobně by to nestálo příliš námahy ani prostoru. Zájemci o dálněvýchodní variantu (ja-
ponština, korejština, čínština) by možná mohli pomoci s příslušnou extra verzí. Také připojit aspoň
kontrolu pravopisu těch nejužívanějších cizích jazyků (angličtina, němčina, francouzština) k přítomné
češtině by jistě stálo za úvahu – tak by se mohl stát Slax skutečně pracovním nástrojem na cesty.


Konqueror by mohl mít nastavenu výchozí vyhledávací službu, např. Google, aby se dalo hledat
rovnou z adresového řádku prohlížeče a nemusela se výchozí služba ručně nastavovat. Taktéž poněkud
otravné výchozí otvírání odkazů v nových oknech namísto nových panelů/záložek by si zasloužilo
korigovat. Vedle toho už působí jen jako drobnost, že matematický editor KWordu má jako výchozí
nastaveno v systému nepřítomné písmo Times, čímž je prakticky nepoužitelný.


Řada těchto nastavení je víceméně triviální pro autora distribuce a přitom by maximálně vylep-
šily dojem z ní. Nelze se než přimluvit, aby byla kromě funkčnosti jednotlivých aplikací věnována
pozornost také takovým a podobným maličkostem.


Bonusy pro kutily


Tvůrce Slaxu nabízí ve spolupráci s mezitím docela živou komunitou uživatelů řadu přídavných
modulů [5], s jejichž pomocí si můžete Slax upravit podle svého gusta a potřeb. Spuštění modulů
pomocí parametru uselivemod může však způsobit zatuhnutí systému, což se mi také při pokusu
s modulem libxine skutečně stalo – příčinou je patrně nějaký bug UnionFS a lze doufat, že příští
verze budou v tomto směru méně problémové.


Dobrým nápadem jsou „special editions [6]ÿ Slaxu, upravené verze pro různé speciální účely, např.
PopCorn (obsahuje desktop XFCE, Firefox, beep-XMMS, Gaim, Abiword), Kill Bill (zaměření na
spolupráci s aplikacemi pro Windows, obsahuje Wine, Dosbox a Qemu), Server Edition (včetně
služeb DNS, DHCP, SMB, HTTP, FTP, MySQL, SMTP, POP3, IMAP, SSH) či minimalistické
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Frodo (pouze konzolový základ pro ostatní verze Slaxu). A pokud máte ambice vyrobit si na bázi
Slaxu live CD zcela vlastní, nabízí k tomu autor řadu skriptů a návod [7].


Na závěr bych se měl ještě kvůli úplnosti zmínit o instalaci Slaxu na pevný disk, vzhledem k recen-
zované verzi to ale udělám jen krátce, neboť sám tvůrce varuje, že tato verze může mít s instalací na
pevný disk problémy. Předchozí verze si však soudě podle diskusí ve fóru nainstalovala bez větších
problémů řada lidí. Vlastnosti a konfigurace Slaxu na pevném disku se však mohou od live stavu
značně lišit, proto neočekávejte automaticky stejnou funkčnost, tím spíše, že ani tvůrce distribuce
není a nikdy příliš nebyl nakloněn tomuto způsobu užití Slaxu a doporučuje v takovém případě
sáhnout po plnohodnotné distribuci originálního Slackware.


Shrnuto


Slax je příkladem úspěšného projektu: skvělý nápad malé live distribuce a jeho důsledné, stále se
zdokonalující provedení. Pro náročného (tedy nezkušeného) uživatele je však třeba označit ho stále
ještě jako stádium „betaÿ, tedy v podstatě funkční, ale nevychytaný. I přes zmíněné (snadno odstra-
nitelné) nedostatky může však Slax směle aspirovat na místo ve výstavní skříni Linuxu a důstojně
se řadí vedle projektů, jako je průkopnický Knoppix nebo následováníhodný vyladěný Kanotix [8].


Poznámka: Na Slaxu je založen např. ABC Linux 2005 [9].


Doplněk k verzi Slax 5.0.8


Protože nedlouho po zveřejnění této recenze vyšla nová udržovací verze Slaxu označená jako 5.0.8,
přidávám aktualizaci některých výše uvedených kritických pasáží:


Nejznatelnější zlepšení je tentokrát připravená česká klávesnice hned po startu grafického prostředí
KDE (pravděpodobně kvůli bugu v Xorg – viz diskuse pod článekm – ale stále pouze QWERTZ).
Také v terminálovém programu Konsole je nastaveno české písmo jako výchozí a nemusíte je tedy
před spouštěním Midnight Commanderu upravovat; stejně jako je již možné díky úpravě písma vložit
v KWordu do dokumentu matematický vzorec.


Další hlavní změna asi je, že ačkoliv číslování naznačuje pouze udržovací verzi, postatně se změnila
práce s operační pamětí. Slax nyní využívá pouze asi 60 % RAM coby virtuální pevný disk (oproti
90 % verzí předchozích), což výrazně omezuje uživatele se slabší konfigurací počítače: abyste totiž
mohli použít v článku zmiňovaný startovací parametr copy2ram , bude u Slaxu 5.0.8 třeba odhadem
nejméně 512 MB fyzické RAM, navzdory v nápovědě stále uvedeným 256 MB.


Odkazy


[1] http://slax.linux-live.org/cheatcodes.php
[2] http://www.root.cz/clanky/vim2elvis-1
[3] http://www.mutt.org/
[4] http://www.abclinuxu.cz/clanky/navody/mutt-jak-zacit
[5] http://slax.linux-live.org/modules.php
[6] http://slax.linux-live.org/download.php
[7] http://www.linux-live.org/
[8] http://www.abclinuxu.cz/clanky/recenze/kanotix
[9] http://www.abclinuxu.cz/projekty/abclinux/verze-2005
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Jaderné noviny – 15. 3. 2006
Robert Krátký


Aktuální verze jádra. Citát týdne. Shrnutí API změn v2.6.16. Virtualizační rozhraní
VMI. StromyI:Radix stromy. Přístup klinuxovému jádru prostřednictvím souborového
systému /proc.


Poznámka redakce: Vzhledem k tomu, že Zack Brown ukončil svůj seriál Kernel Traffic a já nemám
tolik času, abych mohl přípravu KT zcela převzít, bylo nutné najít náhradu (více k této situaci v zápisu
Konec Jaderných novin? Snad ne.. . [1]). Dohodl jsem se proto s redaktory LWN na překládání jejich
zpravodajství o vývoji jádra a dění v LKML. Tento díl Jaderných novin je tedy prvním, který je založen
na LWN.net. Berte jej jako díl testovací, oťukávací a průzkumný. Zatím nemám jasnou představu
o tom, jakým způsobem budu JN z materiálů dostupných na LWN připravovat. Pokud máte vlastní
připomínky či návrhy, podělte se o ně v diskuzi.


Verze jádra


Aktuální prepatch pro 2.6 je 2.6.16-rc6 – vydán [2] 11. března. Linus poznamenává: Ok, blížíme se,
i když vydání 2.6.16 se rozhodně protahuje více, než by mělo.


Jak by se dalo očekávat, patch obsahuje především opravy; viz dlouhý changelog [3]. Git repozitář
hlavního stromu obsahuje několik desítek patchů začleněných od -rc6; mnohé z nich jsou opravy
chyb nalezených díky kontrole pomocí Coverity. Také je tam patch, který vypíná sysfs rozhraní
pro subsystém detekce a opravy chyb (EDAC); dané rozhraní „je potřeba lépe promysletÿ, takže
bude schováno, dokud nebudou problémy vyřešeny. Aktuální -mm strom je 2.6.16-rc6-mm1 [4]. Mezi
nedávné změny v -mm patří nová sada patchů pro sdílení NFS superbloků (což způsobuje některým
testerům problémy s NFS) a řádka oprav.


Citát týdne


Jo, a na holky nezabírá, když řeknete, že jste hacker jádra. Lhali jste mi. – Mariusz Mazur [5] vzdává
linux-libc-headers.


Shrnutí API změn v 2.6.16


2.6.16 by měla být v tuto chvíli již dostatečně stabilní na to, abychom sestavili seznam změn v API.
Jako obvykle bude tento seznam také zařazen do LWN 2.6 API changes page [6].


• Byl začleněn mutex kód [7]. Používání semaforů pro vzájemné vyloučení [mutual exclusion] je
teď považováno za nevhodné a současné semaforové API možná bude odstraněno celé.


• Začlenění se dočkal kód jaderného časovače s vysokým rozlišením [high-resolution kernel ti-
mer] [8]. Nové API umožňuje používání přesnějších hodnot časovače, ale základní implementace
je stále omezena rozlišením přerušení časovače.


• Nová seznamová funkce list for each entry safe reverse()
dělá přesně to, co by od ní člověk očekával.


• Byl přidán atomický typ atomic long t . Podporuje následující funkce:


◦ long atomic long read(atomic long t *l);


◦ void atomic long set(atomic long t *l, long i);


◦ void atomic long inc(atomic long t *l);


◦ void atomic long dec(atomic long t *l);
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◦ void atomic long add(long i, atomic long t *l);


◦ void atomic long sub(long i, atomic long t *l);


• Byl začleněn alokátor paměti „SLOBÿ. SLOB je náhradou za alokátor slab a je určen pro
systémy s velmi malou pamětí.


• Změnila se struktura dentry : pole d child a d rcu jsou nyní překrytá ve spojení [overlaid
in a union]. Tím se tato často využívaná struktura zmenšuje a vylepšuje se její kešové chování.


• Struktura usb driver má nové pole ( no dynamic id ), které ovladačům umožňuje vypnout
přidávání dynamických ID pro zařízení. Pole owner bylo ze struktury odstraněno.


• Metody pro ovládání zařízení – probe() a remove() – přesunuty ze struct device driver
do struct bus type . Metody na úrovni sběrnice budou mít přednost před všemi zbývajícími
metodami ovladačů.


• Několik významných změn v SCSI subsystému je zaměřeno na ukončení používání staré struk-
tury scsi request . Softwarové SCSI IRQ už není používáno; o postprocessing se místo toho
stará obecné blokové softwarové IRQ.


• Většina kódu základního modelu zařízení byla naučena používat termín „ueventÿ místo „hot-
plug.ÿ Některé změny jsou patrné mimo základní kód:


◦ kobject hotplug() se mění na kobject uevent()
◦ struct kset hotplug ops se mění na struct kset uevent ops a jeho člen hotplug()
je teď uevent()


◦ add hotplug env var() se mění na add uevent var()


• Blokový I/O bariérový kód byl přepsán [9]. Tento patch mění bariérové API a také přidává
nový parametr pro end that request last() .


• Struktura block device operations má novou metodu getgeo() ; její funkcí je poskytnout
struktuře hd geometry informace o jednotce. Díky tomu nebudou mnohé blokové ovladače
vůbec potřebat ioctl() funkci.


• Byl začleněn patch Linase Vepstase pro zotavení po PCI chybě [10].
• Kompilátory starší než gcc 3.2 už nelze používat k sestavování jádra.
• Letitý příkaz „make bzImageÿ přestal fungovat; použijte místo něj jen „makeÿ.
• Je-li jádro nastaveno pro optimalizaci velikosti, gcc (pokud je to verze 4.x) se může sám roz-
hodnout, jestli mají být inline funkce skutečně inline. Atribut always inline vynutí
inlinování ve všech případech. Jde o výsledek diskuze o inline funkcích [11] z počátku roku.


Virtualizační rozhraní VMI
Nikdo by se neodvážil tvrdit, že je na výběr málo linuxových virtualizačních technologií. Existuje
množství přístupů, od odlehčených „kontejnerovýchÿ technik, které prostě vytvoří zdi mezi částmi
systému, až po plně virtualizační přístupy, které implementují kompletní virtuální hardwarovou plat-
formu schopnou provozovat více (neupravených) operačních systémů. Na pomezí těchto dvou jsou
„paravirtualizačníÿ přístupy vyžadující určitou míru porozumění ze strany hostovaného jádra. Pro
mnohé je paravirtualizace nejlepším přístupem, protože slibuje kombinaci relativně vysokého vý-
konu se silnou izolací hostovaného systému. Nejčastěji vzpomínaným paravirtualizačním systémem
je v současnosti Xen, ale existují další.
Každý paravirtualizační systém klade na hostovaný systém jisté požadavky. Než může být daný
systém provozován pod konkrétním hypervisorem (software spravující hostované systémy), musí být
upraven tak, aby spolupracoval s rozhraním hypervisora. Tento požadavek může znamenat více práce
pro vytvoření virtuálního systému a zvyšuje i náročnost správy softwaru, především jsou-li hypervisor
i hostované jádro aktivně vyvíjeny.
Ve snaze ulehčit virtualizačním hackerům život přišel Zachary Amsden (z VMware) s komplexním
návrhem [12] na společnou vrstvu rozhraní virtuálních strojů (VMI – Virtual Machine Interface)
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s některými zajímavými vlastnostmi. VMI vrstva definuje sadu volání pro provádění funkcí speci-
fických pro daný stroj – tedy ten druh věcí, které obyčejně vyžadují zásah hypervisora. Tato volání
jsou velmi nízkoúrovňová - operace jako ochrana stránek, povolování přerušení, zapisování registrů
u konkrétních modelů, změny specifických kontrolních registrů, obsluha událostí časovače atd. V dů-
sledku toho funguje v současné době VMI vrstva pouze se systémy s i386 architekturou, i když se
pracuje na x86-64 portu.
Když nabootuje virtualizované jádro, jednou z prvních věcí, které udělá, je vyhledání „VMI ROMÿ
poskytnuté hypervisorem. Tato ROM obsahuje informace potřebné pro to, aby nízkoúrovňová VMI
volání mohla spolupracovat s hypervisorem. S použitím informací nalezených v ROM si právě nabo-
otované jádro samo upraví kód tak, aby využívalo funkce hypervisoru bez hledání v tabulkách nebo
nepřímých volání funkcí. Výsledkem toho je, že operace hypervisoru jsou rychlé.
Tento přístup má několik zajímavých aspektů. Jedním je, že jádro vybavené VMI může být provozo-
váno pod jakýmkoliv VMI hypervisorem bez úprav – dokonce bez překompilování. Prostě si vezme
ROM poskytnutou kterýmkoliv dostupným hypervisorem a dál si jede po svém. Stejně zajímavá je
skutečnost, že takové jádro může běžet na holém hardwaru bez jakéhokoliv hyoervisora a fungovat
jako hostitelské jádro. Vývojáři VMI tvrdí, že dopad na výkon je v podstatě nulový. To vede k tomuto
tvrzeni:
VMI Linux má na nativních strojích zanedbatelnou režii, takže věříme, že se v budoucnu může stát
výchozím Linuxem pro i386. Vlastní kód je dodáván jako 24dílný patch. Zahrnuje dost nízkoúrov-
ňového nastavování a fíglů s assemblerem. To může být jednou z příčin toho, že samotný kód nebyl
zatím příliš komentován. Dosavadní diskuze se zdá myšlence nakloněná, i když odměřená. Kromě
jiných věcí bude potřeba open source hypervisor, který toto rozhraní využívá – dříve než může být
vážně uvažováno o začlenění. Prozatím si můžete další podrobnosti přečíst v dokumentaci [13].


Stromy I: Radix stromy
Jádro obsahuje množství knihovních rutin pro implementaci užitečných datových struktur. Mezi ty
patří i dva druhy stromů: radix stromy a red-black stromy. Tento článek se zaměří na API radix
stromu, přičemž red-black stromy budou následovat v budoucnu.
Wikipedia má článek o radix stromech [14], ale linuxové radix stromy v něm nejsou dobře popsány.
Linuxový radix strom je mechanismus, pomocí kterého může být (ukazatelová) hodnota propojena
s (dlouhým) integerovým klíčem. Z hlediska ukládání je to rozumně efektivní a při vyhledávání docela
rychlé. Kromě toho mají radix stromy v linuxovém jádře několik funkcí zaměřených na specifické
potřeby jádra, včetně schopnosti přiřazovat značky [tags] konkrétním záznamům.


Ten roztomilý malý diagram ukazuje listový uzel linuxového radix stromu. Uzel obsahuje určitý počet
slotů, z nichž každý může obsahovat ukazatel na něco, co je zajímavé pro tvůrce stromu. Prázdné
sloty obsahují ukazatel NULL . Tyto stromy jsou poměrně rozsáhlé – v jádrech 2.6.16-rc je 64 slotů
v každém uzlu radix stromu. Sloty jsou indexovány částí (dlouhého) integerového klíče. Je-li nejvyšší
hodnota klíče méně než 64, může být celý strom reprezentován jediným uzlem. Obyčejně se však
používá poněkud větší sada klíčů – jinak by stačilo obyčejné pole. Takže větší strom může vypadat
nějak takto:
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Tento strom má tři úrovně. Když chce jádro najít konkrétní klíč, bude šest nejvýznamnějších bitů
použito k nalezení příslušného slotu v kořenovém uzlu. Dalších šest bitů indexuje slot ve středním uzlu
a těch nejméně významných šest bitů bude označovat slot obsahující ukazatel na vlastní hodnotu.
Uzly, které nemají žádné potomky, nejsou ve stromu přítomné, takže radix strom může poskytnout
efektivní úložný prostor pro řídké stromy.
Radix stromy mají v hlavním jádře několik uživatelů. PowerPC architektura používá strom k ma-
pování mezi skutečnými a virtuálními IRQ čísly. NFS kód připojuje strom k relevantním inode
strukturám, aby se udržel přehled o čekajících požadavcích. Nicméně nejrozšířenější využití radix
stromů je k vidění v kódu správy paměti. Struktura address space používaná k udržování přehledu
o backing store (úložiště právě nepoužívaných stránek) obsahuje radix strom, který sleduje stránky
v jádře [core] vázané na dané mapování. Kromě jiného umožňuje tento strom kódu pro správu paměti
rychle nacházet stránky, které jsou buď nečisté nebo jsou právě zpětně zapisovány [writeback]. Jak
je pro jaderné datové struktury typické, existují dva režimy pro deklaraci a inicializaci radix stromů:


#include <linux/radix-tree.h>


RADIX_TREE(name, gfp_mask); /* Declare and initialize */


struct radix_tree_root my_tree;


INIT_RADIX_TREE(my_tree, gfp_mask);


První způsob deklaruje a inicializuje radix strom daného jména ( name ); druhý provede inicializaci
za běhu. V obou případech musí být zadána gfp mask , která kódu říká, jak mají být prováděny
alokace paměti. Pokud mají být operace radix stromu (především vkládání) prováděny v atomickém
kontextu, maska by měla být zadána jako GFP ATOMIC . Funkce pro přidávání nebo odstraňování
záznamů jsou přímočaré:


int radix_tree_insert(struct radix_tree_root *tree, unsigned long key,


void *item);


void *radix_tree_delete(struct radix_tree_root *tree, unsigned long key);


Volání radix tree insert() způsobí vložení daného item (propojeno s key ) do daného tree
. Tato operace může vyžadovat alokace paměti; jestliže alokace selže, selže i vložení a návratová
hodnota bude -ENOMEM . Kód odmítne přepsat existující záznam; pokud key ve stromě již existuje,
radix tree insert() vrátí -EEXIST . Při úspěchu je návratová hodnota nula.
radix tree delete() odstraní položku propojenou key ze tree a pokud existoval, vrátí ukazatel
na danou položku. Mohou nastat situace, kdy selhání vložení nové položky do radix stromu může
znamenat zásadní problém. Pro předcházení takovým situacím jsou poskytnuty dvě specializované
funkce:
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int radix_tree_preload(gfp_t gfp_mask);


void radix_tree_preload_end(void);


Tato funkce se pokusí alokovat dostatečné množství paměti (s použitím dané gfp mask ), aby se zaru-
čilo, že následující vložení do radix stromu neselže. Alokované struktury jsou uloženy v proměnné pro
každý procesor, což znamená, že volající funkce musí provést vložení předtím, než bude plánovat nebo
než bude přesunuta na jiný procesor. Kvůli tomu se radix tree preload() při úspěchu vrátí s vy-
pnutou preempcí; volající musí nakonec preempci opět zapnout voláním radix tree preload end()
. Při neúspěchu je vrácena hodnota -ENOMEM a preempce není vypnuta. Radix stromy lze prohledávat
několika způsoby:


void *radix_tree_lookup(struct radix_tree_root *tree, unsigned long key);


void **radix_tree_lookup_slot(struct radix_tree_root *tree, unsigned long key);


unsigned int radix_tree_gang_lookup(struct radix_tree_root *root,


void **results,


unsigned long first_index,


unsigned int max_items);


Nejjednodušší způsob, radix tree lookup() , hledá key v tree a vrací přiřazenou položku (nebo
NULL při neúspěchu). radix tree lookup slot() místo toho vrátí ukazatel na slot, který drží uka-
zatel na danou položku. Volající pak může ukazatel změnit, aby byl key přiřazen k nové položce.
Pokud však položka neexistuje, radix tree lookup slot() pro ni nevytvoří slot, takže tato funkce
nemůže používána místo radix tree insert() . A konečně, volání radix tree gang lookup()
vrátí až max items položek v results se vzestupnými hodnotami klíčů začínajícími na first index
. Počet vrácených položek může být nižší než bylo požadováno, ale krátký výsledek (nenulový) nemusí
nutně znamenat, že ve stromě nejsou žádné další hodnoty.
Mělo by se poznamenat, že žádná z funkcí radix stromů neprovádí interně zamykání. Je na volajícím,
aby si pohlídal, že jednotlivá vlákna strom nepoškodí, nebo se nedostanou do jinak problémových
situací. Nick Piggin dal do oběhu patch, který by pro uvolňování uzlů používal posloupnost číst-
zkopírovat-aktualizovat (RCU – Read-Copy-Update); patch by umožnil provádění vyhledávacích
operací bez uzamykání za předpokladu, že (1) výsledný ukazatel bude použit pouze v atomickém
kontextu a (2) volající kód se vyvaruje vytváření vlastních problémových situací. Není však jasné,
kdy by mohl být patch začleněn.
Kód radix stromů podporuje funkci nazývanou „tagsÿ, díky které mohou být určité bity nastaveny
na položky ve stromu. Tagy se používají například k označení stránek paměti, které jsou nečisté nebo
jsou právě zpětně zapisovány. API pro práci s tagy je:


void *radix_tree_tag_set(struct radix_tree_root *tree,


unsigned long key, int tag);


void *radix_tree_tag_clear(struct radix_tree_root *tree,


unsigned long key, int tag);


int radix_tree_tag_get(struct radix_tree_root *tree,


unsigned long key, int tag);


radix tree tag set() nastaví daný tag na položku indexovanou pomocí key ; je chyba pokoušet
se nastavit tag na neexistující klíč. Návratová hodnota bude ukazatel na otagovanou položku. Ačkoliv
tag vypadá jako běžný integer, kód zatím umožňuje maximálně dva tagy. Použití jakékoliv jiné
hodnoty tagu než nula nebo jedna způsobí tiché narušení paměti na nějakém nechtěném místě; byli
jste varováni. Tagy lze odstranit pomocí radix tree tag clear() ; návratovou hodnotou je opět
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ukazatel na (ne)otagovanou položku. Funkce radix tree tag get() zkontroluje, jestli má položka
indexovaná pomocí key nastavený daný tag ; návratová hodnota je nula, pokud key neexistuje,
-1 pokud key existuje, ale tag není nastaven, a +1 v ostatních případech. Tato funkce je však
v současné době ve zdrojovém kódu zakomentována, protože ji nepoužívá žádný kód uvnitř jádra.
Pro dotazování se na tagy existují další dvě funkce:


int radix_tree_tagged(struct radix_tree_root *tree, int tag);


unsigned int radix_tree_gang_lookup_tag(struct radix_tree_root *tree,


void **results,


unsigned long first_index,


unsigned int max_items,


int tag);


radix tree tagged() vrací nenulovou hodnotu, pokud nějaká položka ve stromě nese daný tag .
Seznam položek s daným tagem získáte pomocí radix tree gang lookup tag() .
Závěrem můžeme poukázat na další zajímavý aspekt API radix stromů: neexistuje žádná funkce
pro zrušení stromu. Zjevně se očekává, že radix stromy budou existovat věčně. V praxi lze však
vymazáním všech položek z radix stromu uvolnit veškerou paměť, která s ním byla spojena – kromě
kořenového uzlu, jehož se lze potom zbavit normálně.


Přístup k linuxovému jádru prostřednictvím souborového systému
/proc (developerWorks)
developerWorks nabízí tutoriál k vytváření /proc souborů [15] z natahovatelných jaderných modulů.
Tady je [modul], který podporuje jak čtení, tak zápis. Tato jednoduchá aplikace funguje jako zásobník
citátů. Po natažení modulu do něj může uživatel nahrát text citátů pomocí příkazu echo a pak je po
jednom zase číst pomocí příkazu cat.
Jen se nesnažte o začlenění do hlavního jádra.
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Zprávičky
1.3.2006 Daniel Kvasnička ml.


Napadlo vás někdy, jaké by to bylo, kdyby Li-
nux tepal pod kapotou Mac OS X? Jason Toffa-
letti, dlouhodobý vývojář pro Mac a nyní uživatel
Ubuntu Linuxu, o tom celkem vážně spekuluje.


1.3.2006 M&M Malevičovi


Patříte také k majitelům wi-fi klienta s chipse-
tem RT61 (RT2600) od Ralinku a stále čekáte
na schopný open-source driver? Na CVS projektu
rt2x00 se konečně objevil. . .


1.3.2006 Daniel Kvasnička ml.


Na KernelTrap.org si můžete přečíst report z ex-
perimentu Jespera Juhla, který stokrát za sebou
s různými konfiguracemi zkompiloval linuxový
kernel. 82 pokusů bylo neúspěšných a warningů
byly tisíce, přičemž nemalé procento problémů
bylo způsobeno již známými chybami. Jesper se
nechal slyšet, že jeho pokus měl být pro lidi mo-
tivací k důslednějšímu hledání a hlášení chyb.


1.3.2006 Daniel Kvasnička ml.


DesktopLinux.com přináší další trefný článek Ste-
vena J. Vaughan-Nicholse. Tentokrát je o Dellu,
jeho desktopu s Linuxem a podezřelé neochotě
tento produkt propagovat.


1.3.2006 Lumír Jasiok


Další seminář OLS se bude konat již příští čtvrtek
9.3.2006 od 17:00hod. na půdě VŠB-TU Ostrava.
Podrobnosti o akci a seznam přednášek naleznete
na ols.vsb.cz. Seminář bude přenášen pomocí on-
line videopřenosu. Adresa on-line streamu je zde.
Všichni jste srdečně zváni.


1.3.2006 GeBu


Další v pořadí šestá Open Party Olomouc se blíží.
Jedná se o neformální setkání zájemců o open
source, GNU/Linux a svobodný software na Olo-
moucku. Na programu je volné posezení a pokec.
Prosím registrujte se :). Pořádá GeBu ve spolu-
práci s Liberix, o. p. s. PS: Nezapomeňte hla-
sovat pro LinuXchange v anketě CZECH OPEN
SOURCE 2006.


2.3.2006 Michal Jurosz


Po pěti letech a pár měsících od svého spuštění
má anglická Wikipedie přes milion článků. Více
v tiskové zprávě. V české Wikipedii počet článků
nedávno překročil 25,000.


2.3.2006 Daniel Kvasnička ml.


Šéfredaktor Redmond magazínu popisuje svoje
zkušenosti s PR předních linuxových společností
a Applu a tvrdí, že Linux a Apple nejen že nejsou
alternativami, ale ani se nesnaží.


2.3.2006 Daniel Kvasnička ml.


Chcete, aby vaše PC dávalo všem na první po-
hled najevo, že má pod kapotou Linux? Pak vám
nezbývá, než mít case ve tvaru tučňáka (Linux-
Devices.com).


2.3.2006 Daniel Kvasnička ml.


Pokud byste rádi měli možnost číst formát DOC
v příkazové řádce, Linux.com pro vás má pár
užitečných programů sloužících právě k tomuto
účelu.


2.3.2006 Daniel Kvasnička ml.


Je možné nacpat něco tak velkého, jako je Wiki-
pedia do něčeho tak malého, jako je Apple iPod?
Ale jistě, prosím: Encyclopodia.


2.3.2006 Leoš Literák


Root.cz pořádá první ročník ankety CZECH OP-
EN SOURCE 2006. Odborná porota a široká ve-
řejnost v ní vybírají to nejlepší z českého open
source. I vy můžete svým hlasováním ovlivnit vý-
sledky.


2.3.2006 Jiří Culka


Tento týden vychází český překlad slavné bible
jazyka C – Programovací jazyk C (The C Progra-
mming Language). Jde o překlad 2. vydání, které
je navíc aktualizované Miroslavem Viriusem.


3.3.2006 Filip Molčan


Dnes byl oficiálně oznámen vznik organizace ODF
Alliance, která si klade za cíl podporovat rozšiřo-
vání formátu ODF a jeho další rozvoj. Mezi 35
zakládajícími členy je i nezisková organizace OSS
Alliance z ČR.


3.3.2006 Daniel Kvasnička ml.


Ač se tomu možná někteří budou divit, mezi XGL
a AIGLX nezuří divoké konkurenční boje, ale nao-
pak kvete spolupráce. David Reveman (Novell) se
domluvil s Kristianem Hogsbergem (Red Hat), že
z projektu AIGLX adoptuje nemalou část změn.
Informoval OSNews.com.


3.3.2006 Daniel Kvasnička ml.


NewsForge udělal malý průzkum v oblasti open-
source licencí pro fonty. Pár jich stručně předsta-
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vuje a nezapomíná ani na rozdíly mezi jejich fi-
lozofií a filozofií běžných licencí pro open-source
software.


3.3.2006 Daniel Kvasnička ml.


Článek na itWorldCanada interpretuje myšlenky
Larryho Ellisona (Oracle CEO), který zdůrazňuje
důležitost finanční zajištěnosti pro open-source
projekty a odmítá romantické představy o Li-
nuxu vyvinutém jen tak pro radost neplacenými
programátory.


3.3.2006 Ivan Bibr


Velmi rychle se objevila další betaverze (beta2)
nového live-cd Mandriva Linux 2006 One. Více in-
formací včetně ukázek najdete například v tomto
článku na mandrivalinux.cz.


3.3.2006 Jan Kundrát


Všemi milovaný server lamer.cz již obsahuje tisíc
citací. Jubilejní výrok tam bezesporu patří :-)


4.3.2006 iSteve


Vyšla první veřejná verze live distribuce Olive.
Jde o technologicky velmi nekonvenční distribuci,
obsahující např. komprimovaný ramdisk, byla též
snaha o rychlejší bootování. V neposlední řadě
ma také přívetivý a sladěný vzhled, mimo jiné
díky Enlightenment DR17 a podpoře Composite
rozšíření.


5.3.2006 Luboš Doležel


Phoronix ve svém článku spekuluje o datu vydání
a funkcích příštích ovladačů NVIDIA (vylepšená
podpora XvMC, podpora nových karet a další).


5.3.2006 Zdeněk Telička


Stránky slovinských příznivců Gentoo Linuxu jsou
zřejmě ještě ve vývoji :-)


6.3.2006 Katarína Machálková


České sdružení uživatelů OpenSolarisu ve spolu-
práci s MFF UK pořádá OpenSolaris BootCamp
spojený s installfestem se zaměřením na insta-
laci a základy administrace OpenSolarisu, jakož
i základy vývoje ovladačů pro jádro OS. Akce se
uskuteční v sobotu 11. března 2006 v posluchár-
nách S3 a S4 v budově MFF UK na Malostran-
ském náměstí. Program je k dispozici na strán-
kách CZOSUGu.


6.3.2006 Lukáš Zapletal


Březnový LinuxEXPRES o webhostingu najdete
na stáncích. V čísle si přečtete velký článek o kon-


figuraci Apache, webovém programování v Py-
thonu nebo o photoshopu pod Linuxem.


6.3.2006 Daniel Kvasnička ml.


Pokud vám vrtá hlavou, co mají všichni s tím
Ruby on Rails, můžete si ho zkusit sami. V blogu
Digital Media Minute vyšel přehledný a podrobný
návod na zprovoznění Lighttpd, MySQL a Ruby
on Rails na Fedora Core 4. Použít ho by snad
neměl být problém ani v jiných distribucích.


6.3.2006 Daniel Kvasnička ml.


Frank van Wensveen ze SearchOpenSource.com
nalézá ve všech příbězích o úspěšné migraci pod-
niku na OSS začátek a konec, ale prostředek, ten
proces samotný, mu chybí. Proto se rozhodl ho
nastínit sám.


6.3.2006 Daniel Kvasnička ml.


Zástupci Ubuntu a Linspire spolu s komunitou
uživatelů v posledních několika dnech diskutovali
možnost používání služby CNR v Ubuntu Linuxu.
Jde o placenou službu poskytující otevřený i pro-
prietární software „na jedno kliknutíÿ. Informuje
DesktopLinux.com.


6.3.2006 Michal Eibl


Tak je venku první Rubix Linux. Rubix je dis-
tribuce beroucí si to nejlepší ze Slackware a Ar-
chu a přidávající několik bezpečnostních vylep-
šení. Vizte oznámení.


7.3.2006 Mirek


Vyšla opravná verze distribuce Elive (distribuce
založené na Debianu ve které je jako implicitní
grafické prostředí E17). Všechny známé bugy na-
hlášené a evidované na stránkách byly vyřešeny,
byl přidán Firefox 1.5, nějaké nové funkce do
elive-panelu a ovladač fglrx opět funguje správně.
Stahovat můžete opět přes torrenty.


7.3.2006 Mirek


Pro fandy Enlightenmentu, konkrétně verze E17,
hlavně pro takové co umí francouzsky, byl ne-
dávno spuštěn nový web http://fr.edevelop.org/.


7.3.2006 Daniel Kvasnička ml.


Vyšel Wine 0.9.9. Mezi novinky v této verzi patří
např. vylepšená podpora webových prohlížečů,
kvalitnější debugger, mnoho bugfixů a další. Bi-
nární balíčky pro vaší distribuci stahujte zde,
zdrojový kód najdete na SourceForge nebo na
ibiblio.
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7.3.2006 Daniel Kvasnička ml.


KernelTrap.org přináší část rozhovoru z mailing
listu Open Graphics Projektu. Diskutuje se o tom,
kolik by měla stát OGD1 – deska, která v bu-
doucnu poslouží jako základ pro open-source gra-
fickou kartu.


7.3.2006 Daniel Kvasnička ml.


AOL včera odstartoval svoji Open AIM inicia-
tivu, v rámci které je k dispozici SDK ulehču-
jící tvorbu vlastního AIM klienta nebo pluginu
pro originální Triton IM. AOL však chápe pojem
„openÿzajímavým způsobem: není dovoleno pou-
žít kit pro vývoj klienta podporujícího více pro-
tokolů, mobilního klienta a pro open-source soft-
ware. Informuje Internetnews.com.


7.3.2006 Michal Čihař


Včera večer vyšla nová verze phpMyAdmina, jed-
noho z nejpoužívanějších nástrojů na správu da-
tabáze MySQL. Tato verze 2.8.0 kromě opravy
mnoha chyb přináší také php skript pro vytvo-
ření konfigurace.


7.3.2006 Pavel ’lingeek’ Szalbot


Kristian Hgsberg (Red Hat) si hrál s Compizem
a AIGLX a podařilo se mu je přinutit k spo-
lupráci s působivým výkonem. Oznámení a in-
formace o patchích poslal do mailing listu free-
desktop.org.


7.3.2006 Daniel Kvasnička ml.


Andreas Pleschek (IBM) se na německé konfe-
renci LinuxForum 2006 nechal slyšet, že firma
zrušila kontrakt s Microsoftem a na jejích desk-
topech se neobjeví Windows Vista, ale Red Hat
Linux. Otázkou zůstává, zda to bylo myšleno glo-
bálně nebo pouze pro Německo. Každopádně to
bude pro MS nemalý kopanec. Informuje Neosee-
ker.


7.3.2006 Daniel Kvasnička ml.


Sdružení výrobců komerčního software (BSA) za-
hájilo kampaň proti pirátství a nelegálnímu soft-
ware. Díky jeho dopisům a telefonátům to pocítí
10000 malých a středních firem v ČR (kde byla
v r. 2004 míra nelegálně užívaného software 41%)
a SR. Kampaň zahrnuje i rozhlasové spoty a ban-
nery. Informují Finanční Noviny.


8.3.2006 Daniel Kvasnička ml.


Steven J. Vaughan-Nichols z LinuxDesktop.com
nabootoval svoje staré 300MHz Pentium, aby zjis-


til, co je pravdy na tvrzení Alana Yatese (Micro-
soft), že OpenOffice.org je tam, kde byl MS Office
před 10 lety.


8.3.2006 Daniel Kvasnička ml.


Server Linux.com přináší první díl seriálu mající
za cíl vás podrobněji seznámit s kancelářským ba-
líkem KOffice, který je většinou opomíjen na úkor
OpenOffice.org. S příchodem verze 1.5 by se to
mohlo změnit.


8.3.2006 Daniel Kvasnička ml.


LinuxToday.com přináší odkaz na stránku, díky
které zjistíte vše důležité o relačním databázovém
systému Firebird, a to za pouhé 2 minuty.


8.3.2006 Daniel Kvasnička ml.


Julie Hanna Faris se v rozhovoru na SearchO-
penSource.com věnuje otázce spolehlivosti firem
v open-source business sféře a klade přitom dů-
raz na hybridní modely kombinující open-source
a uzavřený software.


9.3.2006 Pavel Vakeš


Pro fanoušky distribuce ArchLinux jsem zapra-
coval na překladu oficiální instalační příručky.
Prozatím je umístěna na adrese archlinux.czech-
offspring.net. V budoucnu snad přibudou lokali-
zace dalších přínosných dokumentů.


9.3.2006 Jiří Hlinka


Na světě je nová verze 8.23.7 proprietárních ovla-
dačů grafických karet ATI. Byla přidána podpora
pro karty Radeon X800 a X850, rozšířena pod-
pora OpenGL 2.0 (GLEW) a přidána podpora
FSAA pro karty Radeon 9500 a novější. Bohužel
není stále oficiálně podporovaný Xorg 7.0. Diskuzi
k novým ovladačům najdete na Rage3D.com. Na
phoronix.com je popis nových ovladačů, včetně
benchmarků.


9.3.2006 Daniel Kvasnička ml.


Web programovacího jazyka Python dostal nový
kabát a je radost na něj (nejen) pohledět.


9.3.2006 Daniel Kvasnička ml.


Dnes od 11:00 máte možnost se na webu Čes-
kých Novin (zpravodajský server ČTK) zapojit
do rozhovoru s českou ministryní informatiky Da-
nou Bérovou. Dotazy můžete posílat už teď a to
na témata jako digitalizace TV vysílání, Březen -
měsíc internetu nebo podpora informační společ-
nosti, její význam, cíle, projekty a priority MI.
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9.3.2006 Daniel Kvasnička ml.


Linux Gazette přináší návod na vytvoření linu-
xové pracovní stanice se šesti monitory a odpo-
vídajícím počtem myší a klávesnic. Použita byla
Mandriva 2006 a to beze změny v kernelu či in-
stalace dodatečného software.


9.3.2006 Daniel Kvasnička ml.


Mozilla nedávno potvrdila, že díky Firefoxu vydě-
lává miliony dolarů. Přesnou částku odmítá zve-
řejnit, ale nebrání se číslům kolem 70 milionů
USD, přičemž většina peněz plyne od Googlu pla-
tícího za dobře známý vyhledávací toolbar. Pří-
stup k penězům si však Mozilla zachovává stříz-
livý: Money is just a tool.


9.3.2006 Daniel Kvasnička ml.


Steven J. Vaughan Nichols z DesktopLinux.com si
popovídal se samotným Michaelem Dellem o Li-
nuxové strategii jeho firmy. Trápí ho roztříštěnost
distribucí a když se ho lidé ptají na podporu Li-
nuxu na desktopu, ptá se on jich, který že Linux
to mají na mysli.


9.3.2006 Daniel Kvasnička ml.


Vyšla další verze Eclipse plug-inu pro Python: Py-
Dev 1.0.3. Změny se udály v automatickém odsa-
zování, možnostech zvýrazňování syntaxe a opra-
veny byly i některé chyby v debuggeru. Download,
plán vývoje a tutoriál.


9.3.2006 Daniel Kvasnička ml.


Do 15. března probíhá nominace projektů hosto-
vaných na SourceForge.net do soutěže 2006 Sour-
ceForge.net Community Choice Awards. Hlaso-
vání o pět komunitou nejoblíbenějších projektů
začíná 17. března.


9.3.2006 Jindřich Plešinger


OpenDX neskončil, ale stále se vyvíjí. Dokonce
vyšla nová verze OpenDX 4.4.0.


9.3.2006 tomas kouba


Na www.neo.cz/ tomas/java.net/ vyšel článek
TIOBE: Java 6x populárnější než .NET.


9.3.2006 Lukáš Helebrandt


Toužíte po live CD, ve kterém si budete moct
vyzkoušet Xgl? Tady je – Kororaa Xgl Live CD
0.1. Recenzi se screenshoty najdete na Softpedii.
Podporované drivery jsou nvidia (nVidia) a fglrx
(ATI) (seznam karet).


10.3.2006 Michal Křenek


Na serveru LinuxQuestions.org byly zveřejněny
výsledky hlasování o 2005 LinuxQuestions.org
Members Choice Award. Nejlepší distribucí roku
se stalo Ubuntu a nejlepším desktopem KDE!
Dalšími vítěznými aplikacemi ve svých kategori-
ích jsou Konqueror, amaroK, MPlayer, Quanta,
Firefox, Thunderbird, OpenOffice.org, MySQL,
Gaim, GIMP, Frozen Bubble, Fluxbox, Wine,
Eclipse, vi/vim, nmap, bash a LiveCD distribuce
Knoppix.


10.3.2006 David Watzke


V jihoafrickém magazínu Tectonic vyšel článek
o KDE 4.0 (PDF, strana 17–19). Informuje web
dot.kde.org.


10.3.2006 Daniel Kvasnička ml.


Vyšla nová verze kancelářského balíku OpenOf-
fice.org 2.0.2. Verze pro Linux, Windows i Mac
OS X jsou k dispozici na ftp.linux.cz.


10.3.2006 Daniel Kvasnička ml.


Mluvčí IBM ve středu popřela, že by firma měla
v úmyslu zbavit se MS Windows na desktopech
[zprávička]. Vysvětlila, že Linux se objeví tam,
kde je ho potřeba pro práci, ale ostatní uživatelé
zůstanou na Windows. Upgrade na Vistu je stále
předmětem rozhodování. Informoval CRN.


10.3.2006 Daniel Kvasnička ml.


Versora a CodeWeavers společně ohlásily vydání
produktu s názvem Linux Desktop Migration
and Productivity Bundle, který v sobě kombi-
nuje CrossOver Office (upravená verze Wine) a
Progression Desktop (software pro aut. migraci
nastavení z Windows do Linuxu). Produkt by měl
pomoci firmám zvládnout co nejplynuleji přechod
na Linux. Informuje DesktopLinux.com.


10.3.2006 iSteve


Vyšla nová verze (0.2) technologicky nekonvenční
Linuxové live distribuce Olive. Mezi nejvýraznější
změny patří opravení komprimovaného ramdisku
pro systémy s 1GiB RAM či více, plná podpora
seriové konzole po celou dobu bootování a pro
ovládání systému či přidání mplayer mozilla plu-
ginu. Changelog a download je k dispozici na
stránkách Olive.


10.3.2006 Daniel Kvasnička ml.


Díky službě Google Video máme možnost vidět a
slyšet Guido van Rossuma, autora jazyka Python,
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jak mluví stručně o jeho minulosti, ale hlavně
budoucnosti. Záznam je z prostor firmy Google
v New Yorku a byl pořízen 22.2.2006, přičemž
v plném znění si Guidovu přednášku vychutnali
návštěvníci PyConu 2006. Informaci jsem dostal
díky mailing listu py.cz, kde se také objevil (za-
tím) provizorní, ale přínosný přepis přednášky:
1. část, 2. část.


10.3.2006 Daniel Kvasnička ml.


Časopis Forbes přináší další rozhovor s Linusem
Torvaldsem. Se současným návrhem GPLv3 stále
nesouhlasí (a znovu vysvětluje proč), ale vypadá
to, že optimismu mu přibylo.


11.3.2006 watslaw


Podle Timova blogu už nejnovější build Opery
bez chyby zvládne známý test Acid2.


11.3.2006 Jindřich Plešinger


Generátor FEM sítí Gmsh dospěl do nové stabilní
verze 1.64.


11.3.2006 Petr Tomeš


Ubuntu Flight CD 5 je připraveno. Jde o páté
z řady milníkových obrazů CD, které budou vy-
dány během vývojového cyklu pro Dappera. Se-
znam důležitých změn tohoto vydání v rámci celé
distribuce je dostupný na: http://wiki.ubuntu.cz/
Dapper Flight 5.


13.3.2006 Filip Krška


Průkopnický SIP a H.323 VoIP (audio i video)
klient Ekiga se dočkal 2.00 verze.


13.3.2006 Pavel ’lingeek’ Szalbot


Kritická chyba a potenciální bezpečnostní riziko
bylo objeveno v Ubuntu Breezy. Heslo uživatele
root se ukládá do instalačního logu v nešifrované
(nehašované) podobě. Patch je dostupný a ostra-
žití by měli být i uživalé, kteří z Breezy upgrado-
vali na Dapper.


13.3.2006 Pavel ’lingeek’ Szalbot


Mezi novinkami ohlášeného OpenOffice.org 2.0.2
najdete několik přispěvků z KDE. Konkrétně
KDE Addressbook Connector a ikonky Crystal
(k jejich vývoji můžete přispět). KDE.News.


13.3.2006 David Jaša


Blíží se třetí pátek v měsíci a s ním už 6. setkání
příznivců Linuxu v Brně, které se jako obvykle
uskuteční v restauraci Onyx od 18:00.


13.3.2006 Daniel Kvasnička ml.


Ačkoliv je dnes jazyk awk přítomný téměř v každé
distribuci, netěší se takové popularitě jako např.
Perl. Linux Journal proto přináší krátký, ale uži-
tečný úvod.


13.3.2006 Daniel Kvasnička ml.


Mark Shuttleworth vyzval k posunutí termínu vy-
dání nové verze Ubuntu Linuxu (Dapper Drake)
o šest týdnů. Rád by ji vyladil tak, aby ji mohl
s klidným svědomím představit jako první verzi
Ubuntu hodnou označení enterprise desktop. In-
formuje Tectonic.


13.3.2006 Daniel Kvasnička ml.


Chcete na svém počítači s dualbootem přepínat
mezi systémy a nezmáčknout při tom ani klávesu?
IBM developerWorks poradí jak na to.


13.3.2006 Daniel Kvasnička ml.


Free Software Magazine přináší zajímavou ana-
lýzu situace free a open-source software v zemích
bývalého SSSR. Řeč je hlavně o Ruské federaci,
Bělorusku a Ukrajině.


13.3.2006 Daniel Kvasnička ml.


Na webu NASA je seznam projektů, které agen-
tura vyvíjí jako open-source. Není jich málo a
nejsou to žádné podřadné záležitosti: AI, gene-
tické algoritmy, renderovací a zobrazovací SW či
podpůrný SW pro vývoj planetárních průzkum-
ných vozidel.


13.3.2006 Daniel Kvasnička ml.


Pokusy o dialog na téma uživatelského rozhraní
GIMPu zatím všechny ztroskotaly a program je
v současnosti obětí designové filozofie, která ne-
splňuje očekávání uživatelů. Navíc je tu Pixel, pro
který jsou rozpory kolem GIMPu doslova živnou
půdou. A proto se NewsForge ptá: Time to stick
a fork in the GIMP?


13.3.2006 Daniel Kvasnička ml.


Ačkoliv většina serverů žije ještě v dobách PHP 4,
vývojáři jazyka již pilně pracují na PHP 6. V nové
verzi dojde na „The big cleanupÿ(definitivní od-
stranění register globals apod.), vylepšení objek-
tového aparátu (implementace namespaces), pod-
poru Unicode a další. Informuje OSDir.


14.3.2006 Reklama


Pro vývoj produktu Red Hat hledáme nové kolegy
na pozici GNU/Quality Assurance, GNU/Softwa-
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re Engineer, Release Engineer a další. Více infor-
mací.


14.3.2006 Daniel Kvasnička ml.


Další z řady milníků na cestě za finálním Eclipse
3.2 je na světě: 3.2M5. Změn a novinek je opravdu
mnoho a to jak v Java prostředí, tak v platformě
jako takové. Pokud by vás zajímalo, jak je na tom
tato verze se svižností, jsou k dispozici výsledky
porovnávacích testů s v3.1.


14.3.2006 Daniel Kvasnička ml.


Finanční Noviny přinášejí stručné informace o le-
tošním ročníku projektu „Březen – měsíc inter-
netuÿa rozpis akcí, které se v rámci něho budou
konat. Dnes je např. ve Zlíně konference o inter-
netu a bezpečnosti organizací a na začátku dubna
dojde i na debatu o internetu ve státní správě a
samosprávě.


14.3.2006 Daniel Kvasnička ml.


Lidem z Debianu došla ve sporu s FSF trpělivost
a nechali hlasovat o kompatibilitě GNU FDL a
DFSG. Dokumenty vydané pod GNU FDL, na níž
Debianu nejvíce vadilo, že povoluje neměnné části
dokumentu, byly nakonec označeny za akceptova-
telné pro main větev. Nesmí však neměnné části
obsahovat. Informuje NewsForge.


14.3.2006 Daniel Kvasnička ml.


Techworld uveřejnil první část článku o výhodách
a úskalích mixed-source modelu (open-source +
možnost dokoupit proprietární přídavky): Free
code for sale: the new business of open source.


14.3.2006 Daniel Kvasnička ml.


Google v oblasti on-line služeb jede jako buldo-
zer. DesktopLinux.com představuje Writely, be-
taverzi on-line textového procesoru, kterou Goo-
gle nedávnou koupil: Could MS Office’s doom be
a little app called Writely?


14.3.2006 Daniel Kvasnička ml.


PSF (Python Software Foundation) se chlubí, že
už má také svůj blog. Budou se v něm objevovat
oznámení, žádosti o pomoc, výzvy k diskusím a
podobně.


15.3.2006 Pavel ’lingeek’ Szalbot


Dnes ohlášená betaverze FreeBSD 6.1-BETA4 se
pyšní opravou kódu kolem VFS (vyšší výkon a
stabilita pod velkou zátěží) a instalací generic i
SMP kernelu sysinstallem spolu s detekcí CPU
konfigurace.


15.3.2006 Daniel Kvasnička ml.


Termín Web 2.0 není tak úplně lehké definovat.
Definice „vylepšený World Wide Webÿ mnoho
neřekne, ale termíny jako RSS, AJAX, Flickr či
del.icio.us už lecos napoví. V článku na openDe-
mocracy.net se kromě těchto věcí také dozvíte,
jak důležitou roli v tomto fenoménu hrají ote-
vřené formáty, protokoly a API.


15.3.2006 Daniel Kvasnička ml.


The Zone vás během 10 minut naučí, jak vyu-
žít Subversion tak trošku netradičním způsobem
– ke správě, sledování a auditům konfiguračních
souborů vašeho serveru.


15.3.2006 Daniel Kvasnička ml.


Steven J. Vaughan-Nichols z DesktopLinux.com
se po všech svých zkušenostech s chováním vel-
kých firem (hlavně Dellu) znovu zamýšlí nad tím,
proč ještě nepřišel boom linuxových desktopů.
Vysvětluje, že velcí dinosauři jednoduše už ne-
chtějí být průkopníky, ale radši zůstávají v zaje-
tých kolejích: Old OEMs, new Linux tricks?


15.3.2006 Daniel Kvasnička ml.


Myslíte, že MySQL či software od Googlu nebo
IBM jsou viry? Antivirový software firmy McA-
fee si myslí, že ano a nezůstal jen u toho. Za
viry označil a vyřadil z provozu i programy fi-
rem Microsoft, Adobe či Autodesk a způsobil tím
nemalé škody firmám i jednotlivcům. Informuje
Aktuálně.cz.


16.3.2006 Martin Kocourek


Tak a je venku GNOME 2.14, které přináší nejen
spoustu novinek, ale také změny uvnitř kódu, jež
by měly postupně vést ke zrychlení aplikací a
menší spotřebě paměti. Enjoy!


16.3.2006 David Watzke


Vyšlo Wine 0.9.10 obsahující opravy v ESounD
ovladači, MSHTML a WinInet, Direct3D a mno-
ho dalších. Zde je zpráva o vydání.


16.3.2006 Daniel Kvasnička ml.


Gael Duval, zakladatel Mandrake Linuxu – dnes
známého jako Mandriva, byl ze své vlastní firmy
vyhozen. Stalo se tak údajně v rámci redukce ná-
kladů, pro kterou se vedení firmy rozhodlo na zá-
kladě její špatné finanční situace. Informuje Inter-
netnews.com a zprávu potvrzující Duvalovo od-
hodlání Mandrivu zažalovat přináší NewsForge.
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16.3.2006 Daniel Kvasnička ml.


LinuxFormat přináší rozhovor se dvěma význam-
nými programátory z projektu Mono, kteří jsou
mimo jiné i autory knihy o open-source imple-
mentaci platformy .NET.


16.3.2006 Daniel Kvasnička ml.


Eben Moglen (právník FSF) se opět ohrazuje
proti termínu „anti-kapitalismus”. Vysvětluje, že
free software je obrovská hora zlatých vajec a úko-
lem firem je starat se o ty, co je kladou. Více na
ZDNetu.


16.3.2006 Daniel Kvasnička ml.


Humbuku kolem procesoru Intel Core Duo jste si
nemohli nevšimnout. Pokud vás zajímají podrob-
nosti o jeho architektuře, přečtěte si článek, na
který upozornila ArsTechnica.


16.3.2006 Daniel Kvasnička ml.


Úspěch open-source principů je tak markantní, že
ani Microsoft ho nemůže ignorovat. Společnost se
rozhodla posunout svůj styl vývoje software opět
o kousek blíže open-source a začíná chápat, že
beta verze v dlouhých časových intervalech nejsou
to nejlepší. Více na Microsoft Watch.


16.3.2006 Jiří Poláček


Vyšla stabilní verze KBarcode 2.0.0, programu na
generování a tisk čárových kódů na štítky. Mezi
novinky patří podpora Javascriptu, spolupráce
s adresářem KDE, pokládání libovolných dotazů
do databáze a tvorba čárových kódů s pomocí
”Barcode Writer in Pure Postscript”. Ke stažení
jsou jak zdrojové kódy, tak balíčky pro Fedoru a
SUSE. Více viz oficiální oznámení.


16.3.2006 Jose


Zaregistrovali ste fenomenálny úspech finančnej
zbierky na nákup nového stroja pre autora k3b
Sebastiana Truega? Už po 2 dňoch bol dosiahnutý
cieľ vo výške 1 000 Euro a momentálne sa blíži
celková suma k trom tisícom. Pekné, čo poviete?


16.3.2006 Filip Molčan


Seznam.cz se stal generálním mediálním partne-
rem organizace OSS Alliance, na podporu Open
Source věnuje reklamu v hodnotě 300.000 Kč.


16.3.2006 Milan Lajtoš


Rečník, filozof, ale hlavne zakladateľ GNU a FSF
Richard Stallman dnes oslavuje svoje 53. narode-
niny! Samozrejme mu blahoželáme. . ;)


16.3.2006 srtsrt


Pořádná řežba si žádá pořádný výhled. Andrew
Sabri je zřejmě téhož názoru – zneužil jednu počí-
tačovou laboratoř a pomocí 12 GNU/Linuxových
serverů rozběhal hru Quake III Arena na 24 LCD
monitorech.


17.3.2006 Daniel Kvasnička ml.


Další z řady spekulací o marketingových tazích
Googlu je na světě. Daniel M. Harrison z Blogcri-
tics.org si myslí, že Google koupí firmu Sun Micro-
systems. Uvádí proč a také podotýká, že akcie
Sunu už na základě těchto dohadů stouply o 4%.


17.3.2006 Martin Baleja


Bill Gates se vysmíval projektu 100$ laptopu:
„Hardware představuje jen malou část ceny, větší
částky jsou třeba na síťovou konektivitu, apli-
kace a podporu.ÿDále zpochybnil možnosti sdílení
bezdiskového počítače a kritizoval malý displej
laptopu, přičemž před samotnou filipikou předsta-
vil nový ”ultramobile computerÿse sedmipalco-
vým dotykovým displejem. Informuje news.com.


17.3.2006 Daniel Kvasnička ml.


Steven J. Vaughan-Nichols se rozčiluje nad opě-
tovným tříštěním sil v open-source komunitě,
konkrétně nad projektem SimpleKDE. Podobná
snažení podle něj podkopávají snahy projektů
jako je Desktop Linux Working Group a ještě
více odrazují softwarové firmy a výrobce HW od
vstupu na trh s Linuxem: Repeat after me: No
more Linux desktop forks.


17.3.2006 Daniel Kvasnička ml.


Velká Británie varovala USA, že pokud jí nebude
umožněn přístup ke kompletním zdrojovým kó-
dům software, který ovládá Joint Strike Figter,
zruší svoji objednávku na tato letadla za 12 mili-
ard liber. Více na vnunet.com.


17.3.2006 Petr Břeň


Webové stránky první kompletně svobodné dis-
tribuce UTUTO, kterou jako jednu z mála dopo-
ručuje FSF, jsou nyní dostupné i v češtině.


18.3.2006 Vojtěch Hála


Po dlouhém boji s rakovinou zemřel 9. března
Geir Ivarsy, vedoucí programátor Opery. V roce
1995 s Jonem S. von Tetzchnerem založili Opera
Software. Zaměstnanci mu vyjádří úctu na po-
hřbu v Grefsen Kirke, Oslo.
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18.3.2006 Leoš Literák


V průběhu víkendu doufám dojde k nasazení nové
verze abclinuxu. Kvůli změně formátu databáze
dojde k nejméně čtvrt hodinovému výpadku. Za
potíže se omlouvám.


18.3.2006 Pavel Škoda


Sci-fi: Jeden týden pokročilého uživatele operač-
ního systému Linux alias hezké píchnutí do vlast-
ního hnízda. Zajímavá povídka na blisty.cz.


19.3.2006 Jan Fuchs


Narazil jsem na PDF (en) výtečné knihy od Erica
S. Raymonda – The Art of Unix Programming
(rezenze).


19.3.2006 Jan Grmela


Inženýři od Samsungu, nedočkaví, až jim Micro-
soft pošle systém, na kterém poběží prodejní verze
jejich UMPC, zkoušejí funkčnost jejich mobilního
počítače na Linuxu. Píše se tak na Umpcori-
gami.com v interview s člověkem ze Samsungu,
jenž si nepřál být jmenován.


19.3.2006 Alois Nešpor


Nové KDE 3.5.2 je nadohled. Na některých zr-
cadlech KDE je již nová verze nahrána, oficiální
vydání však zatím není. Pravděpodobně se objeví
během několika hodin/dnů.


19.3.2006 Dominik Sauer


Nový článek Vlastimila Klímy – Tunely v hašo-
vacích funkcích: kolize MD5 do minuty.


20.3.2006 Alois Nešpor


Dneska ráno vyšlo nové jádro 2.6.16. K dispozici
je seznam změn a stahovat můžete odtud.


20.3.2006 Daniel Kvasnička ml.


SIL International (NGO specializující se na lin-
gvistiku) vydala dva nové open-source fonty ur-
čené pro fonetické přepisy: Charis SIL a Doulos
SIL. Fonty jsou licencovány pod OFL a mají roz-
sáhlou podporu Unicode a technologie Smartfont.


20.3.2006 Daniel Kvasnička ml.


Čekání na GNOME 2.14 v repozitářích vaší oblí-
bené distribuce pomůže zkrátit Linux.com, který
nabízí krátkou recenzi nové verze.


20.3.2006 Daniel Kvasnička ml.


Časopis The Economist vydal článek, ve kterém
se snaží zmapovat potenciální slabiny open-source
modelu vývoje. Groklaw hbitě zareagoval: The


Economist Article: Looking at Open Source at a
Tilt.


20.3.2006 Daniel Kvasnička ml.


K přečtení je osobní výpověď Gale Duvala, spo-
luzakladatele distribuce Mandriva vyhozeného
z vlastní firmy. Mimo jiné v ní mluví o nové distri-
buci (Ulteo), která by měla změnit způsob, jakým
lidé používají Linux a operační systémy vůbec.


20.3.2006 Nikola Ciprich


Dobrá zpráva pro příznivce distribuce Fedora
Core. Verze 5, která obsahuje třeba ovladač k wifi
kartám bcm43xx, už je dostupná na mirrorech.
Stahovat můžete například na ftp.linux.cz.


20.3.2006 Milan Lajtoš


Slovenské Kubuntu stránky sú spustené! Ak máte
čím prispieť, neváhajte! Pomoc je vždy vítaná!


20.3.2006 Daniel Kvasnička ml.


Firefox 2 Alpha 1 má být sice oficiálně k dispozici
až zítra, Tinderbox Buildy jsou však ke stažení
už od pátku. Informuje a přímé odkazy přináší
Cybernetnews.com.


21.3.2006 tomas kouba


Na blogu Java.net vyšel článek, který upozorňuje
na to, že Open Source vývojáři podle Source-
Forge.net dnes preferují web tenké aplikace.


21.3.2006 Zdeněk Štěpánek


V pořadí druhé neformální setkání linuxáků ve
Varnsdorfu proběhne 29.3. od 18:00 v restauraci
Střelnice. Na programu je krom jiného dobré pivo
a vynikající nakládaný hermelín. Více na linux-
varnsdorf.gavanet.org. 0


21.3.2006 Daniel Kvasnička ml.


Nedávno avizovaný přepis přednášky Guido van
Rossuma o budoucnosti Pythonu se dočkal ofici-
ální verze (včetně explicitního písemného povolení
od Google, Inc.). Vše samozřejmě díky portálu
PyCZ a lidem z jeho mailing listu.


21.3.2006 Daniel Kvasnička ml.


Robin ’Roblimo’ Miller na NewsForge komentuje
projekt $100 laptopu a zvláště narážky Billa Ga-
tese: Gates wants poor to spend $600+, not $100
or $200, for computers


21.3.2006 Daniel Kvasnička ml.


Vývojáři prohlížeče Flock (založeného na Fire-
foxu) informují, že na květen připravují první ve-
řejnou betaverzi. Flock, jehož v. 0.5.13 můžete
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už dnes celkem bez obtíží používat, má vesta-
věný editor blogů, nástroj pro práci s obrázky na
Flickru, odkládací prostor a přepracovanou RSS
čtečku i systém záložek. Je také znatelně svižnější
než Firefox.


21.3.2006 Daniel Kvasnička ml.


Na bitevní pole vektorové grafiky přichází další
hráč. 19. března byly ve Francii na Libre Graphix
Meeting uvolněny již dříve avízované zdrojové
kódy Xary Xtreme. K dispozici je samozřejmě
i binární verze. Více na stránkách s novým de-
signem: http://www.xaraxtreme.org/.


21.3.2006 Martin Tesař


Byl vydán CentOS 4.3 - hlavní změnou je nový
update systém za použití YUM (announce).


22.3.2006 Kuca


Na univerzitě v Delftu vzniknul zajímavý pro-
jekt jménem Tribler umožňující přenos TV sig-
nálu metodou peer-to-peer sítí. Win verze ke sta-
žení zde.


22.3.2006 Daniel Kvasnička ml.


Posunutí termínu vydání nového Ubuntu bylo
schváleno a Mark Shuttleworth potvrdil nový ter-
mín: 1. červen. Získaný čas bude využit na celkové
doladění, lepší podporu asijských jazyků a zařa-
zení Xfce do hlavního repozitáře.


22.3.2006 Daniel Kvasnička ml.


Ačkoliv OpenSSH používají denně na světě mili-
ony lidí, jeho vývojáři, vyvíjející také OpenBSD,
jsou ve finanční tísni a hledají sponzory. Veškeré
otázky ohledně fundraisingu odpoví marco@open-
bsd.org, který také uvedenou informaci napsal do
OpenBSD Journalu.


22.3.2006 Daniel Kvasnička ml.


NewsForge podotýká, že F/OSS komunita a uži-
vatelé s postižením se musí naučit spolu komuni-
kovat. Jako příklad uvádí loňskou událost ve státě
Massachusetts, kdy se jednalo o nasazení formátu
OpenDocument, jejž lidé s postižením neshledali
vhodným. Následný meeting mnohé vyjasnil: ko-
munita nechápe potřeby handicapovaných a oni
se o F/OSS nezajímají.


22.3.2006 Daniel Kvasnička ml.


Pokud byste rádi pomohli s vývojem prohlížeče
Flock (včera jsme vám oživili paměť), můžete tak
učinit třeba potvrzováním opravených bugů. Tu-
toriál k tomu najdete na Flock Wiki.


22.3.2006 Daniel Kvasnička ml.


Šéf Novellu v rozhovoru pro vnunet.com prohlásil,
že linuxový trh se během několika let zredukuje na
dva subjekty: Novell a Red Hat. Distribuce tvo-
řené jako hobby tu prý zůstanou, ale pro business
dva subjekty stačí.


22.3.2006 Daniel Kvasnička ml.


Free Software Magazine přináší reportáž z celo-
světové konference o Pythonu – PyCON 2006.
Řeč byla například o PyGTK a Glade nebo o ser-
veru Zope.


22.3.2006 Saljack


Na czille informují o první alfa verzi Firefoxu 2.0.


22.3.2006 Daniel Kvasnička ml.


Eclipse IDE je už dnes použitelné pro vývoj PHP
aplikací a to díky PHPeclipse. Eclipse Foundation
však ve spolupráci s IBM a Zend Technologies
připravuje oficiální Eclipse PHP IDE. Jeho návrh
byl schválen a první výsledky práce mohli dnes
vidět návštěvníci konference EclipseCon. Více na
Eclipse.org.


22.3.2006 Daniel Kvasnička ml.


Časopis Forbes přináší na svých stránkách roz-
hovor s Richardem Stallmanem. Mluví se samo-
zřejmě o GPLv3, DRM nebo free software vs.
open source. Zajímavá je také Stallmanova odpo-
věď na otázku, zda by bylo etické vzít kód z uza-
vřeného software např. od MS či Oracle a vydat
ho jako free software. Prý by to nebylo neetické –
asi tak jako osvobození otroka.


23.3.2006 Milan Horák


wasza.com ukazuje, jak se prý přijímají ajťáci
v Japonsku (flash rébus).


23.3.2006 Daniel Kvasnička ml.


Sun uvolnil kompletní specifikace svého nového
procesoru a to pod GNU GPL. Je to OpenSPARC
T1, 64 bitový, vícejádrový procesor založený na
UltraSPARC T1, který se pyšní např. poloviční
spotřebou energie oproti konkurenci. Více na Li-
nuxDevices.com.


23.3.2006 Daniel Kvasnička ml.


Jistý britský blogger na příkladu první alfa verze
Firefoxu 2.0 a Origami vysvětluje, co si myslí, že
by se mohl open source svět od Microsoftu nau-
čit. Jde o umění nechat uniknout ty správné in-
formace.
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23.3.2006 Daniel Kvasnička ml.


Server DesktopLinux.com přináší pohádku na po-
slední dobou oblíbené téma roztříštěnosti distri-
bucí: A Linux desktop fairy tale.


23.3.2006 Daniel Kvasnička ml.


Na Linux.com se dozvíte, jak pomocí speciálního
skriptu dostat několik live CD na jedno DVD a
pomocí GRUBu mezi nimi přepínat.


23.3.2006 Martin Tesař


Byla vydána opravná verze 5.0.8 českého Slaxu,
která možná napravuje některé nedostatky zmí-
něné ve včerejší recenzi verze 5.0.7.


23.3.2006 ronny


Vyšlo SuSE 10.1 Beta8. Obsahuje KDE 3.5.1,
Gnome 2.12.2, kernel 2.6.16 rc6, Beagle 0.2.2.1.
Stahovat můžete z open suse.org. Na screenshoty
z beta verze se můžete podívat na tuxmachi-
nes.org.


23.3.2006 Jiří Fogl


Pokud jste si v posledních dnech chtěli vyzkou-
šet skript ies4linux a nainstalovat si do Linuxu
Internet Explorer, měli jste smůlu, protože in-
stalační soubory z používaného mirroru zmizely.
Dnes ale vyšla nová verze skriptu stahující z ji-
ného mirroru, takže kdo chce/potřebuje IE, má
opět možnost.


24.3.2006 Daniel Kvasnička ml.


LinuxHardware.org si vzal na mušku nové 2,5”
disky pro notebooky, které Seagate představil
v lednu. Jde o disky Momentus s magnetickou
zápisovou technologií ”perpendicular recording”.


24.3.2006 Daniel Kvasnička ml.


Série rozhovorů časopisu Forbes pokračuje. Ten-
tokrát je to se Steve Ballmerem (Microsoft CEO).
Mluví se o strachu z open source, penězích, času
a intelektuálním vlastnictví: Ballmer, Bemused.


24.3.2006 Daniel Kvasnička ml.


Organizace OSDL (Open Source Development
Labs) se rozhodla založit Technical Advisory Bo-
ard, komisi, která by se měla starat o zlepšení
komunikace mezi jednotlivými subjekty na linu-
xovém trhu navzájem a jejich komunikace s vý-
vojáři. Informuje LinuxInsider.


24.3.2006 Daniel Kvasnička ml.


Šéf Sunu Scott McNealy v otevřeném dopise na-
bídl HP sloučení operačních systémů Solaris a


HP-UX. Jelikož Sun má dobrou podporu pro
x86/x64 architekturu, pomohlo by to zákazníkům
HP zůstat u serverů ProLiant, se kterými má HP-
UX v současnosti problémy. HP označil nabídku
za téměř směšnou. Má totiž dohodu s Intelem
a Oracle a chce, aby zákazníci migrovali na ser-
very s procesory Itanium, pro které jsou Oracle
produkty optimalizované. Informuje australský
ZDNet.


25.3.2006 Jiří Fogl


Na Britských listech si můžete přečíst zážitky
s „pětkrát rychlejším Internetem od Českého Te-
lecomuÿ.


25.3.2006 Daniel Kvasnička ml.


Příběh, který se objevil na fóru CentOS. Sice neu-
věřitelný, ale přesto pravdivý: It’s L-i-n-u-x, that
is an Operating System.


25.3.2006 Daniel Kvasnička ml.


Vývojáři Inkscape ve svém deníku na serveru de-
viantART prozrazují pár zajímavých informací.
Termín vydání Inkscape 0.44, o jehož připravova-
ných vlastnostech se také něco dozvíte, je zatím
neznámý, jelikož se stále pilně pracuje na přidá-
vání nových vlastností a chytání bugů. Také je
dobré vědět, že soutěže o design trička a kalen-
dáře byly obě prodlouženy.


26.3.2006 Jindřich Pozlovský


Vyšla nová verze operačního systému SkyOS.
Kromě nového značení beta verzí přináší Build
5550 (původně plánovaný pod jménem Beta 10)
celou řadu vylepšení, opravených chyb, zvýšení
výkonu a v neposlední řadě také několik nových
aplikací (např. Mono). Velkou novinkou je také
frekvence vydávání nových betaverzí a to zhruba
každých 7-14 dní.


27.3.2006 Daniel Kvasnička ml.


Typografičtí nadšenci zcela jistě ocení rozhovor
s Frankem Mittelbachem, vedoucím projektu La-
TeX, který přináší Free Software Magazine.


27.3.2006 Daniel Kvasnička ml.


LinuxJournal předstauje projekt LIRC a přináší
podrobný návod popisující konstrukci IrDA rece-
iveru a jeho následnou kombinaci s PC a např.
ovladačem k vaší televizi. Návod se bude hodit
(nejen) uživatelům MythTV.
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27.3.2006 Daniel Kvasnička ml.


Firma FarStone Technology plánuje v dubnu uvést
software nazvaný RestoreIT. Jde o aplikaci, která
na samostatném skrytém oddílu vašeho disku
bude uchovávat vše, co jí poručíte – třeba celý
systém – a v případě problému vám pomůže
váš systém a data vzkřísit. Informuje DesktopLi-
nux.com.


28.3.2006 Petr Vaněk


Příchod jara oslavujeme prací: Scribus verze 1.3.3
„Printempsÿje na světě. Tato verze vývojové řady
vám přináší více než 200 opravených chyb a imple-
mentovaných vylepšení zaměřených zejména na
použitelnost a správnost výstupů. Také už jsou
zahrnuty první přípravy a testy nového textového
jádra, které dostanete ve verzi nové. Gentí, Debi-
aní a Susí balíky v ceně.


28.3.2006 Daniel Kvasnička ml.


Podle průzkumu společnosti Nextlan je 9 z 10 fi-
remních Wi-Fi sítí v Praze špatně zabezpečených.
Tyto sítě nemají buď vůbec žádnou ochranu, nebo
jen slabou a lze se do nich s pomocí běžných
prostředků dostat během několika desítek minut.
Testováno bylo asi 200 AP. Informují Finanční-
Noviny.cz.


28.3.2006 Daniel Kvasnička ml.


Server British Computer Society přináší u příleži-
tosti blížící se konference www2006 rozhovor s vy-
nálezcem Webu, Sirem Timem Berners-Lee. Řeč
je o tom, co by udělal jinak, co čeká Web v nej-
bližší době a dalších tématech.


28.3.2006 Daniel Kvasnička ml.


Je tomu pár dní, co byl v Německu schválen nový
protipirátský zákon. Ten říká, že za stažení filmu
pro vlastní potřebu můžete dostat 2 roky vězení
a pokud s ním budete obchodovat, půjdete sedět
až na 5 let. Informuje TIMES Online.


28.3.2006 Vlastimil Ott


Včera zemřel klasik moderní sci-fi Stanisaw Lem,
jehož nejznámějším dílem je Solaris.


28.3.2006 Daniel Kvasnička ml.


Slovák Peter Chabada na svých stránkách popi-
suje více než 40 návrhů na vylepšení (nejen) desk-
topového prostředí GNOME.


28.3.2006 WooDy


Dnes vyšlo nové číslo ug e-zinu prielom #24.


28.3.2006 David Watzke


Před chvilkou oficiálně vyšlo KDE 3.5.2. Seznam
změn od verze 3.5.1 a download.


29.3.2006 Daniel Kvasnička ml.


Na O’Reillyho ONLamp.com běží seriál pojedná-
vající kriticky o dnešních programovacích jazycích
a budoucnosti jazyků vůbec: The World’s Most
Maintainable Language.


29.3.2006 Daniel Kvasnička ml.


Juergen Geck, bývalý CTO SUSE Linuxu, od-
chází z Novellu. Nejde o žádné rozkmotření ani
vyhazov. Odchod je přátelský a Geck se teď podle
svých slov zajímá o místa v malých začínajících
společnostech. Informuje CNR.COM.


29.3.2006 Daniel Kvasnička ml.


NewsForge si popovídal s Theo De Raadtem, ve-
doucí postavou projektů OpenBSD a OpenSSH.
Mluvilo se o nadcházejícím OpenBSD 3.9, fi-
nančním stavu projektu a firmách, které profitují
z open-source software aniž by něco přispěly.


29.3.2006 Daniel Kvasnička ml.


Na o3magazine.com vyšel zajímavý článek, který
formou otázek a odpovědí vysvětluje, jak open-
source funguje a jak jde dohromady s businessem.
Dozvíte se např. jak můžete vydělat peníze, když
je váš SW free nebo proč by lidé měli chtít do
vašeho projektu přispívat.


29.3.2006 Jindřich Plešinger


Vyšla třetí beta verze aplikace Gaim. Stahujte a
testujte tady.


30.3.2006 Vilém Buchtík


Minimalistická live distribuce Damn Small Linux
ve verzi 2.3 je na světě. Obsahuje nějaké opravy
a spoustu vylepšení, více v Change Logu.


30.3.2006 Stanislava Melagová


Rádi bychom pozvali všechny uživatele a příz-
nivce Mandriva Linuxu na v pořadí již třetí se-
tkání Mandriva Session, které se uskuteční 11.
dubna 2006 od 19.00 hodin v Restauraci u Zpě-
váčků.


30.3.2006 Daniel Kvasnička ml.


Google koketuje s myšlenkou připojit se k Ec-
lipse Foundation. V rozhovoru na letošním Ec-
lipseConu to řekl Greg Stein, technický manažer
open-source skupiny v Google a předseda Apache
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Software Foundation. Firma by přispěla buď fi-
nančně nebo pracovní sílou. Informuje eWEEK.


30.3.2006 Daniel Kvasnička ml.


Bram Moolenaar, autor slavného Vimu, přijal na-
bídku pracovat v Zürichu pro Google. Na svém
projektu, který se blíží k verzi 7, už nebude prý
pracovat na 150 %, ale opustit ho rozhodně ne-
hodlá. Slíbil také, že všechny finanční dotace pro
Vim půjdou od této chvíle na konto projektu v Ki-
baale (Uganda).


30.3.2006 Daniel Kvasnička ml.


Linux.com představuje Thoggen, nový DVD rip-
per pro Linux (zatím stále ve fázi beta verze). Po-
užívá GTK+ toolkit, GStreamer a pracuje s for-
mátem Ogg Theora. Další formáty (AVI, divx,
mpeg4) budou později.


30.3.2006 Alois Nešpor


Pokud si stejně jako já občas zahrajete starou
dobrou klasiku pro DOS a používáte DOSBox,
pak vězte, že vyšla nová verze, která přináší spous-
tu velkých změn, zejména podporu VESA, zrych-
lení CPU, opravu chyb a podporu IPX pro mul-
tiplayer.


30.3.2006 Ľubomír Pastorek


Celkom pekný návrh Konqueroru 4 sa objavil na
http://konqueror4.home.dyndns.org.


30.3.2006 Michal Kubeček


Byl vydán první release candidate verze 2.0 relač-
ního databázového serveru Firebird. K dispozici
jsou zatím buildy pro Linux (32- i 64-bitové) a
Windows a zdrojové texty. (Release Notes)


31.3.2006 Tomáš Kopečný


Není to ani tak dlouho a už tu máme opět další
verzi live distribuce Slax, tentokráte s číslem 5.1.0.
Verze přináší především opravy, ale i pár vylep-
šení. Vše podstatné si můžete přečíst v change-
logu.


31.3.2006 Daniel Kvasnička ml.


Vytvořit podcast není nic složitého, avšak u za-
čátečníků je často znát absence kvalitního mas-
teringu. NewsForge popisuje, jak ho dosáhnout
s dobře známým Audacity.


31.3.2006 Daniel Kvasnička ml.


SearchCIO.com přináší článek popisující nejčas-
tější důvody firem, které se začaly zajímat o open-
source business model. Kromě problémů s kon-


kurenceschopností produktu to může být třeba i
touha po odstranění konkurenčního produktu.


31.3.2006 Daniel Kvasnička ml.


Peter Yared ve svém blogu uveřejnil otevřený do-
pis Jonathanu Schwartzovi. Žádá ho, aby vysvětlil
své plány s open-source, přičemž hlavní otázkou
je, proč Sun neotevře zdrojové kódy Java Virtual
Machine.


31.3.2006 Daniel Kvasnička ml.


Blogger Jastiv se pozastavuje nad chováním ně-
kterých geeků a jejich oháněním se větami jako
„Go back to windows newbieÿ, „RTFMÿ či bez-
myšlenkovitým odpovídáním odkazy na eseje Eri-
ca Raymonda.


31.3.2006 Jiří Poláček


Namísto očekávané RC1 distribuce SUSE 10.1 se
dnes na mirrorech objevuje v pořadí již devátá
betaverze tohoto operačního systému (stáhnout).
Konečné vydání ostré verze se tak posouvá na 25.
duben 2006.


31.3.2006 Robert Krátký


Další ročník naší ankety o nejoblíbenější distri-
buci bude spuštěn 1. 4. – nenechte se zmást, ne-
bude to apríl. . .
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